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About This Manual

The LabVIEW Function and VI Reference Manual contains descriptions of
all virtual instruments (VIs) and functions, including the following:

e VIs that support the devices for data acquisition
*  VIs for GPIB, VXlbus, and serial port I/O operation
e digital signal processing, filtering, and numerical and statistical VIs

* networking and interapplication communications VIs

This manual is a supplement to the LabVIEW User Manual and you should
be familiar with that material.

This manual provides an overview of each function and VI available in the
LabVIEW development system. However, for more specific parameter
information regarding each function and VI, refer to the Online Reference,
which you can access by selecting Help»Online Reference, or to the Help
window, which you access by selecting Help»Show Help.

Organization of the Product User Manual

This manual covers five subject areas: G functions and VIs, Data
Acquisition VIs, Instrument I/O VIs, Analysis VIs, and Communications
VIs. Chapter 1, Introduction to the G Functions and VIs, introduces the
functions and VIs available in the LabVIEW development system.

e Partl, G Functions and VlIs, includes Chapters 2 through 13, which
describe the functions unique to the G programming language.

*  PartIl, Data Acquisition VIs, includes Chapters 14 through 30, which
describe the Data Acquisition (DAQ) VIs.

e Part IIl, Instrument I/O Functions and Vls, includes Chapters 31
through 36, which describe the Instrument I/O VIs and functions.

e PartlV, Analysis Vls, includes Chapters 37 through 47, which describe
the Analysis Vls.

e Part V, Communication VIs and Functions, includes Chapters 48
through 53, which describe the Communication VIs.
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About This Manual

In addition, this manual includes the following appendices and index:

e Appendix A, Error Codes, includes tables that summarize the analog
and digital I/O capabilities of National Instruments data acquisition
devices.

e Appendix B, DAQ Hardware Capabilities, lists commands that
IEEE 488 defines.

e Appendix C, GPIB Multiline Interface Messages, describes basic
concepts you need to understand to operate GPIB.

e Appendix D, Customer Communication, contains forms to help you
gather the information necessary to help us solve your technical
problems and a form you can use to comment on the product
documentation.

e The Index contains an alphabetical list of VIs described in this manual,
including the page where you can find each one.

Conventions Used in This Manual

The following conventions are used in this manual:

<> Angle brackets enclose the name of a key on the keyboard — for example,
<shift>. Angle brackets containing numbers separated by an ellipsis
represent a range of values associated with a bit or signal name —
for example, DBIO<3..0>.

[1 Square brackets enclose optional items — for example, [response].

- A hyphen between two or more key names enclosed in angle brackets
denotes that you should simultaneously press the named keys —
for example, <Control-Alt-Delete>.

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options»Substitute
Fonts directs you to pull down the File menu, select the Page Setup item,
select Options, and finally select the Substitute Fonts options from the
last dialog box.

bold Bold text denotes the names of menus, menu items, parameters, dialog
boxes, dialog box buttons or options, icons, windows, Windows 95 tabs,
or LEDs.

bold italic Bold italic text denotes an activity objective, note, caution, or warning.

Ctrl Key names are capitalized.
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italic

italic monospace

monospace

monospace bold

paths

About This Manual

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text from which you supply the
appropriate word or value, as in Windows 3.x.

Italic text in this font denotes that you must supply the appropriate words
or values in the place of these items.

Text in this font denotes text or characters that you should literally enter
from the keyboard, sections of code, programming examples, and syntax
examples. This font is also used for the proper names of disk drives, paths,
directories, programs, subprograms, subroutines, device names, functions,
operations, variables, filenames and extensions, and for statements and
comments taken from programs.

Bold text in this font denotes the messages and responses that the computer
automatically prints to the screen. This font also emphasizes lines of code
that are different from the other examples.

Paths in this manual are denoted using backslashes (\) to separate drive
names, directories, folders, and files.

Related Documentation

You might find the following documentation helpful as you read this
manual:

e LabVIEW User Manual

e G Programming Reference Manual

e LabVIEW Data Acquisition Basics Manual
e LabVIEW QuickStart Guide

e LabVIEW Online Reference, available by selecting
Help»Online Reference

e LabVIEW Online Tutorial (Windows only), which you launch from
the LabVIEW dialog box.

*  LabVIEW Getting Started Card

e G Programming Quick Reference Card
*  LabVIEW Release Notes

e LabVIEW Upgrade Notes
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About This Manual

Customer Communication

National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with our
products, and we want to help if you have problems with them. To make it
easy for you to contact us, this manual contains comment and configuration
forms for you to complete. These forms are in Appendix D, Customer
Communication, at the end of this manual.
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Introduction to the
G Functions and Vs

This chapter contains basic information about the functions and virtual
instruments (VIs) that are available in the LabVIEW development system.

The development system includes collections of VIs that work with your
G programming language, data acquisition (DAQ) hardware devices,
instrument devices, and other communication interfaces.

Locating the G Functions and Vis

Functions are elementary nodes in the G programming language. They are
analogous to operators or library functions in conventional languages.
Functions are not VIs and therefore do not have front panels or block
diagrams. When compiled, functions generate inline machine code.

You select functions from the Functions palette in the block diagram.
When the block diagram window is active, select Windows»

Show Functions Palette. You also can access the Functions palette by
popping up on the area in the block diagram window where you want to
place the function.
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Chapter 1 Introduction to the G Functions and VIs

The following illustration shows the functions and VIs available from the
Functions palette.
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Comparison, Time & Dialog File 1/O

Communication, Instrument /O, DAQ

Analysis, Tutorial, Advanced

Instrument Library, User Libraries,
Application Control

Select a VI

Many Functions palette chapters include information about function
examples. The paths for these examples for LabVIEW begin with

examples\.

Function and VI Overviews

The following functions and VIs are available from the Functions palette.

Structures

G Structures include While Loop, For Loop, Case, and Sequence
structures. This palette also contains the global and local variable nodes,

and the formula node.
@'
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Chapter 1 Introduction to the G Functions and VIs

Numeric Functions

Numeric functions perform arithmetic operations, conversions,
trigonometric, logarithmic, and complex mathematical functions. This
palette also contains additional numeric constants, such as Tt

Boolean Functions

Boolean functions perform Boolean and logical operations.

T3

String Functions

String functions manipulate strings and convert numbers to and from
strings. This palette also includes Additional String To Number functions
and String Conversion functions.

k

Array Functions

Array functions assemble, disassemble, and process arrays.

==
L
-

Cluster Functions

Cluster functions assemble, access, and change elements in a cluster.

(&=

k
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Chapter 1 Introduction to the G Functions and VIs

Comparison Functions

Comparison functions compare data (greater than, less than, and so on) and
operations that are based on a comparison, such as finding the minimum
and maximum ranges for a group or array of values.

]

e

Time and Dialog Functions

Time and Dialog functions manipulate time functions and display dialog
boxes. This palette also includes the VIs that perform error handling.

File 1/0 Functions

File I/O functions manipulate files and directories. This palette also
contains the subpalettes Advanced File Functions, Binary File VIs, and

File Constants.
|i

]

Advanced Functions

Advanced functions are functions that are highly specialized. The Code
Interface Node is an example of an advanced function. The Advanced
palette also contains Data Manipulation functions and Occurrences
functions.
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Chapter 1 Introduction to the G Functions and VIs

DAQ VIs acquire and generate real-time analog and digital data as well as
perform counting operations. See Chapter 14, Introduction to the LabVIEW
Data Acquisition VIs, for more information.

Instrument I/O VIs communicate with instruments using GPIB, VISA, or
serial communication. See Chapter 31, Introduction to LabVIEW
Instrument I/0O VIs, for more information.

Communication VIs network to other applications using TCP/IP, DDE,
ActiveX, Apple Events, PPC, or UDP. See Chapter 48, TCP VIs, through
Chapter 53, Program to Program Communication VIs, for more
information.

il

Analysis VIs perform measurement, signal generation, digital signal
processing, filtering, windowing, probability and statistics, curve fitting,
linear algebra, array operations, and VIs which perform additional
numerical methods. See Chapter 37, Introduction to Analysis in LabVIEW,
for more information.

4
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Chapter 1 Introduction to the G Functions and VIs

Select A VI...

The Select a VI... allows you to select any VI using a file dialog box and

then place it on a diagram.

Tutorial

The Tutorial VIs provide examples for you to use while working through
the LabVIEW User Manual.

r

<

Instrument Driver Library

Instrument drivers are a set of VIs for GPIB, VISA, serial, and CAMAC
instruments. National Instruments, as well as other vendors, distribute these
instrument drivers. Any drivers you place in the instr.1ib appear in the
palette.

User Library

The User Library palette automatically includes any VIs in your
user.lib directory, making it more convenient to gain access to
commonly used sub-VIs you have written.
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Application Control

The Application Control palette includes the Help functions, Menu
functions, Print VIs, and VI Server VIs.
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G Functions and Vs

Part I, G Functions and Vls, introduces the G Functions and VIs
descriptions. This part contains the following chapters:

Chapter 2, G Function and VI Reference Overview, introduces the G
functions and VIs. This chapter also describes the differences between
functions and VIs.

Chapter 3, Structures, describes the structures available in G.

Chapter 4, Numeric Functions, describes the functions that perform
arithmetic operations, complex, conversion, logarithmic, and
trigonometric operations. It also describes the commonly used
constants like the Numeric constant, Enumerated constant, and Ring
constant, as well as additional numeric constants.

Chapter 5, Boolean Functions, describes the functions that perform
logical operations.

Chapter 6, String Functions, describes the string functions, including
those that convert strings to numbers and numbers to strings.

Chapter 7, Array Functions, describes the functions for
array operations.

Chapter 8, Cluster Functions, describes the functions for
cluster operations.

Chapter 9, Comparison Functions, describes the functions that
perform comparisons or conditional tests.

Chapter 10, Time, Dialog, and Error Functions, describes the timing
functions, which you can use to get the current time, measure elapsed
time, or suspend an operation for a specific period of time. Error
Handling also is covered in this chapter.

Chapter 11, File Functions, describes the low-level VIs and functions
that manipulate files, directories, and paths. This chapter also
describes file constants and the high-level file VIs.



Part | G Functions and Vs

e Chapter 12, Application Control Functions, describes the Application
Control functions.

e Chapter 13, Advanced Functions, describes the functions that perform
advanced operations. This chapter also describes the Help, Data
Manipulation, and Synchronization functions, and the VI Control and
Memory VISA.
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G Function and
VI Reference Overview

This chapter introduces the G Functions and VIs, descriptions of which
comprise Chapter 3 through Chapter 13.

Functions are elementary nodes in the G programming language. They are
analogous to operators or library functions in conventional languages.
Functions are not VIs and therefore do not have front panels or block
diagrams. When compiled, functions generate machine code.

VIs are “virtual instruments,” so called because they model the appearance
functions of a physical instrument.

You select G Functions from the Functions palette, in the block diagram.
When the block diagram window is active, you can display the Functions
palette by selecting Windows»Show Functions Palette. You also can
access the Functions palette by popping up on the area in the block
diagram window where you want to place the function.
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Chapter 2 G Function and VI Reference Overview

The following illustration shows the G functions and VIs available on the
Functions palette.

& Functions EH

G Functions and Vs

Many Functions palette chapters include information about function
examples.

G Functions Overview

For brief descriptions of each of the eleven G Function and VI palettes
available, refer to Chapter 1, Introduction to the G Functions and Vls.

Introduction to Polymorphism

The following sections provide some general information about
polymorphism in G functions.

Polymorphism

Polymorphism is the ability of a function to adjust to input data of different
types or representations. Most functions are polymorphic. VIs are not
polymorphic. All functions that take numeric input can accept any numeric
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Chapter 2 G Function and VI Reference Overview

representation (except some functions that do not accept complex
numbers).

Functions are polymorphic to varying degrees; none, some, or all of their
inputs may be polymorphic. Some function inputs accept numbers or
Boolean values. Some accept numbers or strings. Some accept not only
scalar numbers but also arrays of numbers, clusters of numbers, arrays of
clusters of numbers, and so on. Some accept only one-dimensional arrays
although the array elements may be of any type. Some functions accept all
types of data, including complex numbers.

Unit Polymorphism

If you want to create a VI that computes the root, mean square value of a
waveform, you have to define the unit associated with the waveform.
You would need a separate VI for voltage waveforms, current waveforms,
temperature waveforms, and so on. LabVIEW has polymorphic unit
capability so that one VI can perform the same calculation, regardless of
the units received by the inputs.

You create a polymorphic unit by entering $x, where x is a number (for
example, $1). You can think of this as a placeholder for the actual unit.
When LabVIEW calls the VI, the program substitutes the units you pass in
for all occurrences of $x in that VL.

LabVIEW treats a polymorphic unit as a unique unit. You cannot convert
a polymorphic unit to any other unit, and polymorphic units propagate
throughout the diagram, just as other units do. When the unit connects to an
indicator that also has the abbreviation $1, the units match and the VI can
then compile.

You can use $1 in combinations just like any other unit. For example, if the
input is multiplied by 3 seconds and then wired to an indicator, the indicator
must be $1 s units. If the indicator has different units, the block diagram
shows a bad wire. If you need to use more than one polymorphic unit, you
can use the abbreviations $2, $3, and so on.

A call to a subVI containing polymorphic units computes output units
based on the units received by its inputs. For example, suppose you create
a VI that has two inputs with the polymorphic units $1 and $2 that creates
an output in the form $1 $2 / s.If a call to the VI receives inputs with
the unit m/s to the $1 input and kg to the $2 input, LabVIEW computes the
output unitaskg m / s”2.
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Suppose a different VI has two inputs of $1 and $1/s, and computes an
output of $1~2. If a call to this VI receives inputs of m/s to the $1 input
and m/s”2 to the $1/s input, LabVIEW computes the output unit as
m”~2 / s*2.If this VI receives inputs of m to the $1 input and kg to

the $1/s input, however, LabVIEW declares one of the inputs as a unit
conflict and computes (if possible) the output from the other input.

A polymorphic VI can have a polymorphic subVI because LabVIEW keeps
the respective units distinct.

Numeric Conversion

You can convert any numeric representation to any other numeric
representation. When you wire two or more numeric inputs of different
representations to a function, the function usually returns output in the
larger or wider format. The functions coerce the smaller representations to
the widest representation before execution.

Some functions, such as Divide, Sine, and Cosine, always produce
floating-point output. If you wire integers to their inputs, these functions
convert the integers to double-precision, floating-point numbers before
performing the calculation.

For floating-point, scalar quantities, it is usually best to use
double-precision, floating-point numbers. Single-precision, floating-point
numbers save little or no execution time, and overflow much more easily.
The analysis libraries, for example, use double-precision, floating-point
numbers. You should only use extended-precision, floating-point numbers
when necessary. The performance and precision of extended-precision
arithmetic varies among the platforms.

For integers, it is usually best to use a long integer.

If you wire an output to a destination that has a different numeric
representation from the source, G converts the data according to the
following rules:

* Signed or unsigned integer to floating-point number—Conversion is
exact, except for long integers to single-precision, floating-point
numbers. In this case, G reduces the precision from 32 bits to 24 bits.

¢ Floating-point number to signed or unsigned integer—G moves
out-of-range values to the integer’s minimum or maximum value.
Most integer objects, such as the iteration terminal of a For Loop,
round floating-point numbers. G rounds a fractional part of 0.5 to the
nearest even integer—for example, G rounds 6.5 to 6 rather than 7.
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* Integer to integer—G does not move out-of-range values to the
integer’s minimum or maximum value. If the source is smaller than the
destination, G extends the sign of a signed source and places zeros in
the extra bits of an unsigned source. If the source is larger than the
destination, G copies only the low order bits of the value.

The block diagram places a coercion dot on the border of a terminal where
the conversion takes place to indicate that automatic numeric conversion
occurred, as in the following example.

Because VIs and functions can have many terminals, a coercion dot can
appear inside an icon if the wire crosses an internal terminal boundary
before it leaves the icon/connector, as the following illustration shows.

FiH)

Moving a wired icon stretches the wire. Coercion dots can cause a VI to use
more memory and increase its execution time. You should try to keep data
types consistent in your VIs.

Overflow and Underflow

G does not check for overflow or underflow conditions on integer values.
Overflow and underflow for floating-point numbers is in accordance with
IEEE 754 Standard for binary, floating-point arithmetic.

Floating-point operations propagate not-a-number (NaN) and +Inf
faithfully. When you explicitly or implicitly convert NaN or +Inf to an
integer or Boolean value, however, you get a value that looks reasonable,
but is meaningless. For example, dividing by zero produces +Inf, but
converting that value to a word integer gives the value 32,768, which is the
largest value that can be represented in the destination format.
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Chapter 2 G Function and VI Reference Overview

Wire Styles

The wire style represents the data type for each terminal, as the following

table shows. Polymorphic functions show the wire style for the most
commonly used data type.

Scalar 1D Amay 20 Amay 30 Aray 4D Amray
Murmber

Boolean
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Structures

This chapter describes the Structures available in G.

To access the Structures palette, select Functions»Structures. The
following illustration shows the options that are available on the Structures
palette.
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See examples\general\structs.1llb for examples of how these
structures are used in LabVIEW.
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Chapter 3 Structures

Structures Overview

The following Structures are available in G.

Case Structure
Has one or more subdiagrams, or cases, exactly one of which executes when the structure
executes. Whether it executes depends on the value of the Boolean, string, or numeric scalar
you wire to the external side of the terminal or selector.

For more information on how to use the Case structure in LabVIEW, see Chapter 4, Case and
Sequence Structures and the Formula Node, in the LabVIEW User Manual.

Sequence Structure

Consists of one or more subdiagrams, or frames, that execute sequentially. As an option, you
can add sequence locals that allow you to pass information from one frame to subsequent
frames by popping up on the edge of the structure.

a0

For more information on how to use the Sequence structure in LabVIEW, see Chapter 4,
Case and Sequence Structures and the Formula Node, in the LabVIEW User Manual.

For Loop
Executes its subdiagram n times, where n equals the value contained in the count terminal.
As an option, you can add shift registers so that you can pass information from one iteration
to the next by popping up on the edge of the structure.

numbser
of times . -
cument ieration

For more information on how to use For Loop in LabVIEW, see Chapter 3, Loops and Charts,
in the LabVIEW User Manual.
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Chapter 3 Structures

While Loop

Executes its subdiagram until a Boolean value you wire to the conditional terminal is FALSE.
As an option, you can add shift registers so you can pass information from one iteration to the
next by popping up on the edge of the structure.

;i{:%&_ curment feration

condiion

For more information on how to use While Loop in LabVIEW, see Chapter 3, Loops and
Charts, in the LabVIEW User Manual.

Formula Node
Executes mathematical formulae on the block diagram.

input—Tl=n E

st [ owtpart

formulae

For more information on the Formula Node, see Chapter 4, Case and Sequence Structures and
the Formula Node, in the LabVIEW User Manual.

Global Variable

A built-in LabVIEW object that you define by creating a special kind of VI, with front panel
controls that define the datatype of the global variable. You can read and write values to the
global variable.

For more information on the Global Variable, see Chapter 23, Global and Local Variables,
in the G Programming Reference Manual.
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Local Variahle

Lets you read or write to one of the controls or indicators on the front panel of your VI.
Writing to a local variable has the same result as passing data to a terminal, except that you
can write to it even though it is a control, or read from it even though it is an indicator.

LOCAL

For more information on the Local Variable, see Chapter 23, Global and Local Variables, in
the G Programming Reference Manual.
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Numeric Functions

This chapter describes the functions that perform arithmetic, complex,
conversion, logarithmic, and trigonometric operations. It also describes the
commonly used constants such as the Numeric constant, Enumerated
constant, and Ring constant, as well as additional numeric constants.

To access the Numeric palette, select Functions»Numeric. The following
illustration shows the options that are available on the Numeric palette.
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The Numeric palette includes the following subpalettes:

Additional Numeric Constants
Complex

Conversion

Logarithmic

Trigonometric

For examples of some of the arithmetic functions, see examples\
general\structs.1llb.
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Chapter 4

Numeric Functions

Polymorphism for Numeric Functions

Note

The arithmetic functions accept numeric input data. With some exceptions
noted in the function descriptions, the output has the same numeric
representation as the input, or if the inputs have different representations,
the output is the wider of the inputs.

The arithmetic functions work on numbers, arrays of numbers, clusters of
numbers, arrays of clusters of numbers, complex numbers, and so on.
A formal and recursive definition of the allowable input type is as follows:

Numeric type = numeric scalar || array [numeric type] || cluster
[numeric types]

The numeric scalars can be a floating-point, integer or complex,
number. G does not allow you to use arrays of arrays.

Arrays can have any number of dimensions of any size. Clusters can have
any number of elements. For functions with one input, the functions operate
on each element of the structure.

For functions with two inputs, you can use the following input
combinations:

e Similar—both inputs have the same structure, and the output has the
same structure as the inputs.

*  One scalar—one input is a numeric scalar, the other is an array or
cluster, and the output is an array or cluster.

e Array of—one input is a numeric array, the other is the numeric type
itself, and the output is an array.

For similar inputs, G performs the function on the respective elements of
the structures. For example, G can add two arrays element by element.
Both arrays must have the same dimensionality. You can add arrays with
differing numbers of elements; the output of such an addition has the same
number of elements as the smallest input. Clusters also must have the same
number of elements, and the respective elements must have the same
structure.

You cannot use the multiply function to do matrix multiplication. If you use the
multiply function with two matrices, G takes the first number in the first row of the
first matrix, multiplies it by the first number in the first row of the second matrix,
and so on.
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Chapter 4 Numeric Functions

For operations involving a scalar and an array or cluster, G performs the
function on the scalar and the respective elements of the structure.

For example, G can subtract a number from all elements of an array,
regardless of the dimensionality of the array.

For operations that involve a numeric type and an array of that type,

G performs the function on each array element. For example, a graph is an
array of points, and a point is a cluster of two numeric types, x and y. To
offset a graph by 5 units in the x direction and 8 units in the y direction, you
can add a point, (5, 8), to the graph.

The Polymorphic Combinations example below illustrates some of the
possible polymorphic combinations of the Add function.

Sirnilar One Scalar

zoalar
soalar :|>_ Al scalar :l>— array
array :I% artay aray
array gralar ;[% cluster
cluster ﬁ>m cluster cluster
cluster

Array of

array of clusters

= aray of clusters
cluster =

Polymorphism for Transcendental Functions

The transcendental functions accept numeric input data. If the input is an
integer, the output is a double-precision, floating-point number. Otherwise,
the output has the same numeric representation as the input.

These functions work on numbers, arrays of numbers, clusters of numbers,
arrays of clusters of numbers, complex numbers, and so on.

Polymorphism for Conversion Functions

All the conversion functions except Byte Array to String, String to Byte
Array, Convert Unit, and Cast Unit Bases are polymorphic. Therefore, the
polymorphic functions work on scalar values, arrays of scalars, clusters of
scalars, arrays of clusters of scalars, and so on. The output has the same
numeric representation as the input but with the new type.
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When you compare signed and unsigned integers and the signed integer is
negative, the negative integer is changed to positive before the comparison
occurs. Therefore, you do not get the expected results. For example, if you
enter —1 with representation 132 for one input and 5 with a representation
U32 as the other input, the result returned states that the minimum value
is 5, because 5 is less than 4294967295.

Polymorphism for Complex Functions

The complex functions work on scalar values, arrays of scalars, clusters of
scalars, arrays of clusters of scalars, and so on. The output has the same
composition as the input but with the new type.

Arithmetic Function Descriptions

The following functions are available.

Absolute Value

Returns the absolute value of the input.

abzx]

i+

Add

Computes the sum of the inputs.

B iy
¥y

Add Array Elements

Returns the sum of all the elements in numeric array.

NUMEric array I;I\'> UM
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Compound Arithmetic

Performs arithmetic on two or more numeric, cluster, or Boolean inputs.

walueld surn, product,
valued AND or OF of
RN R- walues

You select the operation (multiply, AND, or OR) by popping up on the function and selecting
Change Mode.

You can invert the inputs or the output of this function by popping up on the individual
terminals, and selecting Invert. For Add, select Invert to negate an input or the output. For
Multiply, select Invert to use the reciprocal of an input or to produce the reciprocal of the
output. For AND or OR, select Invert to logically negate an input or the output.

Note You add inputs to this node by popping up on an input and selecting Add Input or
by placing the Positioning tool in the lower left or right corner of the node and
dragging it.

Decrement

Subtracts 1 from the input value.

Divide

Computes the quotient of the inputs.

e
¥y wy

Increment
Adds 1 to the input value.

H—IE—H{I
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Multiply

Returns the product of the inputs.

e
¥
¥

Multiply Array Elements

Returns the product of all the elements in numeric array.

NUmMEric array {b product

Negate

Negates the input value.

e D X

Quotient & Remainder

Computes the integer quotient and the remainder of the inputs.

Y [ R} sy floar=Ay]
¥ —'_ml_‘— flar=dy]

If the integer input value of y is zero, the quotient is zero and the remainder is dividend x. For
floating point inputs, if y is zero, the quotient is infinity and the remainder defaults to NaN.

Random Number (0-1)

Produces a double-precision floating-point number between 0 and 1 exclusive, or not
including 0 and 1. The distribution is uniform.

number; 0to 1
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Reciprocal
Divides 1 by the input value.

X % 1

Round To +Infinity

Rounds the input to the next highest integer. For example, if the input is 3.1, the result is 4.
If the input is —3.1, the result is —3.

¥ D ceill] smallest int >= =

Round To —Infinity

Rounds the input to the next lowest integer. For example, if the input is 3.8, the result is 3.
If the input is —3.8, the result is —4.

X E]} floar(=]: largest int <=«

Round To Nearest

Rounds the input to the nearest integer. If the value of the input is midway between two
integers (for example, 1.5 or 2.5), the function returns the nearest even integer (2).

number ED nearest integer value

Scale By Power Of 2

Multiplies one input (x) by 2 raised to the power of the other input (n). If n is a floating-point
number, this function rounds n prior to scaling x (0.5 rounds to 0; 0.51 rounds to 1). If x is an
integer, this function is the equivalent of an arithmetic shift.

n :E}‘/\,_ W
X
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Sign
Returns 1 if the input value is greater than 0, returns O if the input value is equal to 0, and

returns —1 if the input value is less than 0. Other programming languages typically call this
function the signum or sgn function.

[z,
number ek 1,01

Square Root

Computes the square root of the input value. If x is negative, the square root is NaN unless
X is complex.

X & aart[x]

Subtract

Computes the difference of the inputs.

bt
i
¥

User Definable Arithmetic Constants
You can define the following constants.

Numeric Constant

7z3] Use this constant to supply a constant numeric value to the block diagram. Set this value by
clicking in the constant with the Operating tool and typing a value. You can change the data
format and representation.

The value of the numeric constant cannot be changed while the VI executes. You can assign
a label to this constant.

Enumerated Constant

Enumerated values associate unsigned integers to strings. If you display a value from an
enumerated constant, the string is displayed, instead of the number associated with it. If you
need a set of strings that do not change, then use this constant. Set the value by clicking in the
constant with the Operating Tool. Set the string with the Labeling Tool and enter the string.
To add another item, click the constant and choose Add Item Before or Add Item After.
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The value of the enumerated constant cannot be changed while the VI executes. You can
assign a label to this constant.

Ring Constant

Rings associate unsigned integers to strings. If you display a value from a ring constant, the
number is displayed, instead of the string associated with it. If you need a set of strings that
do not change, then use this constant. Set the value by clicking the constant with the Operating
tool. Set the string with the Labeling tool and enter the string. To add another item, pop up on
the constant and choose Add Item Before or Add Item After.

The value of the Ring constant cannot be changed while the VI executes. You can assign a
label to this constant.

Conversion Functions Descriptions

The following illustration shows the options that are available on the Conversion subpalette.
=1

11g) J116) J132) Jug) Juiel Ju32)

ISGL) JDBL) JEXT) IGSGI cxT)

The following functions convert a numeric input into a specific representation:
* To Byte Integer

*  To Double Precision Complex
*  To Double Precision Float

* To Extended Complex

*  To Extended Precision Float

* To Long Integer

*  To Single Precision Complex
* To Single Precision Float

*  To Unsigned Byte Integer

*  To Unsigned Word Integer

e To Unsigned Long Integer

*  To Word Integer
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When these functions convert a floating-point number to an integer, they round the output to
the nearest integer, or the nearest even integer if the fractional part is 0.5. If the result is out
of range for the integer, these functions return the minimum or maximum value for the integer
type. When these functions convert an integer to a smaller integer, they copy the
least-significant bits without checking for overflow. When they convert an integer to a larger
integer, they extend the sign of a signed integer and pad an unsigned integer with zeros.

Use caution when you convert numbers to smaller representations, particularly when
converting integers, because the G conversion routines do not check for overflow.

Boolean Array To Number
Converts Boolean array to an unsigned long integer by interpreting it as the two’s
complement representation of an integer, with the 0™ element of the array being the
least-significant bit.

Boolean amay number

Boolean To (0,1)

Converts a Boolean value to a word integer— 0 and 1 for the input values FALSE and TRUE,
respectively.

Boolean TFo:1} 0.1

Boolean can be a scalar, an array, or a cluster of Boolean values, an array of clusters of
Boolean values, and so on. See the Polymorphism for Boolean Functions section in Chapter 5,
Boolean Functions.

Byte Array To String

Converts an array of unsigned bytes into a string.

unsigned byte array ztring
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Cast Unit Bases

Changes the units associated with the input to the units associated with unit and returns the
results at the output terminal. Use this function with extreme caution. Because the Cast Unit
Bases function works with bases, you must understand the conversion from an arbitrary unit
to its bases before you can use this function effectively. This function can change base units,
such as changing meters to grams.

unit [none] —‘_|
X Lo

Convert Unit

Converts a physical number (a number that has a unit) to a pure number (a number with no
units), or a pure number to a physical number.

*—m 7=

You can edit the string inside the unit by highlighting the string with the Operating tool then
entering the text.

If the input is a pure number, the output receives the specified units. For example, given an
input of 13 and a unit specification of seconds(s), the resulting value is 13 seconds.

If the input is a physical number and unit is a compatible unit, the output is the input measured
in the specified units. For example, if you specify 37 meters(m), and unit is meters, the result
is 37 with no associated units. If unit is feet (ft), the result is 121.36 with no associated units.

Number To Boolean Array
Converts an integer number to a Boolean array of 8, 16, or 32 elements, where the 0 element
corresponds to the least-significant bit (LSB) of the two’s complement representation of the
integer.

number Boolean aray

String To Byte Array

Converts string into an array of unsigned bytes.

glring unzigned byte array
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To Byte Integer

Converts number to an 8-bit integer in the range —128 to 127.

number 118} abit integer

To Double Precision Complex
Converts number to a double-precision complex number.

number ICDE} double precizion complex

To Double Precision Float
Converts number to a double-precision floating-point number.

numhber JDEL} double precision float

To Extend Precision Complex

Converts number to an extended-precision complex number.

]

number IGET} extended precizion comples

To Extended Precision Float
Converts number to an extended-precision floating-point number.

number EXT) extended precizion float

To Long Integer
Converts number to a 32-bit integer in the range 2302311

number 1132} 32bit integer
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To Single Precision Complex

Coverts number to a single-precision complex number.

numher ICSG] gingle precizion comples

To Single Precision Float
Converts number to a single-precision floating-point number.

number ISGL} gingle precizion float

To Unsigned Byte Integer

Converts number to an 8-bit unsigned integer in the range 0 to 255.

numhber 1U8 | unzigned Bhit integer

To Unsigned Long Integer
Converts number to a 32-bit unsigned integer in the range 0 to 2321,

number 132} = unsigned 32bit integer

To Unsigned Word Integer

Converts number to a 16-bit unsigned integer in the range 0 to 65,535.

number 1U16} unzigned 16kt integer

To Word Integer
Converts number to a 16-bit integer in the range —32,768 to 32,767.

numher 1116} 16hit integer
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Trigonometric and Hyperbolic Functions Descriptions

The following illustration shows the options for the Trigonometric subpalette.

[ X

""" i I,r"\,l g ﬁ':'?"\\'r E‘EL""
ol [Aeds | Ciranl b Esind [ 54 ] [P
.(;Il civgi] [ =1 Tarn | an ncu::ug'u Jeitiun
=R

E :; . (R
S | I s H : FAEE H
CoC| [y SEC | 1 YT -JI{J':':'s ATAME| | SINE

3

Cosecant
Computes the cosecant of x, where x is in radians. Cosecant is the reciprocal of sine.

1zin )

Cosine
Computes the cosine of x, where x is in radians.

X qu.-;.s'k coE(x]

Cotangent

Computes the cotangent of x, where X is in radians. Cotangent is the reciprocal of tangent.

IGJ 1/tanx]

ST

Hyperbolic Cosine

Computes the hyperbolic cosine of x.

)

Lo

cozhlx]
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Hyperbolic Sine

Computes the hyperbolic sine of x.

X EIEHH zinki[x]

Hyperbolic Tangent

Computes the hyperbolic tangent of x.

X : ; tarilx]

Inverse Cosine

Computes the arccosine of x in radians. If x is not complex and is less than —1 or greater
than 1, the result is NaN.

ry

X 5o arcoog(x)]

Inverse Hyperbolic Cosine
Computes the hyperbolic argcosine of x. If X is not complex and is less than 1, the result

is NaN.
Y 3"/. aracosh(x]
[ACOSH-
Inverse Hyperbholic Sine
Computes the hyperbolic argsine of x.
X - argzinh(x]
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Inverse Hyperbolic Tangent

Computes the hyperbolic argtangent of x. If x is not complex and is less than —1 or greater
than 1, the result is NaN.

X : m: ) argtanhix]

Inverse Sine

Computes the arcsine of X in radians. If X is not complex and is less than —1 or greater than 1,
the result is NaN.

: arczin(x]
ASIH|

Inverse Tangent
Computes the arctangent of x in radians (which can be between —T1/2and 11/2).

e
X ; arctan(x
"'f;mn [#]

Inverse Tangent (2 Input)
Computes the arctangent of y/x in radians. This function can compute the arctangent for
angles in any of the four quadrants of the x-y plane, whereas the Inverse Tangent function
computes the arctangent in only two quadrants.

—"i

y xﬁﬂxI'I atanzw.y

X ATANZ

Secant
Computes the secant of x, where X is in radians.

o

X 1/cogx]
[oysecy]
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Sinc
Computes the sine of x divided by x, where X is in radians.
X e zin[®]
SINE
Sine
Computes the sine of x, where X is in radians.
X [ inx]
Rt 211 |

Sine & Cosine
Computes both the sine and cosine of X, where x is in radians. Use this function only when
you need both results.

vl ginx]
H i,
i cos(x]

Tangent

Computes the tangent of x, where X is in radians.

karx]

H
EREAE

Logarithmic Functions Descriptions

The following illustration shows the options for the Logarithmic subpalette.

[Frea] J
L5 =
: Ei, x &
B | e | e H
L] =i LK EMp -1
q q 1 1 - :
i L il il Aini
Il"E" 10 I{Z I{x T e
LH LOG QG G LH+)
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Exponential

Computes the value of e raised to the x power.

explx]

Exponential (Arg) -1
Computes 1 less than the value of e raised to the x power. When x is very small, this function
is more accurate than using the Exponential function then subtracting 1 from the output.

B-ficy

exp(#] -1

—..i1
EXP-1

Logarithm Base 2

Computes the base-2 logarithm of x. If x is 0, log2(x) is —co. If x is not complex and is less
than 0, log2(x) is NaN.

1

¥ |{-:-2-:u log2{x]

Logarithm Base 10

Computes the base-10 logarithm of x. If x is 0, log(x) is —. If x is not complex and is less
than 0, log(x) is NaN.

X fii loglx]
Lo

Logarithm Base X

Computes the base x logarithm of y (x>0, y>0). If y is 0, the output is —c0. When x and y are
both not complex and x is less than or equal to 0, or y is less than 0, the output is NaN.

1
y— i
i lagxiv]

X
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Natural Logarithm

Computes the natural base e logarithm of x. If x is 0, In(x) is —o. If x is not complex and is
less than 0, In(x) is NaN.

X i & [F[=]

Natural Logarithm (Arg +1)
Computes the natural logarithm of (x + 1). When x is near 0, this function is more accurate
than adding 1 to x then using the Natural Logarithm function. If x is equal to —1, the result is
—oo, If x is not complex and is less than —1, the result is NaN.

x ——{ e Infs+1)
LHgeHy
Power Of 2
Computes 2 raised to the x power.
X Moz 2
S
Power Of 10
Computes 10 raised to the x power.
H P 107
T EHE]

Power Of X

Computes x raised to the y power. If x is not complex, it must be greater than zero unless y is
an integer value. Otherwise, the result is NaN. If y is zero, x"y is 1 for all values of x,
including zero.

Wy
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Complex Function Descriptions

The following illustration displays the options available on the Complex subpalette.

[ X

2 B2kl B R

The functions Polar To Complex and Re/Im To Complex create complex numbers from two
values given in rectangular or polar notation. The functions Complex To Polar and Complex
To Re/Im break a complex number into its rectangular or polar components.

Complex Conjugate
Produces the complex conjugate of x + iy.

¥+ iy Lc_.mf M-y

Complex To Polar

Breaks a complex number into its polar components.

[ * e"(i"theta) .

Complex To Re/Im

Breaks a complex number into its rectangular components.

Polar To Complex

Creates a complex number from two values in polar notation.

theta: & r* e”[i*theta)
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Re/Im To Complex

Creates a complex number from two values in rectangular notation.

— Y
¥

Additional Numeric Constants Descriptions

The following illustration shows the options available on the Additional Numeric Constants
subpalette.

sl Additional Numeric Constants |

[ [ b kg b2 E
HEEGEERBME

Additional User Definable Constants
You can define the following constants.

Listhox Symbol Ring Constant

This ring constant assigns symbols to items in a listbox control. Typically, you wire this
constant to the Item Symbols attribute.

Color Box Constant

Use this constant to supply a constant color value to the block diagram. Set this value by
clicking the constant with the Operating tool and choosing the desired color.

The value of the Color Box constant cannot be changed while the VI executes. You can assign
a label to this constant.
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Error Ring Constant

This constant is a predefined ring of errors specific to memory usage, networking, printing,
and file I/O. Errors related to DAQ, GPIB, VISA, and Serial VIs and functions are not options

in this ring.

Fixed Constants

Avogadro Constant (1/mol)
Returns the value 6.0220e23.
] Base 10 Logarithm of e
Returns the value 0.43429448190325183.
Elementary Charge (c)
Returns the value 1.6021892¢—19.
Gravitational Constant (Nm2/kg?)
Returns the value 6.6720e—11.
[£] Molar Gas Constant (J/mol K)
Returns the value 8.31441.
E| e
Returns the value 2.7182818284590452¢+0.
[.] Natural Logarithm of Pi
Returns the value 1.14472988584940020.
Natural Logarithm of 2
Returns the value 0.69314718055994531.
Natural Logarithm of 10
Returns the value 2.30234095236904570.
— Negative Infinity
Returns the value —co.
LabVIEW Function and VI Reference Manual 4-22
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Pi

Returns the value 3.14159265358979320.
Pi divided by 2

Returns the value 1.57079632679489660.
Pi multiplied by 2

Returns the value 6.28318530717958650.
Planck’s Constant (J/Hz)

Returns the value 6.6262¢-34.

=] Positive Infinity

Returns the value .

l

=1 Reciprocal of e
Returns the value 0.36787944117144232.

-] Reciprocal of Pi
Returns the value 0.31830988618379067.

= Rydberg Constant (/m)
Returns the value 1.097373177¢7.

Speed of Light in Vacuum (m/sec)
Returns the value 299,792,458.
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Boolean Functions

This chapter describes the functions that perform logical operations.

The following illustration shows the Boolean palette, which you access by
selecting Functions»Boolean.
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For examples of some of the Boolean functions, see examples\
general\structs.llb.

Polymorphism for Boolean Functions

The logical functions take either Boolean or numeric input data. If the input
is numeric, G performs a bit-wise operation. If the input is an integer, the
output has the same representation. If the input is a floating-point number,
G rounds it to a long integer, and the output is a long integer.

The logical functions work on arrays of numbers or Boolean values,

clusters of numbers or Boolean values, arrays of clusters of numbers or
Boolean values, and so on.
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A formal and recursive definition of the allowable input type is as follows:

Logical type = Boolean scalar || numeric scalar || array [logical type] ||
cluster [logical types]

except that complex numbers and arrays of arrays are not allowed.

Logical functions with two inputs can have the same input combinations as
the arithmetic functions. However, the logical functions have the further
restriction that the base operations can only be between two Boolean values
or two numbers. For example, you cannot have an AND between a Boolean
value and a number. See the example below for an illustration of some
combinations of Boolean values for the And function.

Similar One Scalar

_ -------- Eaolean scalar

Boalean scalar -
Boolean scalar -

Boolean scalar ...
Boalean array
Boalean array

Boolean array Boolean array
Boalean array
Boalean scalar

Boolean cluster e = Boolean closter

cluster
cluster

array of clusters o=
cluster oo

Boolean Function Descriptions

The following Boolean functions are available.

And
Computes the logical AND of the inputs.
w.and. y?
Note This function performs bit-wise operations on numeric inputs.
LabVIEW Function and VI Reference Manual 5-2 © MNational Instruments Corporation




Chapter 5 Boolean Functions

And Array Elements
Returns TRUE if all the elements in Boolean array are true; otherwise it returns FALSE.

Boolean array I‘-:-" logical AMD

Boolean Array To Number
Converts Boolean array to an unsigned long integer by interpreting it as the two’s
complement representation of an integer with the Oth element of the array being the least
significant bit.

Boolean array rrmber

Boolean To (0,1)

Converts a Boolean value to a word integer — 0 and 1 for the input values FALSE and TRUE,
respectively.

Boolean 1201} 0.1

Compound Arithmetic

Performs arithmetic on two or more numeric, cluster, or Boolean inputs.

walueld sum, product,
valuel AND or OF of
RN R- walues

You choose the operation (multiply, AND, or OR) by popping up on the function and selecting
Change Mode.

You can invert the inputs or the output of this function by popping up on the individual
terminals and selecting Invert. For Add, select Invert to negate an input or the output. For
Multiply, select Invert to use the reciprocal of an input or to produce the reciprocal of the
output. For AND or OR, select Invert to logically negate an input or the output.

Note You add inputs to this node by popping up on an input and selecting Add Input or
by placing the Positioning tool in the lower left or right corner of the node and
dragging it.
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Exclusive Or

Computes the logical exclusive OR of the inputs.

Implies

Computes the logical OR of y and of the logical negation of x. The function negates x then
computes the logical OR of y and of the negated x.

B % impliss, y?
p
Not
Computes the logical negation of the input.
¥ a|;> .hot, =7
Not And

Computes the logical NAND of the inputs.

Not Exclusive Or

I L) S— ok, [ .and. u]?

[

Computes the logical negation of the logical exclusive OR of the inputs.

Not Or

chiat, [ waor, w]?

Computes the logical NOR of the inputs.

LabVIEW Function and VI Reference Manual
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Number To Boolean Array
Converts number to a Boolean array of 8, 16, or 32 elements, where the 0™ element
corresponds to the least significant bit (LSB) of the two's complement representation of the
integer.

number Boolean array

Or

Computes the logical OR of the inputs.

Or Array Elements
Returns FALSE if all the elements in Boolean array are false; otherwise it returns TRUE.

Boolean amray Iﬁl/\ logical OR

Boolean Constant

Use this function to supply a constant TRUE/FALSE value to the block diagram. Set this
value by clicking the T or F portion of the constant with the Operating tool. This value cannot
be changed while the VI executes. You can assign a label to this constant.
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String Functions

This chapter describes the string functions, including those that convert
strings to numbers and numbers to strings.

The following illustration shows the String palette, which you access by
selecting Functions»String.

[ X

abz

Overview of Polymorphism for String Functions

This section provides descriptions of polymorphism for String functions,
Additional String to Number functions, and String Conversion functions.

Polymorphism for String Functions

String Length, To Upper Case, To Lower Case, Reverse String, and Rotate
String accept strings, clusters, arrays of strings, and arrays of clusters.
To Upper Case and To Lower Case also accept numbers, clusters of
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numbers, and arrays of numbers, interpreting them as ASCII codes for
characters (refer to the Appendix C, GPIB Multiline Interface Messages for
the numbers that correspond to each character). Width and precision inputs
must be scalar.

Polymorphism for Additional String to Number Functions

To Decimal, To Hex, To Octal, To Engineering, To Fractional, and

To Exponential accept clusters and arrays of numbers and produce clusters
and arrays of strings. From Decimal, From Hex, From Octal, and From
Exponential/Fract/Sci accept clusters and arrays of strings and produce
clusters and arrays of numbers. Width and precision inputs must be scalar.

Polymorphism for String Conversion Functions

The Path To String and String To Path functions are polymorphic. They
work on scalar values, arrays of scalars, clusters of scalars, arrays of
clusters of scalars, and so on. The output has the same composition as the
input but with the new type.

Format Strings Overview

Many G functions accept a format string input, which controls the
behavior of the function. A format string is composed of one or more
format specifiers, which determine what action to take to process a given
parameter. The Format Into String and Scan From String functions can use
multiple format specifiers in the format string, one for each resizable input
or output to the function. Characters in the string that are not part of the
format specifier are copied verbatim to the output string (in the case of
Format Into String) or are matched exactly in the input string (in the case
of Scan From String), with the exception of special escape codes. You can
use these codes to insert nondisplayable characters, the backslash, and
percent characters within any format string. These codes are similar to
those used in the C programming language.

Table 6-1 displays the special escape codes. A code does not exist for the
platform-dependent end-of-line (EOL) character. If you need to append
one, use the End-of-Line constant from the String palette.
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Table 6-1. Special Escape Codes

Code Meaning

\r Carriage Return

\t Tab

\b Backspace

\n Newline

\f Form Feed

\'s space
\xx character with hexadecimal ASCII code xx

(using O through 9 and upper case A through F)

\\ \

%% %

Notice that for the Scan From String and Format & Strip functions, a space
in the format string matches any amount of whitespace (spaces, tabs, and
form feeds) in the input string.

The Format & Append, Format & Strip, Array To Spreadsheet String, and
Spreadsheet String To Array functions use only one format specifier in the
format string because these functions have only one input that can be
converted. Any extraneous specifiers inserted into these functions are
treated as literal strings with no special meaning.

For functions that produce a string as output, such as Format Into String,
Format & Append, and Array To Spreadsheet String, a format specifier has
the following syntax. Double brackets ( [] ) enclose optional elements.

S[-1[+1["][0] [Width][.Precision] [{unit}]Conversion Code

For functions that scan a string, such as Scan From String, Format & Strip,
and Spreadsheet String to Array, a format specifier has the following,
simplified syntax:

% [Width]Conversion Code
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Table 6-2 displays the string syntax available.

Table 6-2. String Syntax

Syntax Element Description
% Begins the formatting specification.
— (optional) Causes the parameter to be left justified rather

than right justified within its width.

+ (optional) For numeric parameters, includes the sign even
when the number is positive.

~ (optional) When used with the e or g conversion codes, uses
engineering notation (exponent is always a
multiple of 3).

0 (optional) Pads any excess space to the left of a numeric

parameter with Os rather than spaces.

Width (optional) When scanning, specifies an exact field width to
use. G scans only the specified number of
characters when processing the parameter.

When formatting, specifies the minimum
character field width of the output. This width is
not a maximum width; G uses as many characters
as necessary to format the parameter without
truncating it. G pads the field to the left or right
of the parameter with spaces, depending on
justification. If width is missing or zero, the
output is only as long as necessary to contain the
converted input parameter.

Separates Width from Precision.

Precision For floating-point parameters, specifies the
(optional) number of digits to the right of the decimal point.
If width is not followed by a period, G inserts a
fractional part of six digits. If width is followed
by a period, and Precision is missing or 0,

G does not insert a fractional part.

For string parameters, specifies the maximum
width of the field. G truncates strings longer than
this length.
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Table 6-2. String Syntax (Continued)

Syntax Element Description

{unit} (optional) | Overrides the choice of unit of a VI when
converting a physical quantity (a value with an
associated unit). Must be a valid unit.

Conversion Codes | Single character that specifies how to scan or
format perimeter, as follows:

d decimal integer

hex integer

octal integer

binary integer

floating-point number with

fractional format

Hh O O X

e floating-point number with
scientific notation

g floating-point number using e format
if the exponential is less than —4 or greater
than Precision, or £ format otherwise

s string

An 1 (lowercase L) preceding the conversion

Localization Codes | Codes used as format separators for localization,
as follows:

comma decimal separator

.; period decimal separator

; system default separator

~
~

o° oo oe

The conversion codes used in G are similar to those used in the
C programming language. However, G uses conversion codes to determine
the textual format of the parameter, not the datatype of the parameter.

You can use the d, x, o, b, £, e, and g conversion codes to process any
numeric G data type, including complex numbers and enums.

For complex numbers, you can use the format specifier to process both the
real and imaginary parts as a single parameter.

You can use the s conversion code to process string or path parameters or
enums.
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Notice that you can use either a numeric or string conversion code with an
enum, depending on whether you want the numeric value or symbolic
(string) value of the enum.

For compatibility with C, G treats a u conversion code (unsigned integer)
the same as a d, and ignores an 1 or L preceding the conversion code.
However, in G, the datatype of the parameter determines the size of an
integer and whether the integer is signed or unsigned.

For examples of format string usage, see the Format Into String and Scan
From String function descriptions later in this chapter.

String Function Descriptions

The following string functions are available.

Array To Spreadsheet String
Converts an array of any dimension to spreadsheet string. spreadsheet string is a table in
string form, containing delimiter-separated column elements, a platform-dependent EOL
character separating rows, and, for arrays of three or more dimensions, separated pages.

format string

dzheet st
anay spreadsheet sting

Concatenate Strings

Concatenates input strings and one-dimensional arrays of strings into a single, output string.
For array inputs, this function concatenates each element of the array.

string O :||:|+ concatenation of
i =
stri'mg ! 15+ ; stringd, stringl, .., string n-1

Format Into String
Converts input arguments into resulting string, whose format is determined by format
string. You increase the number of parameters by popping up on the node and selecting Add
Parameter or by placing the Positioning tool over the lower left or right corner of the node,
then stretching it until you reach the desired number of arguments.
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forrat string
initial string

error in (na errar)
argurment 1000

resulting string
error aut

Table 6-3 shows the errors that can appear in error out by the Format Into String function.

Table 6-3. Possible Format into String Errors

Error Code Description
Format specifier type 81 The datatype of a format specifier in the format string
mismatch does not match the datatype of the corresponding

input argument.

Unknown format 82 The format string contains an invalid format specifier.
specifier
Too few format 83 There are more arguments than format specifiers.
specifiers
Too many format 84 There are more format specifiers than arguments.
specifiers

Note If an error occurs, the source component of the error out cluster contains a string

of the form “Format Into String (arg n),” where nis the first argument
for which the error occurred.

If you wire a block diagram constant string to format string, G checks for errors in format
string at compile time. You must correct these errors before you can run the VI. In this case,
N0 errors can occur at run time.

Format Specifier Examples

In Table 6-4, the underline character (_) represent spaces in the output. The last three entries
are examples of physical quantity inputs.

Table 6-4. Format Specifiers

Format String Argument(s) Resulting String
score = %2d%% 87 score = 87%
level = \n%-7.2e V | 0.03642 level =
3.64e-2 V
Name: %s, %s. Smith John Name: Smith, John.
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Table 6-4. Format Specifiers (Continued)

Format String Argument(s) Resulting String
Temp: %$05.1f $s 96.793 Fahrenheit Temp: 096.8 Fahrenheit
String: %10.5s. Hello, World String:______ Hello.
%$5.3f 567N 5.670 N
$5.3{mN} £ 5.67TN 5670.000 mN
%$5.3{kg}f 567N 5.670 ?kg

The last table entry shows the output when the unit in the format specifier is in conflict with
the input unit.

Index & Append

Selects a string specified by index from string array and appends that string to string.

string array
string [ E%
<

index .

aLtput string

Index & Strip

Compares each string in string array with the beginning of string until there is a match.

shring |r~§_..=' indes
string array %g: oLtput ztring

Match Pattern

Searches for regular expression in string beginning at offset, and if it finds a match, splits
string into three substrings.

before substing
match substring
after substring
offzet past match

reqular expression
gtrning ~
offzet (0]
LabVIEW Function and VI Reference Manual 6-8

© National Instruments Corporation
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Table 6-5. Special Characters for Match Pattern

Special Character Interpreted by the Match Pattern Function as...

Matches any character.

? Matches zero or one instances of the expression preceding 2.

\ Cancels the interpretation of special characters (for example,
\ 2 matches a question mark). You can also use the following
constructions for the space and non-displayable characters:
\b  backspace

\f form feed

\n  newline

\'s space

\r  carriage return

\xx any character, where xx is the hex code using 0 through 9
and upper case A through F

\t tab

If ~ is the first character of regular expression, it anchors the match
to the offset in string. The match fails unless regular expression
matches that portion of string that begins with the character at
offset. If ~ is not the first character, it is treated as a regular
character.

[ ] Encloses alternates. For example, [abc] matches a, b, or c.
The following character has special significance when used within
the brackets:

- (dash) Indicates a range when used between digits, or lowercase
or uppercase letters (for example, [0—5],[a—g], or [L-Q])

The following characters have significance only when they are the
first character within the brackets:

~ Excludes the set of characters, including nondisplayable
characters. [~0—9] matches any character other than O through 9.

~ Excludes the set with respect to all the displayable characters
(and the space characters). [*0—9] gives the space characters and all
displayable characters except O through 9.
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Table 6-5. Special Characters for Match Pattern (Continued)

Special Character

Interpreted by the Match Pattern Function as...

+ Matches the longest number of instances of the expression
preceding +; there must be at least one instance to constitute a
match.

* Matches the longest number of instances of the expression

preceding * in regular expression, including zero instances.

$ If s is the last character of regular expression, it anchors the
match to the last element of string. The match fails unless
regular expression matches up to and including the last character
in the string. If $ is not last, it is treated as a regular character.

Table 6-6 shows examples of the Strings for the Match Pattern functions.

Table 6-6. Strings for the Match Pattern Examples

Characters to Be Matched

Regular Expression

VOLTS

VOLTS

All uppercase and lowercase versions of
volts, that is, VOLTS, Volts, volts, and
SO on

[Vv] [Oo] [L1] [Tt] [Ss]

A space, a plus sign, or a minus sign

[ +-1

A sequence of one or more digits

[0-9]1+

Zero or more Spaces

\s* or * (that is, a space followed by an
asterisk)

One or more Spaces, Tabs, New Lines, or
Carriage Returns

[\t \r \n \s]l+

One or more characters other than digits [~0-91+
The word Level only if it begins at the ~Level
offset position in the string

The word Volts only if it appears at the end | Volts$
of the string

The longest string within parentheses (.%)
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Table 6-6. Strings for the Match Pattern Examples (Continued)

Characters to Be Matched Regular Expression

The longest string within parentheses but ([~C)H)1*%)
not containing any parentheses within it

The character [ L[]

Pick Line & Append

Chooses a line from multi-line string and appends that line to string.

multi-line string
stritg ) WS E|
" <

line index . output string

Reverse String

Produces a string whose characters are in reverse order of those in string.

ztring Jab-bal reversed

Rotate String

Places the first character of string in the last position of first char last, shifting the other
characters forward one position. For example, the string abcd becomes bcda.

string LI ]II firzt char last

Scan From String

Scans the input string and converts the string according to format string. You increase the
number of parameters by popping up on the node and selecting Add Parameter or by placing
the Positioning tool over the lower left or right corner of the node, then stretching it until you
reach the desired number of parameters.

Use Scan From String when you know the exact format of the input string.

format string

input string []wald remaining string
initial search location .t offzet past scan
error in [no error) [ error out
default 1 (0 db1) & [ autput 1
i eesiens =
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Table 6-7 lists the Scan from String errors.

Table 6-7. Scan from String Errors

Error Code Description

Format specifier type mismatch 81 The datatype of a format specifier
in the format string does not match
the datatype of the corresponding
output.

Unknown format specifier 82 The format string contains an
invalid format specifier.

Too few format specifiers 83 There are more arguments than
format specifiers.

Too many format specifiers 84 There are more format specifiers
than arguments.

Scan failed 85 Scan From String was unable to
convert the input string into the
datatype indicated by the format
specifier.

Note If an error occurs, the source component of the error out cluster contains a string
of the form “Scan From String (arg n),” where nis the first argument for
which the error occurred.

If you wire a block diagram constant string to format string, G checks for errors in format
string at compile time. You must correct these errors before you can run the VI. In this case,
only the Scan-failed error can occur at run time.

Table 6-8 lists Scan From String examples.

Table 6-8. Scan from String Examples

Format Remaining
Input String String Default(s) Output(s) String
abc xyz Y05 — abc 00
12.3+56i 7200 908 %0t %2d — XyZ
0&0i (CDB) 12.3+56i
— 72
Q+1.27E-3 tail Q%ft — 1.27E-3 ail
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Table 6-8. Scan from String Examples (Continued)

Format Remaining
Input String String Default(s) Output(s) String
0123456789 %3d%3d — 12 6789
345
X:9.860 Z:3.450 X:%ftY: %t 100 (I32) 10 Z: 3450
100.0 (DBL) 100.0
set49.4.2 set%d — 49 4.2

Scan String for Tokens

Scans input string, starting at offset, and returns the next token found.

dup ztring

offset past token
taken zting
token index

input ztring
offzet

delimiters [ha, )

A token is a substring of input string, which is surrounded by delimiters, or which matches
an element in operators. Typically, tokens represent individual keywords, numeric values,
or operators found when parsing a configuration file or other text-based data format.

This function scans input string, starting at offset, returning the next token found.

See the online reference for more information about the Scan String for Tokens function and
parameters.

Select & Append

Selects either false string or true string according to a Boolean selector and appends that
string to string.

falze stning
true stning

ghring [ e
selector

outpLt string
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Select & Strip

Examines the beginning of string to see whether it matches true string or false string. This
function returns a Boolean TRUE or FALSE value in selection, depending on whether string
matches true string or false string.

. - ]
sknng T zelection

I:.:I:E z::::g = autput string

Split String
Splits the string at offset or searches for the first occurrence of search char in string,
beginning at offset, and splits the string at that point.

substring before char
char subztring
offzet of char

search char [-]
zhring
aoffzet (0]

Spreadsheet String To Array

Converts spreadsheet string to a numeric array of the dimension and representation of
array type. This function works for arrays of strings as well as arrays of numbers.

format string [
spreadsheet string - = ’ array
aray type [20 Dbl =T &
String Length

Returns in length the number of characters (bytes) in string.

ztring ',m»u length
String Subset
Returns substring of the original string beginning at offset and containing length number of
characters.
length ——{m .
offzet (0] — &]ﬁ substring
string
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To Lower Case

Converts all alphabetic characters in string to lowercase characters. This function does not
affect non-alphabetic characters.

shring all lower case string

To Upper Case

Converts all alphabetic characters in string to uppercase characters. This function does not
affect non-alphabetic characters.

shring all upper case shing

Additional String To Number Function Descriptions

For general information about Additional String to Number functions, see Polymorphism for
Additional String to Number Functions, earlier in this chapter.

The following illustration displays the options available on the Additional String to Number
Functions subpalette.

Format & Append

Converts number into a regular string according to the format specified in format string, and
appends this to string.

format string
string [ B

number (0] — " output ztring
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% Note The Format Into String function has the same functionality as Format & Append
but can use multiple inputs, so you can convert information simultaneously.
Consider using Format Into String instead of this function to simplify your block
diagram.

Format & Strip
Looks for format string at the beginning of string, formats any number in this string portion
according to the conversion codes in format string, and returns the converted number in
number and the remainder of string after the match in output string.

format ing 719 W1 number
ormat ztnng _
default [0 dbl) 2 autput string

From Decimal
Converts the numeric characters in string, starting at offset, to a decimal integer and returns
it in number.

string
rumber

From Exponential/Fract/Eng
Interprets the characters O through 9, plus, minus, e, E, and the decimal point (usually period)
in string starting at offset as a floating-point number in engineering notation, or exponential
or fractional format and returns it in number.

nmber

15 Note If you wire the characters Inf or NaN to string, this function returns the G values
Inf and NaN, respectively.

From Hexadecimal
Interprets the characters O through 9, A through F, and a through f in string starting at offset
as a hex integer and returns it in number.

string

number
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From Octal
Interprets the characters O through 7 in string starting at offset as an octal integer and returns
it in number. This function also returns the index in string of the first character following the
number.

string

number

To Decimal
Converts number to a string of decimal digits width characters wide, or wider if necessary.

#7)
number decimal integer string
To Engineering

Converts number to an engineering format, floating-point string width characters wide, or
wider if necessary. Engineering format is similar to E format, except the exponent is a
multiple of three (-3, 0, 3, 6).

number ®F
——H[n.nE3

E higineering string

To Exponential

Converts number to an E-format (exponential notation), floating-point string width
characters wide, or wider if necessary.

number )
————{w[renEn] E -farmat string
N .

To Fractional

Converts number to an F-format (fractional notation), floating-point string width characters
wide, or wider if necessary.

number

AT
PR Ny F-farmat string
_I_H ...... .
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To Hexadecimal
Converts number to a string of hexadecimal digits width characters wide, or wider if
necessary.

number ‘*-_:%
'F LA

|

hex integer string

To Octal

Converts number to a string of octal digits width characters wide, or wider if necessary.

number “-;%
'? Rl

s

octal integer sting

String Conversion Function Descriptions

For general information about String Conversion functions, see Overview of Polymorphism
for String Functions earlier in this chapter.

The following illustration shows the String Conversion subpalette.

[ X

Array Of Strings To Path accepts one-dimensional (1D) arrays of strings, Path To Array Of
Strings accepts paths, Path To String accepts paths, and String To Path accepts strings.
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Array Of Strings To Path

Converts array of strings into a relative or absolute path.

If you have an empty string in the array, the directory location before the empty string is
deleted in the path output. Think of this change as moving up a level in directory hierarchy.

rE—'lEIti"-"E ........................

array of ztrings 1 ) path

Byte Array To String

Converts an array of unsigned bytes into a string.

unszigned byte array string

Path To Array Of Strings
Converts path into array of strings and indicates whether the path is relative.
........................ fEl-EIti"."E
path - ) array of strings

Path To String

Converts path into a string describing a path in the standard format of the platform.

path P abs shring

Refnum To Path

Returns the path associated with the specified refnum.

refnum 10 % } path

String To Byte Array

Converts string into an array of unsigned bytes.

ztring unzigned byte array
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String To Path

Converts a string, describing a path in the standard format for the current platform, to a path.

string Jab "o} path

String Fixed Constants

The following String Fixed Constants are available.

String Constant

Use this constant to supply a constant ASCII string to the block diagram. Set this string by
clicking the constant with the Operating tool and typing the value. You can change the display
mode so you can see non-displayable characters or the hex equivalent to the characters.
You also can set the constant in password display mode so asterisks are displayed when you
type characters.

The value of the string constant cannot be changed while the VI executes. You can assign a
label to this constant.

Carriage Return
Consists of a constant string containing the ASCII CR value.

Empty String

ﬂ Consists of a constant string that is empty. Length is zero.

End of Line

Consists of a constant string containing the platform-dependent, end-of-line value. For
Windows, the value is CRLF; for Macintosh, the value is CR; and for UNIX, the value is LF.

Line Feed
Consists of a constant string containing the ASCII LF value.
Tab

Consists of a constant string containing the ASCII HT (horizontal tab) value.
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Array Functions

This chapter describes the functions for array operations.

The following illustration shows the Array palette, which you access by
selecting Functions»Array.
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Some of the array functions also are available from the Array Tools palette
of most terminal or wire pop-up menus. The illustration below shows this
pop-up menu.

| Array Tools ) |

[E]E ] = [
=14 ] = ) ||'«|f b

MzEEER
[ n+ =

If you select functions from this palette, they appear with the correct
number of terminals to wire to the object on which you popped up.

For examples of array functions, see examples\general\arrays.llb.

Array Function Overview

Some of the array functions have a variable number of terminals.

When you drop a new function of this kind, it appears on the block diagram
with only one or two terminals. You can add and remove terminals by using
Add Element Input or Add Array Input and Remove Input pop-up
menu commands (the actual names depend on the function) or by resizing
the node vertically from any corner. If you want to add terminals by
popping up, you must place your pointer on the input terminals to access
the pop-up menu.

You can shrink the node if doing so does not delete wired terminals.

The Add Element Input or Add Array Input command inserts a terminal
directly after the one on which you popped up. The Remove Input
command removes the terminal on which you popped up, even if it is wired.
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The following illustration shows the two ways to add more terminals to the
Build Array function.

ra

1 2

L ==l - I'= ¥ [0, =+
Online Help =] ! ! =
Description... ! ! |
Show » - ==
Replace ]

Change to Arra
Add Array Input
Remove Input
Create Constant
Create Control
Create Indicator

Out-of-Range Index Values

Attempting to index an array beyond its bounds results in a default value
determined by the array element type.

Polymorphism for Array Functions

Most of the array functions accept n-dimensional arrays of any type.

However, the wiring diagrams in the function descriptions show numeric
arrays as the default data type.

Array Function Descriptions

The following Array functions are available.

Array Max & Min

Searches for the first maximum and minimum values in a numeric array. This function also
returns the index or indices where it finds the maximum and minimum values.

[WLE == rnas value
array E' max index [indices]

i walue
min index [indices)
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If a numeric array has one dimension, the max index and min index outputs are scalar
integers. If a numeric array has more than one dimension, these outputs are 1D arrays that
contain the indices of the maximum and minimum values.

The function compares each datatype according to the rules referred to in Chapter 9,
Comparison Functions.

Array Size

Returns the number of elements in each dimension of array.

array 1 zizefs]

Array Subset

Returns a portion of array starting at index and containing length elements.

array sub-array
indexfﬂ'_‘;l -t
e

Array To Cluster
Converts a 1D array to a cluster of elements of the same type as the array elements. Pop up
on the node to set the number of elements in the cluster. The default is nine. The maximum
cluster size for this function is 256.

AT ET—)1

array =], cluster

For more information about clusters, see Chapter 8, Cluster Functions.

Build Array

Appends any number of array or element inputs in top-to-bottom order to create array with
appended element.

FF 3L m—

array with appended element(s])

To change an element input to an array input, pop up on the input and select Change to Array.
In general, to build an array of n-dimensions, each array input must be of the same
dimension, n, and each element input must have n— 1 dimensions. To create a 1D array,
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connect scalar values to the element inputs and 1D arrays to the array inputs. To build a
2D array, connect 1D arrays to element inputs and 2D arrays to the array inputs.

Cluster To Array

Converts a cluster of identically typed components to a 1D array of elements of the same type.

cluster =0 array

For more information about clusters, see Chapter 8, Cluster Functions.

Decimate 1D Array
Divides the elements of array into the output arrays.

array of elernents 0, n, 2Zn, ...
array of elernents 1, n+1, 2n+l, .

array

Index Array

Returns the element of array at index. If array is multidimensional, you must add additional
index terminals for each dimension of array.

n-dimension array + o elernent ar
index 0O — = sub-array

: e :

e o e il Al

In addition to extracting an element of the array, you can slice out a higher-dimensional
component by disabling one or more of the index terminals.

Initialize Array
Creates an n-dimensional array in which every element is initialized to the value of element.

] ~ elerent—{=4 initialized
dimension E}ze? b+ | n—-dimension array

Hed
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Interleave 1D Arrays

Interleaves corresponding elements from the input arrays into a single output array.

arrayd
arrayil

interleaved array

ar'r"ag r-i

Interpolate 1D Array
Uses the integer part of fractional index or x to index the array and the fractional part of
fractional index or x to linearly interpolate between the values of the indexed element and
its adjacent element.

array of numbers or points ot
#

_ . g yvalue
fractional index or x *iTer

Replace Array Element
Replaces the element in array at index with the new element.

arrau [—b [ 3112w ith mew elernent
news elerment g!: ] !

index—lm-t

Reshape Array
Changes the dimension of an array according to the value of dimension size. The function is
resizable; m-dim array has one dimension for each dimension size input. For example, you
can use this function to change a 1D array into a 2D array or vice versa. You also can use it
to increase and decrease the size of a 1D array.

n-dirn artay +|§|— rn-dirn array
dimension size — w4

Reverse 1D Array
Reverses the order of the elements in array.

F o
amray oKl b s reversed array
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Chapter 7 Array Functions

Rotates the elements of array by the number of places and in the direction indicated by n.

array

n [‘ooo#] array [last n elements first)

idesw af element

Search 1D Array
Searches for element in 1D array starting at start index.
1D array [oozd]
element — Hm

start index [0] —

Sort 1D Array

Returns a sorted version of array with the elements arranged in ascending order. The rules
for comparing each datatype are described in Chapter 9, Comparison Functions.

array %

zorted array

Split 1D Array

Divides array at index and returns the two portions.

——
array i |
index o |

first subarray
zecond subarrap

Threshold 1D Array

Compares threshold y to the values in array of numbers or points starting at start index
until it finds a pair of consecutive elements such that threshold y is greater than the value of
the first element and less than or equal to the value of the second element.

The function then calculates the fractional distance between the first value and threshold y
and returns the fractional index at which threshold y would be placed within array of

numbers or points using linear interpolation.

array of numbers or points

threshold y —

f;.fﬁ"; fractional index ar »

start index [0] —

ETHEEZH
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Array Functions

For example, suppose array of numbers or points is an array of four numbers [4, 5, 5, 6],
start index is 0, and threshold y is 5. The fractional index or x is 1, corresponding to the
index of the first value of 5 the function finds. Suppose the array elements are 6, 5, 5, 7, 6, 6,
the start index is 0, and the threshold y is 6 or less. The output is 0. If threshold y is greater
than 7 for the same set of numbers, the output is 5. If threshold y is 14.2, start index is 5,
and the values in the array starting at index 5 are 9.1, 10.3, 12.9, and 15.5, threshold y falls
between elements 7 and 8 because 14.2 is midway between 12.9 and 15.5. The value for
fractional index or x is 7.5, that is, halfway between 7 and 8.

If the array input consists of an array of points where each point is a cluster of x and y
coordinates, the output is the interpolated x value corresponding to the interpolated position
of threshold y rather than the fractional index of the array. If the interpolated position of
threshold y is midway between indices 4 and 5 of the array with x values of —2.5 and 0
respectively, the output is not an index value of 4.5 as it would be for a numeric array, but
rather an x value of —1.25.

Transpose 2D Array

Rearranges the elements of 2D array such that 2D arrayl[i,j] becomes transposed array|[;,i].

2D amray tranzpozed array
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Cluster Functions

This chapter describes the functions for cluster operations.

The following illustration shows the Cluster palette that you access by
selecting Functions»Cluster.

[ X
| Cluster

]
[1EH

|

-2

Lexl
w
-

-

abi

%

x
-

XA ]

=

-| =

vm

eI ] |

1 [<ernp ] [Comnp]
| e
] e |

&E'
i
L

HJ
pi
10

I
$
=
=
==
=
==
[ B
++

B

H
mana| ({11

i

i
B

e
BE
2

I

© MNational Instruments Corporation 8-1 LabVIEW Function and VI Reference Manual



Chapter 8

Cluster Functions

Some of the cluster functions also are available from the Cluster Tools
palette of most terminal or wire pop-up menus. The following illustration
shows the pop-up menu.

[ M

Cnline Help
Description...
Show 3
Feplace 3

Cluster Tools

Create Constant
Create Control
Create Indicatar
Hide Full Mames =

If you select the functions from this palette, they appear with the correct
number of terminals to wire to the object on which you popped up.

Cluster Function Overview

Some of the cluster functions have a variable number of terminals.

When you drop a new function of this kind, it appears on the block diagram
with only one or two terminals. You can add and remove terminals by using
the Add Input or Remove Input pop-up menu options or by resizing the
node using the Positioning tool. If you want to add terminals by popping
up, place your cursor on the input terminal to access the pop-up menu.

You can shrink the node if doing so does not delete wired terminals.

The Add Input option inserts a terminal directly after the one on which
you popped up. The Remove Input option removes the terminal on which
you popped up, even if it is wired.
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The following illustration shows the two ways to add more terminals to the
Bundle function.

ra

|_:Eli]nline Help :'+ ’iﬁ:—’i

|
Description... :
Show [ !
Replace » !

Remove Input
Create Constant
Create Control
Create Indicator

¥

[T

Polymorphism for Cluster Functions

The Bundle and Unbundle functions do not show the datatype for their
individual input or output terminals until you wire objects to these
terminals. When you wire them, these terminals look similar to the
datatypes of the corresponding front panel control or indicator terminals.

Setting the Order of Cluster Elements

Cluster elements have a logical order that is unrelated to their positions
within the shell. The first object you insert in the cluster is element 0,

the second is 1, and so on. If you delete an element, the order adjusts
automatically. You can change the current order by selecting the Cluster
Order... option from the cluster pop-up menu.

Clicking an element with the cluster order cursor sets the place of the
element in the cluster order to the number displayed inside the Tools
palette. You change this order by typing a new number into that field.
When the order is as you want it, click the Enter button to set it and exit
the cluster order edit mode. Click the X button to revert to the old order.

The cluster order determines the order in which the elements appear as
terminals on the Bundle and Unbundle functions in the block diagram.

The Bundle By Name and Unbundle By Name functions give you more
flexible access to data in clusters. With these functions, you can access
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specific elements in clusters by name and access only the elements you
want to access. Because these functions reference components by name and
not by cluster position, you can change the data structure of a cluster
without breaking wires, as long as you do not change the name of or remove
the component you reference on the block diagram.

Cluster Function Descriptions

The following cluster functions are available.

Array To Cluster
Converts a 1D array to a cluster of elements of the same type as the array elements. Pop up
on the node or resize it to set the number of elements in the cluster. The default is nine.
The maximum cluster size for this function is 256.

array =], cluzter

Build Cluster Array
Assembles all the component inputs in top-down order into an array of clusters of that
component. If the input is four, single-precision, floating-point components, the output is a
four-element array of clusters containing one single-precision, floating-point number.
Element O of the array has the value of the top component, and so on.

artay of clusters of cornponent

Bundle

Assembles all the individual input components into a single cluster.

cluster
cnmpnnent%m
carmponent cluster
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Bundle By Name

Replaces components in an existing cluster. After you wire the node to a cluster, you pop up
on the name terminals to choose from the list of components of the cluster.

cluster
camponent 1 —— a1
cluster
cornponent 2 —name 2

You must always wire the cluster input. If you are creating a cluster for a cluster indicator,
you can wire a local variable of that indicator to the cluster input. If you are creating a cluster
for a cluster control of a subVI, you can place a copy of that control (possibly hidden) on the
front panel of the VI and wire the control to the cluster input.

Cluster To Array

Converts a cluster of identically typed components to a 1D array of elements of the same type.

cluster B} array!

Index & Bundle Cluster Array

Indexes a set of arrays and creates a cluster array in which the i element contains the i
element of each input array.

array of x +[=
array of y = array of cluster of ¢, , U, ., %;)

array of x

This function is equivalent to the following block diagram and is useful for converting a
cluster of arrays to an array of clusters.
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Unbundle

Disassembles a cluster into its individual components.

cornpanent
I:]"'Et'alrI““EE:m:-mFu:-n-ent

Unbundle By Name
Returns the cluster elements whose names you specify. You select the element you want to
access by popping up on the name output terminals and selecting a name from the list of
elements in the cluster.

= [name 1 cornponent 1

cluster

" |name 2 component 2
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Comparison Functions

This chapter describes the functions that perform comparisons or

conditional tests.

The following illustration shows the Comparison palette that you access
by selecting Functions» Comparison.

B
3 3 3
m
3 - 3
abc @
3 3 3
o | B [T
«—H
g
i =
v
Instr Lik) IE:’

WO
WO W W
A

SAEERAV
A,

5

Comparison Function Overview

Boolean Comparison

The Comparison functions treat the Boolean value TRUE as greater than
the Boolean value FALSE.

© MNational Instruments Corporation

This section introduces the Comparison functions.
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String Comparison

These functions compare strings according to the numerical equivalent of
the ASCII characters. Therefore, a (with a decimal value of 97) is greater
than A (65), which is greater than the numeral 0 (48), which is greater than
the space character (32). These functions compare characters one by one

from the beginning of the string until an inequality occurs, at which time

the comparison ends. For example, LabVIEW compares the strings abcd
and abef until it finds ¢, which has a value less than the value of e.

The presence of a character is greater than the absence of one. Therefore,
the string abcd is greater than abc because the first string is longer.

The functions that test the category of a string character (for example, the
Decimal Digit? and Printable? functions) evaluate only the first character
of the string.

Numeric Comparison

Most of the Comparison functions test one input or compare two inputs
and return a Boolean value. The functions convert numbers to the same
representation before comparing them. Comparisons with a value of
not a number (NaN) return a value that indicates inequality.

Cluster Comparison

The Comparison functions compare clusters the same way they compare
strings, one element at a time starting with the 0" element until an
inequality occurs. Clusters must have the same number of elements, of
the same type, and in the same order if you want to compare them.

Comparison Modes

Some of the Comparison functions have two modes for comparing arrays
or clusters. In the Compare Aggregates mode, if you compare two arrays
or clusters, the function returns a single value. In the Compare Elements
mode, the function compares the elements individually. Then returns an
array or cluster of Boolean values. The following illustration shows the
two modes.
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Comparison Functions

Ext drray 1

EXI

e Arr’ag = Eéua] 7

[exT]|

Ext drray 2
[ExT]

W

Elernent By Element Equah’tgl

m P R3]

You change the comparison mode by selecting Compare Elements or
Compare Aggregates in the pop-up menu for the node, as shown in the
following illustrations.

Ext .ﬁ.rrag 1 e Arr’agg Eiua'l?
[Exr]' [ o
1 —| Online Help
Description...
Show ]
Ext drray 2 Replace 4
[mg}——L=
Lull Array Tools ]

Create Constant
Create Control

Create Indicator

Compare Aggregates .

Ext drray 2

I ——

|E'Iement Ey Elernent Equa'litgl

[Tl

Online Help
Description...

Show ]
Replace ]

Create Constant
Create Control

Create Indicator
Compare Elements |

When you compare two arrays of unequal lengths in the Compare
Elements mode, LabVIEW ignores each element in the larger array whose
index is greater than the index of the last element in the smaller array.
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When you use the Compare Aggregates mode to compare two arrays, the
following occurs: (1) LabVIEW searches for the first set of corresponding
elements in the two inputs that differ, and uses those to determine the
results of the comparison. (2) If all elements are identical except that one
has more elements, LabVIEW considers the longer array to be greater than
the shorter array. (3) If no elements of the two arrays differ and the arrays
have the same length, the arrays are equal. Therefore, LabVIEW considers
the array [1, 2, 3] to be greater than the array [1, 2] and returns a single
Boolean value in the Compare Aggregates mode.

Arrays must have the same number of dimensions (for example, both
two-dimensional), and, for the comparison between multidimensional
arrays to make sense, each dimension must have the same size.

For clusters using the Compare Aggregates mode, LabVIEW compares
using cluster order. The two clusters LabVIEW compares must have the
same number of elements.

The Comparison functions that do not have the Compare Aggregates
or Compare Elements modes compare arrays in the same manner as
strings—one element at a time starting with the 0" element until an
inequality occurs.

Character Comparison

You can use the functions that compare characters to determine the type of
a character. The following functions are character-comparison functions.

¢ Decimal Digit?

e Hex Digit?

* Lexical Class

e Octal Digit?

e Printable?

e White Space?

If the input is a string, the functions test the first character. If the input is an

empty string, the result is FALSE. If the input is a number, the functions
interpret it as a code for an ASCII character.

See Appendix C, GPIB Multiline Interface Messages, for the numbers that
correspond to each ASCII character.
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Polymorphism for Comparison Functions

The functions Equal?, Not Equal?, and Select take inputs of any type, as
long as the inputs are the same type.

The functions Greater or Equal?, Less or Equal?, Less?, Greater?,

Max & Min, and In Range? take inputs of any type except complex, path,
or refnum, as long as the inputs are the same type. You can compare
numbers, strings, Booleans, arrays of strings, clusters of numbers, clusters
of strings, and so on. You cannot, however, compare a number to a string or
a string to a Boolean, and so on.

The functions that compare values to zero accept numeric scalars, clusters,
and arrays of numbers. These functions release Boolean values as output in
the same data structure as the input.

The Not A Number/Path/Refnum function accepts the same input types as
functions that compare values to zero. This function also accepts paths and
refnums. Not A Number/Path/Refnum outputs Boolean values in the same
data structure as the input. See Chapter 11, File Functions, and Chapter 31,
Introduction to LabVIEW Instrument 1/O Vls, for more information about
these functions.

The functions Decimal Digit?, Hex Digit?, Octal Digit?, Printable?, and
White Space? accept a scalar string or number input, clusters of strings or
non-complex numbers, arrays of strings or non-complex numbers, and

so on. The output consists of Boolean values in the same data structure as
the input.

The function Empty String/Path? accepts a path, a scalar string, clusters of
strings, arrays of strings, and so on. The output consists of Boolean values
in the same data structure as the input.

You can use the Equal?, Not Equal?, Not A Number/Path/Refnum?, Empty
String/Path?, and Select functions with paths and refnums, but no other
comparison functions accept paths or refnums as inputs.

Comparison functions that use arrays and clusters normally produce
Boolean arrays and clusters of the same structure. You can pop-up and
change to Compare Aggregates, in which case the function releases a
single Boolean value as output. The function compares aggregates by
comparing the first set of elements to produce the output, unless the first
elements are equal, in which case the function compares the second set of
elements, and so on.
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Comparison Function Descriptions

The following Comparison functions are available.

Decimal Digit?
Returns TRUE if char is a decimal digit ranging from O through 9. Otherwise, this function

returns FALSE.
char 52 digit?
Empty String/Path?
Returns TRUE if string/path is an empty string or path. Otherwise, this function returns
FALSE.
ztring/path l:% Empty?
Equal?

Returns TRUE if x is equal to y. Otherwise, this function returns FALSE.

Equal To 0?

Returns TRUE if x is equal to 0. Otherwise, this function returns FALSE.

X Eﬁ} w=107

Greater?
Returns TRUE if x is greater than y. Otherwise, this function returns FALSE.
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Greater Or Equal?
Returns TRUE if x is greater than or equal to y. Otherwise, this function returns FALSE.

Greater Or Equal To 0?

Returns TRUE if x is greater than or equal to 0. Otherwise, this function returns FALSE.

Greater Than 0?
Returns TRUE if x is greater than 0. Otherwise, this function returns FALSE.

X @ w07

Hex Digit?
Returns TRUE if char is a hex digit ranging from O through 9, A through F, or a through f.
Otherwise, this function returns FALSE.

char % =

In Range?

Returns TRUE if x is greater than or equal to lo and less than hi. Otherwise, this function

returns FALSE.
h’: .................. lo<=u < hi?

Note This function always operates in the Compare Aggregates mode. To produce a
Boolean array as an output, you must execute this function in a loop structure.
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Less?
Returns TRUE if x is less than y. Otherwise, this function returns FALSE.

Less Or Equal?
Returns TRUE if x is less than or equal to y. Otherwise, this function returns FALSE.

Less Or Equal To 0?

Returns TRUE if x is less than or equal to 0. Otherwise, this function returns FALSE.

X @ we=07

Less Than 0?
Returns TRUE if x is less than 0. Otherwise, this function returns FALSE.

Lexical Class
Returns class number for char.

char % clazz number

Table 9-1. Lexical Class Number Descriptions

Class
Number Lexical Class
0 Extended characters with a Command- or Option- key prefix
(codes 128 through 255)
1 Non-displayable ASCII characters (codes 0 to 31 excluding 9 through 13)
2 White space characters: Space, Tab, Carriage Return, Form Feed,
Newline, and Vertical Tab (codes 32, 9, 13, 12, 10, and 11, respectively)
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Table 9-1. Lexical Class Number Descriptions (Continued)

Class
Number Lexical Class
3 Digits O through 9
4 Uppercase characters A through Z
5 Lowercase characters a through z
6 All printable ASCII non-alphanumeric characters

Max & Min

Compares x and y and returns the larger value at the top output terminal and the smaller value
at the bottom output terminal.

% EENTEY rnas(x.y]
EE] | it .y]

Not A Number/Path/Refnum?

Returns TRUE if number/path/refnum is not a number (NaN), not a path, or not a refnum.
Otherwise, this function returns FALSE. NaN can be the result of dividing by 0, calculating
the square root of a negative number, and so on.

number/path/refnum [@? M atl /Path/R efnurn?

Not Equal?

Returns TRUE if x is not equal to y. Otherwise, this function returns FALSE.

Not Equal To 0?

Returns TRUE if x is not equal to 0. Otherwise, this function returns FALSE.

% i 4 1= 07
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Octal Digit?
Returns TRUE if char is an octal digit ranging from O through 7. Otherwise, this function
returns FALSE.
char % octal?
Printable?
Returns TRUE if char is a printable ASCII character. Otherwise, this function returns
FALSE.
char s printable 45117
Select

Returns the value connected to the t input or f input, depending on the value of s. If s is TRUE,
this function returns the value connected to t. If s is FALSE, this function returns the value

connected to f.
g %7 7 uf
F—

White Space?

Returns TRUE if char is a white space character, such as Space, Tab, Newline,
Carriage Return, Form Feed, or Vertical Tab. Otherwise, the function returns FALSE.

char & gpace, hdv tab, or, If, {7
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Time, Dialog, and
Error Functions

This chapter describes the timing functions, which you can use to get the
current time, measure elapsed time, or suspend an operation for a specific
period of time. Error Handling also is covered in this chapter.

The following illustration shows the Time & Dialog palette that you access
by selecting Functions»Time & Dialog.

B ]
Time & Dialog
3
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i
Inistr Likl
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Firid
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Errar
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Time, Dialog, and Error Functions Overview

This section introduces the Timing, Dialog, and Error functions.

Timing Functions

The Date/Time To Seconds and the Seconds To Date/Time functions have
a parameter called date time rec, which is a cluster that consists of signed
32-bit integers in the following order.

Table 10-1. Valid Value of Elements for Date/Time Cluster

Element Valid Values

0 | (second) 0to 59

1 | (minute) 0to 59

2 | (hour) 0to 23

3 | (day of month) | 1to 31 as output from the function; 1 to 366
as mput

4 | (month) 1to 12

5 | (year) 1904 to 2040

6 | (day of week) 1 to 7 (Sunday to Saturday)

7 | (day of year) 1 to 366

8 | (DST) 0 to 1 (0 for Standard Time, 1 for Daylight
Savings Time)

The Wait (ms) and Wait Until Next ms Multiple functions make
asynchronous system calls, but the nodes themselves function
synchronously. Therefore, they do not complete execution until the
specified time has elapsed. The functions use asynchronous calls, so other
nodes can execute while the timing nodes wait.

Note

Time values outside the range 2082844800 to 4230328447 seconds or 12:00 a.m.,

Jan. 1, 1970, Universal Time to 3:14 a.m., Jan. 19, 2038, Universal Time might not
convert to the same date on all platforms. This exception primarily exists on
Windows 3.x, which does not support dates prior to Jan. 1, 1970, Universal Time.

LabVIEW Function and VI Reference Manual
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Error Handling Overview

Every time you design a program, consider the possibility that something
can go wrong and, if it does, you should consider how your program can
manage the problem. LabVIEW automatically notifies you with a dialog
box only when a few run-time errors occur, mostly for file-dialog
operations. LabVIEW does not report all errors. If it reported all errors, you
would lose the flexibility to determine what to do when an error occurs and
how and when to inform the user of the error in your program.

Rigorous error checking, especially for I/O operations (file, serial, GPIB,
data acquisition, and communication), is invaluable in all phases of a
project. This section describes three I/O situations in which errors can
occur.

The first type of error can occur when you have initialized your
communications incorrectly or have written improper data to your external
device. This type of problem usually occurs during program development
and disappears once you finish debugging your program. However, you can
spend a lot of time tracking down a simple programming mistake because
you have not incorporated error checks. Without error checks, you only
know that your program does not work. You do not know why the error
occurred or where it is.

The second type of error can occur because your external device might be
powered off, broken down, or otherwise unable to complete its normal
tasks. This type of problem can occur at any time, but if you have
incorporated error checking, your program notifies you immediately
when such operational failures occur.

The third kind of error can occur when you upgrade LabVIEW or your
operating system software and you notice a bug in either a G program or a
system program. This type of error means you should check errors that you
might have felt safe ignoring, such as those from functions that close files
or clear DAQ operations. Be sure to check all I/O operations for errors.

It might seem easier to ignore error checking when you must add error
handling code to test and report errors. The VIs described here are designed
to make it easier for you to create programs with error checking and
handling.

G functions and library VIs return errors in one of two ways—with numeric
error codes or with an error state cluster. Typically, functions release output
error codes while VIs incorporate the error cluster, usually within a
framework called error input/output (error I/O).
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Error 1/0 and the Error State Cluster

The concept of error I/O is logical for the G dataflow architecture. If data
information can flow from one node to another, so can error state
information. Each node that needs information about errors tests the
incoming error state and responds appropriately. If no error exists, the node
executes normally. If an error does exist, the node detects an error, skips
execution, then passes its error state out to the next node, which responds
in the same way. In this fashion, notice of the first error that occurs in a
sequence of operations is passed through all the nodes, with each node
responding to the error. At the end of the flow, your program reports the
error to the user.

Error I/0O has an additional benefit—you can use it to control the execution
order of independent operations. While you can use the DAQ taskID to
control the order of DAQ operations for one group, you cannot use it to
control the order for multiple groups. The DAQ taskID does not work with
other types of I/O operations such as file operations.

The following diagram from the File Utility VI, Read Characters From
File.vi, shows how error I/O is implemented in a simple VI.

{F—=1| [new file path (Not&Path if cancelled)]
......{ character string

|cu:-nt1'nue or stop ressage on an error|

||:-r-:-mpt|ll3hc-use file to read.

Read File+ (ztring).vi General Error Handler i

refrum ir'fc

Cloze Filet i

[fite path (dialog if erpty)]

oz mode Crel. to begin)|J0)
[start of read offset (chars.: 0) (132

[rark after read (chars.)|

filg =ize

nurnber of characters (all:=1))

-

The operation starts at Open File+.vi. If it opens the file successfully,
Read File+ (string) .vireadsthe fileand Close File+.vi closesthe
file. If you pass in an invalid path, Open File+.vi detects the error and
passes the error state through the other two VIs to the General Error
Handler, which reports it. Notice that the only presence of error handling
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on this block diagram is the error wire and the General Error Handler. It is
neither cumbersome nor distracting.

The error state consists of three pieces of information that are combined
into the error cluster. The status is a Boolean value—TRUE if an error
exists, FALSE if it does not. The code consists of a signed 32-bit integer
that identifies the error. A non-zero error code coupled with a FALSE
error status signals a warning rather than a fatal error. For example, a
DAQ timeout event (code 10800) typically is reported as a warning. The
source consists of a string that identifies where the error occurred.

The error in and error out state clusters for the Open File+.vi, where
the error shown in the preceding example originated, are shown in the
following illustration. The error in cluster, whose default value is no
error does not need to be wired if it is the first in the chain.

ermor in [no eror) ermor out
ztatus code status code
¥
Meoe e n
SOLICE sOLUNCe
| |
| |

You can find the error in and error out clusters by selecting
Controls»Array & Cluster on the front panel.

The following illustration shows the message you receive from the General
Error Handler if you pass an invalid path.

Error 7 occurred at Open File in
Untitled 2.

Possible reasons:
LabUIEWD: File not found.
GPIB ENEB: Mon-existent board.
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The General Error Handler is one of the three error-handling utility VIs.
It contains a database of error codes and descriptions, from which it creates
messages like the previous one. The Simple Error Handler performs the
same basic operation but has fewer options. The third VI, Find First Error,
creates the error I/O cluster from functions or VIs that output only scalar
error codes.

Time and Dialog Function Descriptions

The following Time and Dialog functions are available.

Date/Time To Seconds

Converts a cluster of nine, signed 32-bit integers assumed to specify the local time (second,
minute, hour, day, month, year, day of the week, day of the year, and Standard or Daylight
Savings Time) in the configured time zone for your computer into a time-zone-independent
number of seconds that have elapsed since 12:00 a.m., Friday, January 1, 1904,

Universal Time.

date time rec seconds

The day of week, day of year, and DST integers are ignored. If any of the other integers are
out of the ranges specified in Table 10-1, the results are unpredictable.

When used as an integer, the day of month integer has a valid range of 1 to 366. Thus, you
can specify Julian dates by setting the month to January and the current day to the day of the
year. For example, use January 150 for the 150t day of the year.

Format Date/Time String Function
Gives you the ability to display the date and time in a format you specify.

tirme: format string [%c) mJEr;I

Y
geconds [how] 101

datetime string

The date/time string is determined from the seconds (now), which is the number of seconds
since 12:00 a.m., January 1, 1904, Universal Time, and time format string is the format of
the output string.

If seconds is not wired, the current time is used. If time format string is not wired, the default
is ¢, which corresponds to the date/time representation appropriate for the current locale.
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The Format Date/Time String function calculates date/time string by copying time format
string and replacing each of the format codes with the corresponding values in the following

table.
Table 10-2. Format Codes for the Time Format String
Format Code Value
%% a single percent character
Sa abbreviated weekday name (e.g. Wed)
$A full weekday name (e.g. Wednesday)
$b abbreviated month name (e.g. Jun)
$B full month name (e.g. June)
$c locale’s default date and time representation
%d day of month (01-31)
$H hour (24-hour clock) (00-23)
ST hour (12-hour clock) (01-12)
%7 day number of year (001-366)
$m month number (01-12)
$M minute (00—59)
Sp AM or PM flag
%S seconds (00-59)
$U week number of the year (00—53), with Sunday as the first day of
the week
Sw weekday as a decimal number (0—6), with O representing Sunday
SW week number of the year (00—53), with Monday as the first day of
the week
$x date representation of locale
%X time representation of locale
Sy year within century (00—99)
Y year, including the century (for example, 1997)
%2 time zone name or abbreviation
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Characters appearing in time format string that are not part of a format code are copied to
the output string verbatim. Time format codes (beginning with %) that are not recognized
output the character literally.

Time format codes always have leading zeros as necessary to ensure a constant field width.
An optional # modifier before the format code letter removes the leading zeros from the
following format codes:

SH#d, SH#H, S#I, $#7J, S#m, S#M, #S, $#S, $#U, S#w, T#W, $X, $#y, $#Y.
The # modifier does not modify the behavior of any other format codes.

Note The %c, %%, X, and %7 format codes depend on operating system locale support;
the output of these codes is platform dependent. Interpretation of the Daylight
Savings Time rule also can vary per platform.

Get Date/Time In Seconds
Returns a time-zone independent number containing the number of seconds that have elapsed
since 12:00 a.m., Friday, January 1, 1904, Universal Time.

seconds since 1Jan13904

Get Date/Time String
Converts a time-zone independent number calculated to be the number of seconds that have
elapsed since 12:00 a.m., Friday, January 1, 1904, Universal Time, to a date and time string
in the configured time zone for your computer.

date farmat [0] —
geconds [now)
waht seconds? [F] -

date string
time ztring

T

s [0

One Button Dialog Box
Displays a dialog box that contains a message and a single button. The button name control
is the name displayed on the dialog box button.

message

— ]
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Seconds To Date/Time

Converts a time-zone-independent number calculated to be the number of seconds that have
elapsed since 12:00 a.m., Friday, January 1, 1904, Universal Time, to a cluster of nine, signed
32-bit integers that specify the local time (second, minute, hour, day of the month, month,
year, day of the week, day of the year, and Standard or Daylight Savings Time) in the
configured time zone for your computer. The Standard or Daylight Savings time parameter
is set according to the operating system setting for Daylight Savings and indicates whether
the date/time cluster was adjusted due to Daylight Savings Time.

zeconds [now] date time rec

Tick Count (ms)
Returns the value of the millisecond timer. The base reference time (millisecond zero)
is undefined; therefore, you cannot convert millisecond timer value to a real-world time
or date. Be careful when you use this function in comparisons because the value of the
millisecond timer wraps from 23%-1 to 0.

rilizecond bimer value

Two Button Dialog Box

Displays a dialog box that contains a message and two buttons. T button name and F button
name are the names displayed on the buttons of the dialog box.

message T
T button name ['OK"] -~ T T buttan?
F button name ["Cancel"] "

Wait (ms)

Waits the specified number of milliseconds then returns the value of the millisecond timer.

milhizeconds to wait
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Wait Until Next ms Multiple

Waits until the value of the millisecond timer becomes a multiple of the specified millisecond
multiple. Use this function to synchronize activities. You can call this function in a loop
to control the loop execution rate. However, it is possible that the first loop period might

be short.

millizecond multiple

Error Handling VI Descriptions

The following Error Handling VIs are available.

Find First Error

Tests the error status of one or more low-level functions or subVIs that produce a numeric

error code as output.

SOUNCE meszages

Firud 7
el codes find BIrors
ermar in [ho ermar] Error &rror out

If this VI finds an error, it sets the parameters in the error out cluster. You can wire this cluster
to the Simple or General Error Handler to identify the error and describe it to the user.

The following illustration shows how you can use Find First Error in the example VI Write
Binary File. Find First Error creates the error cluster from individual error numbers, and

Simple Error Handler reports any errors to the user.

ermit Fead, deny write|

IEnter Fi1ename}!

ELGH
zelect new file @ FLE =
Lz = m —

Find Fir=t Error.v1'|

Simple Error Hand]er.vﬂ

Array of DEL

write Binary File :Mew File

=]

||| Find

=40 First
Errar

‘Write Binaty File Mwrite File

‘write Binary File :Close File
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Chapter 10
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Determines whether an error has occurred. If an error has occurred, this VI creates a
description of the error and optionally displays a dialog box.

[uzer-defined dezcrptionz]
[uzer-defined codez]

[eror code] (0]

error?

[error source] [~
twpe of dialog [OK mzg:1]
error in [no ermor|

min

o
214

code out

L

zource out
message

(=

[Exception action] [nane: 0]
[Emception code]
[exception zource]

efrar out

Simple Error Handler

Determines whether an error has occurred. If it finds an error, this VI creates a description of
the error and optionally displays a dialog box.

ermor code [no error)

error’y

eror gource [~

twpe of dialog [OF meg:1] f

ermar in [ho ermar]

g

L code aut
zource aut
errar out
Message

Simple Error Handler calls General Error Handler and has the same basic functionality as
General Error Handler, but with fewer options.
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File Functions

This chapter describes the low-level VIs and functions that manipulate
files, directories, and paths. This chapter also describes file constants and
the high-level file VIs.

You access these functions, constants, and VIs by selecting
Functions»File 1/0.

[ X
File 170

123

E]

[=]

o

n
[=[=]
o]
+| ==

v
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@i

T
i
10
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T T T

Instr Lik)

e

wEE S [P

The File I/O palette includes the following subpalettes:
*  Advanced File Functions

*  Binary File VIs

*  Configuration File VIs

¢  File Constants

For examples of File functions and VIs, see examples\file.
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File 1/0 VI and Function Overview

This section introduces the high-level and low-level file VIs, and the File
functions.

High-Level File Vis

You can use the high-level file VIs to write or read the following types
of data:

e Strings to text files

*  One-dimensional (1D) or two-dimensional (2D) arrays of
single-precision numbers to spreadsheet text files

e 1D or 2D arrays of single-precision numbers or signed word integers
to byte stream files

The high-level file VIs described here call the low-level file functions to
perform complete, easy-to-use file operations. These VIs open or create a
file, write or read to it, and close it. If an error occurs, these VIs display a
dialog box that describes the problem and gives you the option to halt
execution or to continue.

The high-level file VIs are located on the top row of the palette and consist
of the following VIs:

* Binary File VIs—Ilocated in the subpalette
* Read Characters from File

* Read from Spreadsheet File

¢ Read Lines from File

e Write Characters to File

*  Write to Spreadsheet File

Low-Level File VIs and File Functions

The low-level file VIs and functions perform one file operation at a time.
These VIs and functions perform error detection in addition to their other
functions. The most commonly used low-level file functions and VIs are
located on the second row of the palette. The remaining low-level functions
are located in the Advanced File Functions subpalette.

The principal low-level file operations involve a three-step process. First,
you create or open a file. Then you write data to the file or read data from
the file. Finally, you close the file. Other file operations include creating
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directories; moving, copying, or deleting files; flushing files; listing
directory contents; changing file characteristics; and manipulating paths.

When creating or opening a file, you must specify its location. Different
computers describe the location of files in different ways, but most
computer systems use a hierarchical system to specify the location of files.
In a hierarchical file system, the computer system superimposes a hierarchy
on the storage media. You can store files inside directories, which can
contain other directories.

When you specify a file or directory in a hierarchical file system, you must
indicate the name of the file or directory, as well as its location in the
hierarchy. In addition, some file systems support the connection of multiple
discrete media, called volumes. For example, Windows systems support
multiple drives connected to a system; for most of these systems, you must
include the name of the volume to create a complete specification for the
location of a file. On other systems, such as UNIX, you do not need to
specify the storage media locations for files because the operating system
hides the physical implementation of the file system from you.

The method of identifying the target of a file function varies depending on
whether the target is an open file. If the target is not an open file, or if it is
a directory, you specify a target using the path of the target. The path
describes the volume containing the target, the directories between the
top-level and the target, and the name of the target. If the target is an open
file, you use a file refnum to identify the file to be manipulated. The file
refnum is an identifier associated with the file when you open it. When you
close the file, the file manager dissociates the file refnum from the file.

In other words, the refnum is obsolete once the file is closed.

Refer to the LabVIEW Online Tutorial: Introduction to LabVIEW for more
information on path specification in G and for file function examples.

Byte Stream and Datalog Files

G can make and access two types of files—byte stream and datalog files.

A byte stream file, as the name implies, is a file whose fundamental unit is
a byte. A byte stream file can contain anything from a homogeneous set
of one G datatype to an arbitrary collection of datatypes—characters,
numbers, Booleans, arrays, strings, clusters, and so on. An ASCII text file,
a file containing this paragraph, for example, is perhaps the simplest byte
stream file. A similar byte stream file is a basic spreadsheet text file, which
consists of rows of ASCII numbers, with the numbers separated by tabs and
the rows separated by carriage returns.
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Another simple byte stream file is an array of binary 16-bit integers or
single-precision, floating point numbers, which you acquire from a data
acquisition (DAQ) program. A more complicated byte stream file is one in
which an array of binary 16-bit integers or single-precision, floating point
numbers is preceded by a header of ASCII text that describes how and when
you acquired the data. That header could alternatively be a cluster of
acquisition parameters, such as arrays of channels and scale factors, the
scan rate, and so forth.

An Excel worksheet file, as opposed to an Excel text file, is also a more
complicated form of byte stream file because it contains text interspersed
with Excel-specific formatting data that does not make sense when you
read it as text. In summary, you can make a byte stream file that consists of
one each of all of the G datatypes. Byte stream files can be created using
high-level File VIs and low-level File VIs and functions.

A datalog file, on the other hand, consists of a sequence of
identically-structured records. Like byte stream files, the components of a
datalog record can be any G datatype. The difference is that all the datalog
records must be the same type. Datalog files can only be created using
low-level file functions.

You write a byte stream file typically by appending new strings, numbers,
or arrays of numbers of any length to the file. You can also overwrite data
anywhere within the file. You write a datalog file by appending one record
at a time. You cannot overwrite the record.

You read a byte stream file by specifying the byte offset or index and the
number of instances of the specified byte stream type you want to read. You
read a datalog file by specifying the record offset or index and the number
of records you want to read.

You use byte stream files typically for text or spreadsheet data that other
applications may need to read. You can use byte stream files to record
continuously acquired data that you need to read sequentially or randomly
in arbitrary amounts. You use datalog files typically to record multiple test
results or waveforms that you read one at a time and treat individually.
Datalog files are difficult to read from non-G applications.

Flow-Through Parameters

Many file functions contain flow-through parameters, which return the
same value as an input parameter. You can use these parameters to control
the execution order of the functions. By wiring the flow-through output of
the first node you want to execute to the corresponding input of the next
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node you want to execute, you create artificial data dependency. Without
these flow-through parameters, you would often have to use Sequence
structures to ensure that file I/O operations take place in the correct order.

Error 1/0 in File 1/0 Functions

G uses error I/O clusters, consisting of error in and error out, in all of its
file I/O functions. With error I/O clusters you can string together several
functions. When an error occurs in a function, that function passes the error
along to the next function. When the error passes to subsequent functions,
the subsequent function does not execute and passes the error along to the
following function, and so on. The following illustration displays an
example of the error in and error out clusters.

[pattern]

prarnpt

file path

start path (Mot & Path)
function (open :0)
error in {not an error)
default name

adwvisory dialog? (display :T)

refnum

new file path
file zize (bytes)
error out

Although the error I/O clusters specify whether an error has occurred, you
may want to use error handlers to report the error to the user. For more
information on error I/O, see Chapter 10, Time, Dialog, and

Error Functions, in this manual.

Permissions

Some of the file functions have a 32-bit integer parameter called
permissions or new permissions. These functions use only the least
significant nine bits of the 32-bit integer to determine file and directory
access permissions.

(Windows) The permissions are ignored for directories. For files, only bit 7
(the UNIX user write permission bit) is used. If this bit is clear, the file is
read-only. Otherwise, you can write to the file.

(Macintosh) All 9 bits of permissions are used for directories. The bits
that control read, write, and execute permissions, respectively, on a
UNIX system are used to control See Files, Make Changes, and

See Folders access rights, respectively, on the Macintosh. For files, only
bit 7 (the UNIX user write permission bit) is used. If this bit is clear, the
file is locked. Otherwise, the file is not locked.
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(UNIX) The nine bits of permissions correspond exactly to the nine UNIX
permission bits governing read, write, and execute permissions for users,
groups, and others. The following illustration shows the permission bits on
a UNIX system.

uset group others

permizsion R

bit 31 grye343210

r - read permission
W - Write permission
% - eRacUte permission

File 1/0 Function and VI Descriptions

The following functions and VIs are available from the File I/O palette.

Build Path

Creates a new path by appending a name (or relative path) to an existing path.

baze path m:t
name or relative path

appended path

Close File
Writes all buffers of the file identified by refnum to disk, updates the directory entry of the
file, closes the file, and voids refnum for subsequent file operations.

refnum CLOSE"
EITar in - error out

Note The Close File VI handles error I/0 differently than other file functions;
it executes even when its error in indicates that an error has occurred in a
preceding function.
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Open/Create/Replace File
Opens an existing file, creates a new file, or replaces an existing file, programmatically or
interactively using a file dialog box. You can optionally specify a dialog prompt, default file
name, start path, or filter pattern. Use this VI with the Write File or Read File functions.

[pattern]

prampt

file path

start path (Mot & Path)
function [open:0)
error in (not an error)
default name

advizsory dialog? (display :T)

refnum

new file path
file size [bytes)
error out

Read Characters From File

Reads a specified number of characters from a byte stream file beginning at a specified
character offset. The VI opens the file before reading from it and closes it afterwards.

file path [dialog if empty] at..; niew file path [MaotsPath it

number of characters [all-1] — ._T * character zting

T mark after read [chars.)
A EQF?

Read File

Reads data from the file specified by refnum and returns it in data. Reading begins at a
location specified by pos mode and pos offset and depends on the format of the specified file.

refnum dup refrum
pog rode [ 2] - data
pos offget [EI] offzet
efrar in mr efrar ot
caunk

Reading Byte Stream Files

If refnum is a byte stream file refnum, the Read File function reads data from the byte stream
file specified by refnum. You can wire either line mode or byte stream type when you read
byte stream files, but you cannot wire both. If you do not wire byte stream type, Read File
assumes the data that begins at the designated byte offset is a string of characters. If you wire
byte stream type, the function interprets data starting at the designated byte offset to be

count instances of that type. Following the read operation, the function sets the file mark to
the byte following the last byte read. If the function encounters end of file before reading all
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of the requested data, it returns as many whole instances of the designated byte stream type
as it finds.

Reading Characters

To read characters from a byte stream file (typically a text file), do not wire the byte stream
type. The following paragraphs describe the manner in which the line mode, count, convert
eol, and data parameters function when reading from a byte stream file.

line mode, in conjunction with count, determines when the read stops.

If line mode is TRUE, and if you do not wire count or count equals 0, Read File reads until it
encounters an end of line marker—a carriage return, a line feed, or a carriage return followed
by a line feed, or it encounters end of file. If line mode is TRUE, and count is greater than 0,
Read File reads until it encounters an end of line marker, it encounters end of file, or it reads
count characters.

If line mode is FALSE, Read File reads count characters. In this case, if you do not wire
count, it defaults to 0. line mode defaults to FALSE.

convert eol (F) determines whether the function converts the end of line markers it reads into
G end of line markers. The system-specific end of line marker is a carriage return followed
by a line feed on Windows, a carriage return on Macintosh, and a line feed on UNIX. The
G end of line marker is a line feed.

If convert eol is TRUE, the function converts all end of line markers it encounters into line
feeds. If convert eol is FALSE, the function does not convert the end of line markers it reads.
convert eol defaults to FALSE.

data is the string of characters read from the file.

Reading Binary Data

To read binary data from a byte stream file, wire the type of the data to byte stream type.
In this case, count, and data function in the manner described in the following paragraphs,
and you do not have to wire line mode or convert eol.

byte stream type can be any datatype. Read File interprets the data starting at the designated
byte offset to be count instances of that type. If the type is variable-length, that is, an array,
a string, or a cluster containing an array or string, the function assumes that each instance of
the type contains the length or dimensions of that instance. If they do not, the function
misinterprets the data. If Read File determines that the data does not match the type, it sets
the value of data to the default value for its type and returns an error.

count is the number of instances of byte stream type to read. If count is unwired, the
function returns a single instance of byte stream type.
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If you wire count, it can be a scalar number, in which case the function returns a 1D array of
instances of byte stream type. Or it can be a cluster of N scalar numbers, in which case the
function returns an N-dimension array of instances of byte stream type.

If the wired count is a scalar number and the byte stream type is something other than an
array, the function returns that number of instances in a 1D array. For example, if the type is
a single-precision, floating point number and count is 3, the function returns an array of three,
single-precision, floating point numbers. However, if the type is an array, the function returns
the instances in a cluster array, because G does not have arrays of arrays. Therefore, if the type
is an array of single-precision, floating point numbers and count is 3, the function returns a
cluster array of three, single-precision, floating point number arrays.

If the wired count is a cluster of N numbers, the function returns an N-dimension array of
instances of the type. The size of each dimension is the value of the corresponding number
according to its cluster order. The number of instances returned in this manner is the product
of the N numbers. Thus, you can return 20, single-precision, floating point numbers as a
2D array of two columns and 10 rows by wiring a two-element cluster with element 0 =2 and
element 1 = 10 to count.

data contains the data read from the file. Refer to the previous description of count for an
explanation of the structures data can have.

Reading Datalog Files

If refnum is a datalog file refnum, the Read File function reads records from the datalog file
specified by refnum. If the data in the file does not match the datatype associated with the
datalog file, this function returns an error.

The number of records read can be less than specified by count if this function encounters the
end of the file. The function sets the file mark to the record following the last record read.
(You should never encounter a partial record; if you do, the file is corrupt.)

Do not wire convert eol, line mode, and byte stream type. They do not pertain to datalog
files. The count and data parameters function in the following manner.

count is the number of records to read and may be wired or unwired. If you do not wire count,
the function returns a single record of the datalog type specified when the file is created or
opened. For example, if the type is a 16-bit integer, the function returns one 16-bit integer.
If the type is an array of 16-bit integers, the functions returns one array of 16-bit integers.
(Your records typically consist of clusters of diverse elements, but the rules for simple types
used in these examples apply to those as well.)

If you wire count, it can be a scalar number, in which case the function returns a 1D array of
records. Or it can be a cluster of N scalar numbers, in which case the function returns an
N-dimension array of records.
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If the wired count is a scalar number, and the datalog type is something other than an
array, the function returns that number of records in a 1D array. For example, if the type

is a single-precision, floating-point number and count is 3, the array contains three,
single-precision, floating-point numbers. However, if the type is an array, the function returns
the records in a cluster array because G does not have arrays of arrays. Therefore, if the
datalog type is an array of single-precision, floating-point numbers and count is 3, the
function returns a cluster array of three, single-precision, floating-point number arrays.

If the wired count is a cluster of N numbers, the function returns an N-dimension array of
records. The size of each dimension is the value of the corresponding number according to its
cluster order. The number of records returned in this manner is the product of the N numbers.
Therefore, you can return 20 records as a 2D array of two columns and ten rows by wiring a
two-element cluster with element O =2 and element 1 = 10 to count.

Read From Spreadsheet File

Reads a specified number of lines or rows from a numeric text file beginning at a specified
character offset and converts the data to a 2D, single-precision array of numbers. Optionally,
you can transpose the array. The VI opens the file before reading from it and closes it
afterwards. You can use this VI to read a spreadsheet file saved in text format. This VI calls
the Spreadsheet String to Array function to convert the data.

format [%. 3] rie file path [Mak A Path...
file path [dialog if ermpty] ELzz all roves
rumber of rows [all-1] E]_t Firgt roms
LET L mark after read [chars. ]
. EDF‘?
tranSpDSE [rll:l:F] ......................

Read Lines From File

Reads a specified number of lines from a byte stream file beginning at a specified character
offset. The VI opens the file before reading from it and closes it afterwards.

file path (dialog if empiy) new file path (Mot & Pathi...
number of lines (all:—-1) ";z t--Tine string
start of read offset (chars... = : rark after read (chars.)

[mmax characters per line] ... EOF?
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Strip Path

Returns the name of the last component of a path and the stripped path that leads to that

component.
EQ:; stripped path
narme

path

Write Characters To File

Writes a character string to a new byte stream file or appends the string to an existing file.
The VI opens or creates the file before writing to it and closes it afterwards.

file path (dialog if empty) new file path (Mot & Path if cancelled)
character string

append to file? (new file:F)

Write File
Writes data to the file specified by refnum. Writing begins at a location specified by
pos mode and pos offset for byte stream file and at the end of file for datalog files. data,
header, and the format of the specified file determine the amount of data written.

..........................

refnum FILE dup refrum
pos mn?fe [D:[E% _,—-' offset
poz offeet L= error out
Efrar in mr
it mm——

Writing Byte Stream Files

If refnum is a byte stream file refnum, the Write File function writes to a location specified
by pos mode and pos offset in the byte stream file specified by refnum. If the top-level
datatype of data is of variable length (that is, a string or an array), Write File can write a
header to the file that specifies the size of the data. Write File sets the file mark to the byte
following the last byte written. convert eol determines whether the function converts the
end-of-line markers it writes into system-specific end-of-line markers. You can wire convert
eol only if data is a string. The system-specific end-of-line marker is a carriage return
followed by aline feed on Windows, a line feed on UNIX, and a carriage return on Macintosh.
If header is true, Write File ignores convert eol.
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Writing Datalog Files

If refnum is a datalog file refnum, the Write File function writes data as records to the datalog
file specified by refnum. Writing always starts at the end of the datalog file (datalog files
are append-only). Write File sets the file mark to the record following the last record written.
The convert eol, header, pos mode, and pos offset parameters do not apply with datalog
files, and you cannot wire them. The data parameter functions in the following manner for
datalog files.

data must be either a datatype that matches the datatype specified when you open or create
the file, or an array of such datatypes. In the former case, this function writes data as a single
record in the datalog file. Representation of numeric data is coerced to the representation of
the datatype if necessary. In the latter case, this function writes each element of data as a
separate record in the datalog file in row-major order.

Write To Spreadsheet File

Converts a 2D or 1D array of single-precision (SGL) numbers to a text string and writes the
string to a new byte stream file or appends the string to an existing file. You can optionally
transpose the data. This VI opens or creates the file before writing to it and closes it
afterwards. You can use this VI to create a text file readable by most spreadsheet applications.
This VI calls the Array to Spreadsheet String function to convert the data.

Format [, 3f] wnrnnnnnenenny
file path [dialog if empty] (B | niew file path [Mak & Pathi..

20 data =T Py
1D data — XS]
append to file? [new file:F] -
tfanSpDSE? [nD:F] ......................... H

Binary File VI Descriptions

The following VIs are available from the Binary File VIs subpalette.

= X
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Read From 116 File

Reads a 2D or 1D array of data from a byte stream file of signed, word integers (I16). The VI
opens the file before reading from it and closes it afterwards. You can use this VI to read
unscaled or binary data acquired from data acquisition VIs and written to a file with Write To
116 File.

20 number of rows

refnum

pos mode (rel. to mark:2)

pos offset (bytes:0)

error in (no error)

20 number of columns F1D count

dup refrumm

2D data

1D data

mark after read (bytes)
error out

EOF

Read From SGL File

Reads a 2D or 1D array of data from a byte stream file of single-precision numbers (SGL).
The VI opens the file before reading from it and closes it afterwards. You can use this VI
to read scaled data acquired from data acquisition VIs and written to a file with Write To
SGL File.

file path [dialog if ernphy]

20 number af roves

nurnber of calumns/ 10 cou...
ztart of read offzet [hytes:0]

=T — riew file path (Mot & Pathi...
_1_ O iy
= SEG" 10 array

«. ..................... EDF‘?

rnark, after read [bytes]

Write To 116 File

Writes a 2D or 1D array of signed word integers (I116) to a new byte stream file or appends
the data to an existing file. The VI opens or creates the file before writing to it and closes it
afterwards. You can use this VI to write unscaled or binary data from data acquisition VIs.

file path [dialog if empt, ] . R —— ]
pathddea’ s aﬁ:y].g.=jf niews file: path (Mot & Path i

10 aray — ¢iiies

append to file? [new file:F] -
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Write To SGL File

Writes a 2D or 1D array of single-precision numbers (SGL) to a new byte stream file or
appends the data to an existing file. The VI opens or creates the file before writing to it and
closes it afterwards. You can use this VI to write scaled data from data acquisition VIs without

changing the representation.

file path (dialog if empty)

1D array

2D array .—_-.=SH
append to file? (new file :F) -~ Fan

B

new file path (Mot & Fath if cancelled)

Advanced File Function Descriptions

The following functions are available on the Advanced File Functions subpalette.

B! x|
OFPEN]"| [HELI" FILE FILE

% . {' - EI:IF EEEH

FLEH" FILE 5| (FILE [g]

B

FILE FILE [g]| [vo

7 | )

“ml' copv| [DEL M 15 T[] | [Ew]

e | e | O | e | e

Access Rights

Sets and returns the owner, group, and permissions of the file or directory specified by path.
If you do not specify new owner, new group, or new permissions, this function returns the

current settings unchanged.

path

RS QlHer

HiEw groLp

nEw pEMmIsEions
eI in

FILE

ACC

dup path
OLHEr
group
permiszions
error out

LabVIEW Function and VI Reference Manual

11-14

© National Instruments Corporation



Chapter 11 File Functions

(Windows) The Access Rights function ignores new owner and new group and returns empty
strings for owner and group because Windows does not support owners and groups.

(Macintosh) If path refers to a file, the Access Rights function ignores new owner and new
group and returns empty strings for owner and group because Macintosh does not support
owners or groups for files.

Array Of Strings To Path
Converts array of strings into a relative or absolute path.
rElati"."E ........................
array of stnngs T ) path

Copy

Copies the file or directory specified by source path to the location specified by target path.
If you copy a directory, this function copies all its contents recursively.

zource path [CoPy[ new path

target path - e — emar ot
&rmar in

Delete
Deletes the file or directory specified by path. If path specifies a directory that is not empty
or if you do not have write permission for both the file or directory specified by path and its
parent directory, this function does not remove the directory and returns an error.

path [DEL [

10T in ‘E error out

EOF

Sets and returns the logical EOF (end-of-file) of the file identified by refnum. pos mode and
pos offset specify the new location of the EOF. If you do not specify pos mode or pos offset,
this function returns the current unchanged EOF. This function always returns the location of
the EOF relative to the beginning of the file.

refnum FLE dup reftium
pos rode [0:1] - o f offzet
pog affeet [0] f L errar auk
2ITar in
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You cannot set the EOF of a datalog file. If refnum identifies a datalog file, you cannot wire
pos mode and pos offset. However, you still can get the EOF of a datalog file, which tells you
how many records exist in the file.

File Dialog

Displays a dialog box with which you can specify the path to a file or directory. You can use
this dialog box to select existing files or directories or to select a location and name for a new
file or directory.

prompk meeeseeeseny
ghart path path
select mode (2] - %’ e eists

default name wj""" o pancelled

File/Directory Info

Returns information about the file or directory specified by path, including its size, its last
modification date, and whether it is a directory.

_. ..................... difECth_'r'

FILE dup path
== size

lazt rod

errar out

path
10 iy ===l =I5 1hF)

Flush File

Writes all buffers of the file identified by refnum to disk and updates the directory entry of
the file associated with refnum. The file remains open, and refnum remains valid.

refnum " dup refrum

20T i 1 errar aut

Data written to a file often resides in a buffer until the buffer fills up or until you close the file.
This function forces the operating system to write any buffer data to the file.
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List Directory
Returns two arrays of strings listing the names of all files and directories found in directory
path, filtering both arrays based upon pattern and filtering the file names array based upon
the specified datalog type.

directory path TsTl dup directorn path
nd

= = file names
mrmr‘—%“"ﬂ directary names
&frar in errar out

Lock Range
Locks or unlocks a range of a file specified by refnum. Locking a range of a file prevents both
reading and writing by other users, overriding permissions for the file, and the deny mode
associated with refnum. See the File I/O VI and Function Overview section in this chapter
for a full discussion of permissions. Unlocking a range of a file removes the override caused
by locking a range, so that the file’s permissions and the deny mode associated with refnum
determine whether other users can read from or write to that range of the file.

gt loghk, [F] e
refnum —FiE
pos made [0:2] T —| @ dup refr:um
pos affzet [0] mr"—l £rrar oLl
EMar in
count

You cannot lock a range of a datalog file.

Move
Moves the file or directory specified by source path to the location specified by target path.

source path
target path -
EFror in ==

new path
errar out

New Directory
Creates the directory specified by directory path. If a file or directory already exists at the
specified location, this function returns an error instead of overwriting the existing file or
directory.

directory path

e

dup directary path
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New File
Creates the file specified by file path and opens it for reading and writing (regardless of
permissions).
]
file path HELI| refrium
E == grrar ot
107 if
DVErWritE [F] ......................
Open File

Opens the file specified by file path for reading and/or writing.

: B
file path DFEH]" refrum
open made [0] ﬁ
[Pe======= rror aut

::::r
20T N

Path To Array Of Strings

Converts a path into an array of strings and indicates whether the path is relative.

R, relati'-.-'e

path 1% [} array of gtrings

Path To String

Converts path into a string describing a path in the standard format of the platform.

path 1P ats} zhring

Path Type

Returns the type of the specified path, indicating whether it is an absolute, relative, or
invalid path. This function checks only the format of the path, not whether the path refers
to an existing file or directory. Therefore, this function only indicates an invalid path for
Not A Path.

path l:% type
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Refnum To Path

Returns the path associated with the specified refnum.

101 % | path

refnum

Seek

Moves the current file mark of the file identified by refnum to the position indicated by
pos offset according to the mode chosen by pos mode.

refnum

pog mode [0:2]
pos offzet [0]
&Iar in

I

FILE
- B

ml)

= s

dup refrum
off et
efrar out

String To Path

Converts string, describing a path in the standard format for the current platform, to path.

string Jat= "} path

Type and Creator

Reads and sets the type and creator of the file specified by path. File type and creator are
four-character strings. If you do not specify new type or new creator, this function returns
the current settings unchanged.

path FILE dup path
new type Jm"" é‘ T ype
riew creator mﬂ‘“’ creator
10T in eror auk

Windows and UNIX do not support file types and creators. Trying to set the type or creator
of a file in these platforms results in an error; however, you can get the file type and creator
in these platforms. If the specified file has a name ending with characters that Type and
Creator recognizes as specifying a file type (such as .vi for the LVIN file type and . 11b for
the LVAR file type), this function returns that type in type and LBVW in creator. Otherwise,
the function returns 2?2?22 in both type and creator.
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Volume Info

Returns information about the volume containing the file or directory specified by path,
including the total storage space provided by the volume, the amount used, and the amount
free in bytes.

volume path
zize

uzed

free

errar out

unL

path
210 jh ===

Configuration File Vs

The Configuration File VIs provide you with the tools to create, modify, and read a
platform-independent configuration file. The following illustration shows the options
available on the Configuration File VIs subpalette.

Is! Configuration File Vs

2 ([

TF DOBL i3z % ab U3z
:
TF DAL [ %a ahbi: T
SEI 20 =3 A E
Moy | [ Mz

The Configuration File VIs work with a platform-independent configuration file similar in
format to the standard Windows initialization (. ini) file.

The file is divided into sections, denoted by a name enclosed in brackets. Each section in a

file must have a unique name. Within each section are key and value pairs. Each key within a
section must have a unique name.

LabVIEW Function and VI Reference Manual 11-20 © MNational Instruments Corporation



Chapter 11 File Functions

An example of a configuration file with sections section 1 and section 2 is:
[section 1]
keyl="string value 1"
key2="string value 2"
key3=53
[section 2]
keyl=TRUE
key2=-12.3
key3="/c/temp/data.dat"

The Configuration File VIs support the following data types:
»  Strings

e Paths

e Booleans

e 64-bit floating-point numbers (Double)

e 32-bit signed integers (132)

e 32-bit unsigned integers (U32)

String data in the file must be enclosed in double quotes. Any unprintable characters in the
string are stored in the file with their equivalent hexadecimal escape codes (for example,
\oD for carriage return). In addition, backslash characters are stored in the file as
double-backslashes (for example, \\ for \).

Path data is stored in a platform-neutral format. This format is the standard UNIX format for
paths. The VIs will interpret the absolute path /c/temp/data.dat as follows on the various
G platforms:

e  Windows: c\temp\data.dat
¢ MacOS: c:temp:data.dat
e UNIX: /c/temp/data.dat

In addition, the VIs interpret the relative path temp/data.dat as follows:
e Windows: temp\data.dat

¢ MacOS: :temp:data.dat

e UNIX: temp/data.dat
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Close Config Data

Closes a reference to the configuration data identified by refnum. If write configuration
file? is TRUE, the VI writes the data to the platform-independent configuration file identified

by refnum.
IE'num ............
write configuration file? - B
errar in [no errar] === error out

Open Config Data
Opens a reference to the configuration data found in a platform-independent configuration
file. If the specified file does not exist and create file if necessary? is TRUE, the VI also
creates the configuration file.

configuration file path g 0 refrm
create file if neceszsany? (T] - e
EITOT i [no eror] === error out

Read Key (Boolean)

Reads a Boolean value associated with a key in a specified section from the configuration
data identified by refnum. If the key does not exist, the VI returns the default value.

setion wrreneneney
refnum TF refrurn aut
by .. @ ......... . - found?
default walue -~ L yalle
erar in [ho errar] mLm &rror oLt

Read Key (Double)

Reads a 64-bit floating-point number value associated with key in a specified section
from the configuration data identified by refnum. If key does not exist, the VI returns
default value.

section =g
refnum DBL refrum out
ke @ “ faund ?

default value r‘ “"ﬂ wvalue
error in [no errar] errar out
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Read Key (132)

Reads a 32-bit signed integer value associated with a key in a specified section from
the configuration data identified by refnum. If the key does not exist, the VI returns the
default value.

SECtil:lrl ......................E
refnum i3z refrium ot

E|_

-

kg - found ?

default value mﬂ“‘ 1 wvalue
Ermar in (o error] errar oLt

Read Key (Path)

Reads a path value associated with key in a specified section from the configuration data
identified by refnum. If key does not exist, the VI returns default value.

sechion ~p

refnum L. refrurm aut
by~ @ = found?
|:|_
default value mr‘ % walue
ermar in [ha errar] 2rrar oLt

Read Key (String)

Reads a string value associated with key in a specified section from the configuration data
identified by refnum. If key does not exist, the VI returns default value.

section wernenneeny
refnum abu refrium out
ke = @ “ found ?
G e 1= ) ey

default value r‘ “"ﬂ value
eror in [no ermor| error out

Read Key (U32)

Reads a 32-bit unsigned integer value associated with key in a specified section from
the configuration data identified by refnum. If key does not exist, the VI returns the
default value.

sechion g
refnum &, refrum out
ke @ “ faund ?

default value —l_r‘ “"ﬂ value
erar in [no erar] errar out
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Remove Key
Removes a key in a specified section from the configuration data identified by refnum.
sechion wrrennneney
refnum ¥ on refrum out
ke - g = found?
EI10r i [ erpor] === === grror out

Remove Section

Removes a section from the configuration data identified by refnum.

sechion g
refnum Wseo refrunm out
............ ot
error in [no ermor| B e mrpor it

Write Key (Boolean)

Writes a Boolean value associated with key in a specified section of the configuration data
identified by refnum. If key exists, the VI replaces the existing value. If key does not exist,
the VI adds the key/value pair to the end of the specified section. If section does not exist,
the VI adds section, with the key/value pair, to the end of the configuration data.

sechion ~p
refnum TF refrum aut
[T "Eﬂ
value - error oLt
errar in (o errar]

Write Key (Double)

Writes a 64-bit floating-point number value associated with key in a specified section of the
configuration data identified by refnum. If key exists, the VI replaces the existing value.

If key does not exist, the VI adds the key/value pair to the end of the specified section.

If section does not exist, the VI adds the section, with the key/value pair, to the end of the
configuration data.

section =g
refnum EL refrum oot
by = ‘r@ﬂ
value error out
error in [ho errar]
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Write Key (132)

Writes a 32-bit signed integer value associated with key in a specified section of the
configuration data identified by refnum. If key exists, the VI replaces the existing value.
If key does not exist, the VI adds the key/value pair to the end of the specified section.
If section does not exist, the VI adds section, with the key/value pair, to the end of the
configuration data.

section wemrereeeny

refnum i3 refrm out
key - “ e
value f oo grror auk

erar in [ho erar]

Write Key (Path)

Writes a path value associated with Kkey in a specified section of the configuration data
identified by refnum. If key exists, the VI replaces the existing value. If key does not exist,
the VI adds the key/value pair to the end of the specified section. If section does not exist,
the VI adds section, with the key/value pair, to the end of the configuration data.

sEction ey
refnum s

k.E_',' o b g
value ﬁ e gprar gt

ermar in [ho errar]

refrum aut

Write Key (String)

Writes a string value associated with Key in a specified section of the configuration data
identified by refnum. If key exists, the VI replaces the existing value. If key does not exist,
the VI adds the key/value pair to the end of the specified section. If section does not exist,
the VI adds section, with the key/value pair, to the end of the configuration data.

sechion =g
refrnum abi: refrum out
kg "'
value o= grror allt
erar in [ho errar]
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Write Key (U32)

Writes a 32-bit unsigned integer value associated with Kkey in a specified section of the
configuration data identified by refnum. If key exists, the VI replaces the existing value.
If key does not exist, the VI adds the key/value pair to the end of the specified section.

If the section does not exist, the VI adds section, with the key/value pair, to the end of the
configuration data.

geChion ey
refnum a3z refrm out
key Y[k

0=
value f errar out

erar in fho erarl

File Constants Descriptions

The following constants are available from the File Constants subpalette.

[ X

E B=H B A

Current VI's Path Constant

Returns the path to the file containing the VI in which this function appears. If the VI is
incorporated into an application (using the Application Builder libraries), the function returns
the path to the VI in the application file, and treats the application file as a VI library.

path
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Default Directory Constant
Returns the path to your default directory. The default directory is the directory which the file
dialog displays initially. The Preferences dialog box (Edit»Preferences), under Paths,
defines this directory.

path

Empty Path

Returns an empty path.

Not A Path

Returns a path whose value is Not A Path. You can use this path as an output from structures
and subVIs when an error occurs.

Not A Refnum

Returns a refnum whose value is Not A Refnum. You can use this refnum as an output from
structures and subVIs when an error occurs.

Path Constant

Use this to supply a constant directory or file path to the block diagram. Set this value by
clicking inside the constant with the Operating tool and typing in the value. Use the standard
file path syntax for a given platform. You can set the value of the path constant to Not a Path
by clicking on the path symbol with the Operating tool and selecting Not a Path from the
resulting menu. See the Paths and Refnums section of Chapter 6, Strings and File /0, in the
LabVIEW User Manual for more information on using the Not a Path value.

The value of the path constant cannot be changed while the VI executes. You can assign a
label to this constant.
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Temporary Directory Constant

Returns the path to your temporary directory. The temporary directory is the directory in
which you store temporary information that you expect the user or the operating system to

delete periodically. The G Preferences dialog box (Edit»Preferences), under Paths, defines
this directory.

path

VI Library Constant

Returns the path to the VI library directory for the current development library on the
current computer. The Preferences dialog box (Edit»Preferences), under Paths, defines this
directory. If you build an application using the Application Builder libraries, this path is the
path of the directory containing the application.

g~ path
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This chapter describes the Application Control functions.

To access the Application Control palette, shown in the following
illustration, select Functions»Application Control.

B x|
Application Contro

123

Hl
S|mIE

o
T
A
[=]=]
-

o]
+| ==
b

v
=
(i

Zi]
Aa
-
&
B

=

i+

-—1ElApplication Control

Cem || B

o (|07

@EE S B

3
< cf’
e

=]

The Application Control palette include the following subpalettes:
*  Help functions

¢ Menu functions
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Application Control Functions

The following Application Control functions are available.

Call By Reference Node

The Call By Reference node is very similar to a subVI node: you can use either to call a VL.
However, there is a significant difference. With a subVI node, you determine what VI is called
when you drop the node on the diagram.

With the Call By Reference node, the end user determines what VI is called at runtime
via the reference input. The Call By Reference node could call a VI that resides on a
different computer.

At the top of the Call By Reference node are four terminals: an input/output pair of flow
through VI reference terminals, and an input/output pair of flow through error clusters.

The VI reference input accepts wires only from strictly-typed VI references. Below these
terminals is an area within which a connector pane resides that is identical to that of a VI
with its terminals showing (rather than its icon). The connector pane of the strictly-typed VI
reference input determines the pattern and data types of this connector pane. You should wire
to these terminals just as you would to a normal subV1I.

As long as none of the terminals of the connector pane have wires attached to them, the
connector pane adapts automatically to the connector pane of the input VI reference.
However, if any of them are wired, the node does not adapt automatically, and you must
explicitly change the connector pane (possibly breaking those wires) by popping up on the
node and selecting the Adapt To Reference Input menu item.

At run time there is a small amount of overhead in calling the VI that is not necessary in a
normal subVI call. This overhead comes from validating the VI reference and a few

other details. However, for a call to a VI in the local LabVIEW, this overhead should be
insignificant for all but the smallest subVIs. Calling a VI located in another LabVIEW
application (across the network) involves considerably more overhead. The reference input
determines the VI that is called by the Call by Reference node.

dup reference
errar aut

referance
errar in kno error)
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Call Chain

Returns a reference to a LabVIEW application or a VI.

% poacasaca: o5l chain

Close Application or VI Reference
Closes an open VI or the TCP connection to an open copy of LabVIEW.

application or ¥i reference

Erar in (o errar) ermar oLt

Invoke Node
Invokes a method or action on a VI. Most methods have parameters associated with them.
To select the method, pop up anywhere on the node and select Methods. Once you select the
method, the associated parameters appear in the following illustration. You can set and get the
parameter values. Parameters with a white background are required inputs and the parameters
with a gray background are recommended inputs.

Arrto Refnorm In B olges O dup dute Refhurm
errar in Cno errar) " [H errar aut
trwethod
—{* paratt 1 |—
—{+ param 2 |—

Open Application Reference
Returns a reference to a VI Server application running on the specified computer. If you do
not specify a value for machine name, then it returns a reference to the local LabVIEW
application in which this function is running.

- open loc... % application reference
port number = -
Ermar in (o eror] ===

machine name |

errar out

You can use the application reference output as an input to the Property and Invoke nodes to
get or set properties and invoke methods on the application. Using it as the input to the Open
VI Reference function lets you get references to VIs in that application. Close the reference
with the Close Application or VI Reference function. If you forget to close this reference, it
closes automatically when the top-level VI associated with this function finishes executing.

However, it is good practice to conserve the resources involved in maintaining the connection
by closing the reference when you finish using it.
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Open VI Reference

Returns a reference to a VI specified by a name string or path to the VI's location on disk.

type specifier ¥ Refrum .. ———
application reference [locall % i reference
vi path =
2Irar in [ho errgr] === Di Eqror out
pagaward [

You can get references to VIs in another LabVIEW application by wiring an application
reference (obtained from the Open Application Reference function) to this function. In this
case, path input refers to the file system on the remote LabVIEW computer. If you wire a
reference to the local LabVIEW application you get the same behavior as if you had not wired
anything to the application reference input.

If you intend to perform editing operations on the referenced VI, and the VI has a
password-protected diagram, you can provide the password to the password string input.

If you provide the incorrect password, the Open VI Reference function returns an error and
an invalid VI reference. If you provide no password when opening a reference to a VI that is
password protected, you can still get the reference, but you can only perform operations that
do not edit the VI.

If you intend to call the specified VI through the Call By Reference function, wire a
strictly-typed VI reference to the type specifier input. The function ignores the value of this
input. Only the input's type—the connector pane information—is used. By specifying this
type, the Open VI Reference function verifies at run time that the referenced VI’s connector
pane matches that of the type specifier input.

Note It is possible to wire a Generic VI refnum type to the type specifier input. Doing
this results in the same behavior as if you had not wired the type specifier input
at all.

If you wire the type specifier input with a strictly-typed VI refnum, the VI must meet several
requirements before the VI reference is returned successfully:

e The VI cannot be broken for any reason.

e The VI must be runnable as a subVI; that is, it cannot be active as a top-level VI (unless
the VI is re-entrant).

e The connector pane of the VI must match that of the type specifier.

If you forget to close this reference, it closes automatically when the top-level VI associated
with this function finishes executing. However, it is good practice to conserve the resources
involved in maintaining the connection by closing the reference when you finish using it.
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If you get a strictly-typed reference to a reentrant VI, a dedicated data space is allocated for
that reference. This data space is always used in conjunction with the output VI reference.
This can lead to some new behaviors that you may not be accustomed to in LabVIEW.

For example, parallel calls (using the Call By Reference node) to a reentrant VI using the
same VI reference do not execute in parallel, but execute serially, one after the other.

Notice that a VI reference is similar to what is known as a function pointer in other languages.
However, in LabVIEW, these function pointers also can be used to call VIs across the
network.

Print Panel
Produces the same printout as programmatic print at completion, but can be called from other
VIs and at times other than at completion. By default, it prints the entire panel, not just what
is visible in the window. This VI assumes that the VI is loaded but does not require the
window to be open.

¥l name =
Ey

erar in [no errar] =4

| Print| errar aut

Property Node
Sets (writes) or gets (reads) VI and application property information. To select the VI or
application class, pop up on the node and select from the Select VI Server Class submenu.
To select an application class, select Application. To select a VI class, select Virtual
Instrument, or wire the VI or application refnum to reference and the node choices change
accordingly.

To select a specific property, pop up on one of the name terminals and select Properties.
To set property information, pop up and select Change to Write, and to get property
information pop up and select Change to Read. Some properties are read only, so you cannot
see Change to Write in the pop-up menu. The Property node works the same way as
Attribute nodes. If you want to add items to the node, pop up and select Add Element or click
and drag the node to expand the number of items in the node. When this node executes,
properties are handled in the order from top to bottom. If an error occurs on one of the
properties, the node stops at that property and returns an error. No further properties are
handled. The error string reports which property caused the error. Remember if the small
direction arrow on a property is on the left, you are setting the property value. If the small
direction arrow on the property is on the right, you are getting the property value. Each
property name has a short or long name which can be changed by popping up and selecting
Name Format. Another name format is no name where only the type is displayed for each

property.
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Quit

Stop

Application Control Functions

referance & ] dup referehce
errar in (no errorl B A vlass 12 errar out
narne 1 y—attribute 1

attribute 2—  name 2

Stops all executing VIs and ends the current session of LabVIEW. This function shuts down
only LabVIEW; the function does not affect other applications. The function stops all running
VIs the same way the Stop function does.

quit? [T]

Stops the VI in which it executes, just as if you clicked the Stop button in the toolbar. If you
wired the input, stop occurs only if the input value is TRUE. If you leave the input unwired,
the stop occurs as soon as the node that is currently executing finishes.

StDp? [T] ................

If you need to abort execution of all VIs in a hierarchy from the block diagram, you can use
this function, but you must use it with caution. Before you call the Stop function with a TRUE
input, be sure to complete all final tasks for the VI first, such as closing files, setting save
values for devices being controlled, and so on. If you put the Stop function in a subVI, you
should make its behavior clear to other users of the VI because this function causes their

VI hierarchies to abort execution.

In general, avoid using the Stop function when you have a built-in termination protocol in
your VI. For example, I/O operations should be performed in While Loops so that the VI can
terminate the loop on an I/O error. You should also consider using a front panel Stop Boolean
control to terminate the loop at the request of the user rather than using the Stop function.
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The following illustration displays the options available on the Help subpalette.

Control Help Window

Ql{m
ol

Modifies the Help window by showing, hiding, or repositioning the window.

Control Online Help

Top Left Cornep s (]~ =

=] STa T — {ﬁ@

Controls the online help system by displaying the table of contents of a help file, jumping to
a specific point in a help file, or closing the online help system.

Get Help Window Status

Operation
String to search for =
g “jmnl

Path to the help file
Errar Input -===r

? Jr======= E rrar Ouitpiuat

ek

Returns the status and the position information for the Help window.
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Menu Functions

The following illustration displays the options available on the Menu subpalette.

MEML! | [MEML

AN
[FEF | MER]
=-+H|M*x
[MEMU | [MEMU | [MEMU |

B[ |

The Menu functions operate on menus identified by a refnum. A VI's menu refnum is
obtained through the constant Current VI's menu. Items are identified by an item tag (string)
and sometimes by an item path (string), which is a list of item tags from the menu tree root
up to the item and separated by colons.

El

The following Menu functions are available.

Delete Menu ltems

Deletes menu items from the menubar or a submenu within the menubar.

menubar FEHD rnenubar out
menu tag ==
iternz ﬁ ] S error ouk
ermar in (o errar)

If menu tag is specified, the items are deleted from the submenu specified by menu tag, or
else the items are deleted from the menubar. The function returns an error if menu tag or one
of the items specified is not found.

items can be a tag (string) of an existing item, an array of tags of existing items, a position
index (zero-based integer) of an item in the menu or an array of position indices of items in
the menu. If you do not wire items, all the items in the menu are deleted. If there is a submenu
in any of the specified items, the submenu and all its contents are deleted automatically.

Because separators do not have unique tags, they are best deleted by using their positional
indices.
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Enable Menu Tracking

Enables or disables tracking of menu selections.

Get Menu Item Info

Chapter 12

Application Control Functions

menubar

2rrar in [ho ermar]

enable [T] -]

MEMLI

* &

e out

errar out

Returns the attributes of the menu item specified through item tag.

itemn kag
menubar FEML
e Y .
error in [no error) =7 ‘

submenu tags

menubar out
item name
enabled
efrar out
checked
ghart cut

Item attributes are item name (the string that appears in the menu), enabled (false designates
that the item is grayed out), checked (specifies whether there is a check mark next to the

item), and short cut (key accelerator). If the item has a submenu, its item tags are returned as
an array of strings in submenu tags. If item tag is unwired, the menubar items are returned.

If item tag is not valid, an error is returned.

Get Menu Selection

Returns the item tag of the last selected menu item, optionally waiting t imeout
milliseconds. item path is a string describing the position of the item in the menu
hierarchy, which is the format of a list of menu tags separated by a colon (:). If block menu
is set to True, Menu selection is blocked out after an item tag is read.

© MNational Instruments Corporation
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menubar

mz timeout [200] -,
block menu [F] -
ermar in [ho erar]

hn

g

menubar out
itemn tag
itern path
errar out

12-9

LabVIEW Function and VI Reference Manual



Chapter 12 Application Control Functions

Get Menu Shortcut Info

Returns the menu item that is accessible through a given shortcut.

menubar GEEE rnenubar out
thort cut = i = jkem tag
EI100 in [ efror] === "‘L_ itern path
error out

item path is a string of menu item tags separated by a colon (:).

short cut consists of a string (key) and a Boolean (specifies whether the shift key is included
or not).

Insert Menu Items
Inserts menu items into a menubar or a submenu within the menubar.

menu tag
menubar FEFD rmenubar out
'tE“!t"aTES mg“u +H itern tags out
them tags — B grror out
errar in [ho errar] ===Em
after item

menu tag specifies the submenu where items are inserted. If you do not specify menu tag,
the items are inserted into the menubar.

item names and item tags identify the items to be inserted into the menu. The type of item
names and item tags can be an array of strings (for inserting multiple items) or just a string
(for inserting a single item). You can wire in either item names or item tags, in which case
both names and tags get the same values. If you require each item to have different name and
tag, you must wire in separate values for item names and item tags.

after item specifies the position where the items are inserted. after item can be a tag (string)
of an existing item or a position index (zero based integer) in the menu. To insert at the
beginning of the menu, wire a number less than 0 to after item. To insert at the end of the
menu, wire a number larger than the number of items in the menu. You can insert a separator
using the application tag APP_SEPARATOR. The function always ensures that the tags of all
the inserted menu items are unique to the menu hierarchy by appending numbers to the
supplied tags, if necessary.

item tags out returns the actual tags of the inserted items. If menu tag or after item (tag) is
not found, the function returns an error.
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Set Menu Item Info
Sets the attributes of a menu item specified through menu and item tag. Item attributes are
item name (the string that appears in the menu), enabled (false designates that the item is
grayed out), checked (specifies whether there is a check mark next to the item), and shortcut
(key accelerator). Attributes that are not wired remain unchanged. If item tag is not valid, an
error is returned.

item tag
menubar HEHD merubar out
itern narne = — ?fﬂ
enabled - d error out
eror in [no error)
ChECkEd ......................
short put sesm————
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Advanced Functions

This chapter describes the functions that perform advanced operations.
This chapter also describes the Data Manipulation and Synchronization
functions, and the VI Control and Memory VIs.

To access the Advanced palette, shown in the following illustration, select
Functions»Advanced.
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The Advanced functions include the following subpalettes:
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Advanced Functions

Advanced Function Descriptions

Beep

The following Advanced functions are available.

Causes the system to issue an audible tone. You can specify the tone frequency in Hertz,
the duration in milliseconds, and the intensity as a value from O to 255, with 255 being the
loudest. Although this VI appears on all platforms, the frequency, duration, and intensity
parameters work only on the Macintosh.

frequency [Hz] - ignored -
duration [mzec] - ighared _,_.P

intenzity [0-259) - ignored —

&rror - ighored

Code Interface Node

Calls code written in a conventional programming language, such as C, directly from a block
diagram. Code Interface Nodes (CINs) make it possible for you to use algorithms written in
another language or to access platform-specific features or hardware that G does not directly
support.

CINs are resizable and show datatypes for the connected inputs and outputs, similar to the
Bundle function. The following illustration shows the CIN function.

[Code Interface Mode]

The LabVIEW interface to external code is very powerful. You can pass any number of
parameters to or from external code, and each parameter can be of any arbitrary G datatype.
LabVIEW provides several libraries of routines that make working with G datatypes easier.
These routines support memory allocation, file manipulation, and datatype conversion.

If you convert a VI that contains a CIN to another platform, you need to recompile the code
for the new platform because CINs use code compiled in another programming language. You
can write source code for a CIN so that it is machine-independent, requiring only a recompile
to convert it to another platform. For examples of CINs, see examples\cins.

For more information on the Code Interface Node, see the LabVIEW Code Interface
Reference Manual, available in portable document format (PDF) only.
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Call Library Function
Calls standard libraries without writing a Code Interface Node (CIN). Under Windows, you
can call a dynamic link library (DLL) function directly. In Macintosh and UNIX, you can call
a shared library function directly. On the Macintosh 68K, you must have the CFM-68K
system extension installed for the Call Library Function node to operate.

This node supports a large number of datatypes and calling conventions. You can use it to call
functions from most standard and custom-made libraries.

The Call Library Function node, shown in the following illustration, looks similar to a
Code Interface node.

ﬂj:ﬂ (£
L]
— return walue
param 1 — — new walue of param 1
param 2 — M new walue of param 2

The Call Library Function consists of paired input/output terminals with input on the left and
output on the right. You can use one or both. The return value for the function is returned in
the right terminal of the top pair of terminals of the node. If there is no return value, then this
pair of terminals is unused. Each additional pair of terminals corresponds to a parameter in
the functions parameter list. You pass a value to the function by wiring to the left terminal of
a terminal pair. You read the value of a parameter after the function call by wiring from the
right terminal of a terminal pair.

If you select Configure... from the pop-up menu of the node, you see a Call Library Function
dialog box from which you can specify the library name or path, function name, calling
conventions, parameters, and return value for the node. When you click on OK, the node
automatically increases in size to have the correct number of terminals. It then sets the
terminals to the correct datatypes. For more information on Call Library Function refer to
Chapter 25, Calling Code From Other Languages, in the G Programming Reference Manual.
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Data Manipulation Function Descriptions

The following illustration displays the options available on the Data Manipulation
subpalette.

=l Data Manipulation

] MANT
@ =4 /'/'_77@ Lyskie
ﬂgj’ cal Al

-] 1€ IE

Flatten To String

Converts anything to a string of binary values. type string is a type descriptor that describes
the datatype of anything. data string is the flattened form of anything. For more information
on type descriptors and flattened data, see Flattened Data, in Appendix A, Data Storage
Formats, of the G Programming Reference Manual.

[o-]

] ; type tring
anything m===H £ data string

Join Numbers
Creates a number from the component bytes or words.

— | (11

Logical Shift
Shifts x the number of bits specified by y.

YT ey
X
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Mantissa & Exponent
Returns the mantissa and exponent of the input numeric value such that
number = mantissa * 2 €P°"0t 1f pymber is 0, both mantissa and exponent are 0.
Otherwise, the value of mantissa is greater than or equal to 1 and less than 2, and the value
of exponent is an integer.

e mantissa
E-3 =0

exponent

number

EXF

Rotate
Rotates x the number of bits specified by y.

y w ratated left by p
X

Rotate Left With Carry

Rotates each bit in the input value to the left (from least significant to most significant bit),
inserts carry in the low-order bit, and returns the most significant bit.

cary [ ,ﬁ’.l msh camy out

rvalue value

Rotate Right With Carry

Rotates each bit in value to the right (from most significant to least significant), inserts carry
in the high-order bit, and returns the least significant bit.

carry

1=b_carry out
walue walue 4

Split Number

Breaks a number into its component bytes or words.

hif=]
X —@:I_ |,::[:]
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The following illustration shows an example of how to use the Split Number function.

The function splits the signed 32-bit number 100,000 into the high word component, 1,
and the low word component, 34,464.

32 ulE
+/100000 1
ulE
34454

Swap Bytes
Swaps the high-order 8 bits and the low-order 8 bits for every word in anything.
anything ': 1 byte swapped
2 2

Swap Words
Swaps the high-order 16 bits and the low-order 16 bits for every long integer in anything.
anything I;; word swapped

Type Cast

Casts x to the datatype, type.

type
X EE “[tupe *] x

Casting data to a string converts it into machine-independent, big endian form. That is, the
function puts the most significant byte or word first and the least significant byte or word last,
removes alignment, and converts extended-precision numbers to 16 bytes. Casting a string to
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a 1D array converts the string from machine-independent form to the native form for that

platform.

Unflatten From String

Converts binary string to the type wired to type. This function performs the inverse of
Flatten To String. binary string should contain flattened data of the type wired to type.
For more information on type descriptors and flattened data, see Flattened Data, in
Appendix A, Data Storage Formats, of the G Programming Reference Manual.

binary string _/-’_77@| eI
type = | walue

Memory VI Descriptions

The following illustration displays the options available on the Memory subpalette.

™

X

In Ot
Part || Port

In Port (Windows 3.1 and Windows 95)

Reads a byte or word integer from a specific register address. Because this VI is not available
on all platforms, VIs using this subVI are not portable.

register address
read a byte or a word [Frhyte] e

Part walue

Out Port (Windows 3.1 and Windows 95)

Writes a byte or word integer to a specific register address. Because this VI is not available
on all platforms, VIs using this subVI are not portable.

register address
wiribe & byte or a word (Fib.. -

value — !

Ot
Fort
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Synchronization Vis

You can synchronize tasks executing in parallel by using the Synchronization VIs.
You can also use the Synchronization VIs to pass data between parallel tasks. You access
the Synchronization palette by choosing Functions» Advanced»Synchronization.

The following illustration displays the options available on the Synchronization palette.

“[] Synchronization

The Synchronization palette consists of five subpalettes:
* Notification VIs

¢ Queue VIs

e Rendezvous VIs

*  Semaphore VIs

¢ Occurrence Functions

Notification Vs

You can use the Notification VIs to pass data from one task to one or more separate, parallel
tasks. In particular, you use these VIs when you want one or more VIs or parts of block
diagrams to wait until another VI or part of a block diagram sends them some data.

The Notification VIs differ from the Queue VIs in that the data sent is not buffered. That is,
if there is no one waiting on a notification when it is sent, the data will be “lost” if another
notification is sent. Also, more than one Wait On Notification VI can receive the same data.
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You can access the notification VIs by selecting
Functions»Advanced»Synchronization»Notification.

Lo o o ou| @

The notification VIs use the Notifier RefNum control from the Controls»Path & Refnum
palette.

The Notifier RefNum can be used with the following VIs.

Cancel Notification
Cancels and returns a previously sent notification.

notifier ':E' natifier out
e pancelled notification

L erraor aut

errar in (no error)

This prevents a call to the Wait On Notification VI with ignore previous set to FALSE to see
the previously sent notification.

Create Notifier

Looks up an existing notifier or creates a new notifier and returns a refnum that you can use
when calling other Notification VIs.

{ i @ notifier
. 2
return exisiting (F) ik created new
ertor in fno error) = b= error oot

If name is specified, the VI first searches for an existing notifier with the same name and
will return its refnum if it exists. If a named notifier with the same name does not already exist
and the return existing input is FALSE, the VI will create a new notifier and return its
refnum. The created new output returns TRUE if the VI creates a new notifier.
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Destroy Notifier
Destroys the specified notifier and returns the last notification that was sent. All Wait on
Notification VIs that are currently waiting on this notifier time out immediately and return

an error.
notifier ':E' notifier out
» e last notification
errar in (no error) ertar out
Get Notifier Status
Returns current status information of notifier.
e fame
notifier ':1:' notifier out

@

L # yraiting

error in (no error]

%hst notification
error out

Not A Notifier
Returns TRUE if netifier is not a valid notifier refnum.
. o i
notifier @0 not 3 notifier

Send Notification

Sends notification to the specified notifier. All Wait On Notification VIs that are currently
waiting on this notifier stop waiting and return the specified notification.

Wait On Notification

Waits for the Send Notification VI to send notification to the specified notifier.

notifier {D notifier out
notification =
ertor in (no error) o ertar out

notifier ':E' niotifier out

ignore previous (T) 777 = . notification
ms timeout (-1 f A N— - tirmed out
errar in Cno error) arrar out
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If ignore previous is FALSE and a notification was sent since the last time this VI was called,
the VI returns immediately with the value of the old notification and with timed out as
FALSE. If the ignore previous input is TRUE, the VI will wait timeout milliseconds
(default —1, or forever) before timing out. If a notification is sent, timed out will return
FALSE. If a notification is not sent or if notifier is not valid, timed out will return TRUE.

Wait On Notification From Multiple

Waits for the Send Notification VI to send a notification to one of the specified notifiers.

notifiers notifiers out
ignore previous (T - i {EI Bonotifications
" s timeout (-1 S tirmed out

errar in (no error) mﬁ‘“ arrar out

Ifignore previous is FALSE and a notification was sent to any of the specified notifiers since
the last time this VI was called, the VI returns immediately with the value(s) of the old
notification(s) and with timed out=FALSE. If the ignore previous input is TRUE, the VI
will wait ms timeout milliseconds (default —1, or forever) before timing out. If at least one
notification is sent, timed out will return FALSE. If no notification is sent, timed out will
return TRUE.

Queue Vls

You can use the Queue VIs to pass an ordered sequence of data elements from one task to
another separate, parallel task. In particular, you use these VIs when you want one task to wait
until another task provides it with some data. You can also use these VIs when you want one
task to wait until another task has processed some data that the first task has provided.

The queue Vs differ from the notification VIs in that the data sent is buffered. That is, if there
is no one waiting to read from the queue when an element is inserted, the element stays in the
queue until it is explicitly removed. Also, when data is inserted into a queue and there are two
VIs waiting to remove it from the queue, only one of them receives the data.

You can access the Queue VIs by selecting Functions»Advanced»Synchronization»Queue.

The Queue VIs use the Queue RefNum control from the Controls»Path & Refnum palette.
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Create Queue

=]

Queue RefNum can be used with the following VIs.

Looks up an existing queue or creates a new queue and returns a refnum that you can use when

calling other queue VlIs.

- (1 i

harme Lunhafned]

. i

e essisiting ()
Feturn exsming L

errar in Cno errar)

o quene
e

e _,Il.j ................. created new
l=ertar out

If you specify a size > 0, the queue size is limited to that many elements. If the Insert Queue
Element VI tries to insert an element into a full queue, it must wait until an element is removed
with the Remove Queue Element VI. The default size is —1 for an unbounded queue.

If a name is specified, the VI first searches for an existing queue with the same name and will
returns its refnum if it exists. If a named queue with the same name does not already exist and
the return existing input is FALSE, the VI creates a new queue and return its refnum.

The created new output returns TRUE if the VI creates a new queue.
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Destroy Queue
Destroys the specified queue and returns any elements that are in the queue. All Insert Queue
Element and Remove Queue Element VIs that are currently waiting on this queue time out
immediately and return an error.

queue - queue aut
» B glements
errar in Cno errar) ertar out
Flush Queue
Removes all elements from queue.
queue I queue out
ugi}ﬁmﬂme]ementg
errar in (no error) ertar out

Get Queue Status

Returns current status information of queue.

quele size
| name

queue - queue out
5z

return elerments (F) - L # pending to remove

ey L pending ta insert

ertar in (no error) EL-
| ertaor aut

# glernets in queus

massssssssses glernents
Insert Queue Element
Inserts an element into a queue.
at l‘-egir.ir-g (F R

queue - queue out
queue element ~F 7 | tirmed out
ms tirmeout (-1] f ... L et ror out

error in (no error)

The at begining parameter specifies whether the element is inserted at the end (default) or the
front of the queue. If the queue is full, the VI waits timeout milliseconds (default —1, or
forever) before timing out. If space becomes available during the wait, the element is inserted
and timeout returns FALSE. If the queue remains full or the queue is not valid, timeout
returns TRUE.
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Not A Queue
Returns TRUE if queue is not a valid queue refnum.
-
queus @9 not a queus
Remove Queue Element
Removes an element from a queue.
frrarn end [F :
queue 1 queus aut
i—
ms timeout (-1 — g qyeue element
errar in (no error) =1 e timed out
error aut

The from end parameter specifies whether the returned element is taken from the front
(default) or the end of the queue. If the queue is empty, the VI waits timeout milliseconds
(default —1, or forever) before timing out. If an element becomes available during the wait,
the element is returned and timed out returns FALSE. If no element becomes available or the
queue is not valid, timed out returns TRUE.

Rendezvous Vs

You can use the Rendezvous VIs to synchronize two or more separate, parallel tasks at
specific points of execution. Each task that reaches the rendezvous waits until the specified
number of tasks are waiting, at which point all tasks proceed with execution.

You can access the Rendezvous VIs by selecting
Functions» Advanced»Synchronization»Rendezvous.

{0 Rendezwou
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The Rendezvous VIs use the Rendezvous RefNum control from the Controls»
Path & Refnum palette.

o+

The Rendezvous RefNum can be used with the following VIs.

Create Rendezvous
Looks up an existing rendezvous or creates a new rendezvous and returns a refnum that you
can use when calling other Rendezvous VIs.

rendezvous

e
-{I-:.I ................ created new
L= error out

burn essisiting (FY el
Feturn exisiting (P e

ertar in (no error)

The size specifies how many tasks have to meet at the rendezvous in order to continue
execution. The default size is 2.

If name is specified, the VI first searches for an existing rendezvous with the same name and
returns its refnum if it exists. If a named rendezvous with the same name does not already
exist and the return existing input is FALSE, the VI creates a new rendezvous and return its
refnum. The created new output returns TRUE if the VI creates a new rendezvous.

Destroy Rendezvous
Destroys the specified rendezvous. All Wait at Rendezvous VIs that are currently waiting on
this rendezvous time out immediately and return an error.

rendezvous **‘. rendezwvous out

error in (no error) errar out

Get Rendezvous Status
Returns current status information of a rendezvous.

fronanansnnns name
rendezyous s rendezvous out
[§ . waiting
errar in (no error) %size
error out
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Not A Rendezvous

Returns TRUE if rendezvous is not a valid rendezvous refnum.

'
@2

rendezyous not a rendezwvous

Resize Rendezvous
Changes the size of rendezvous by size change and returns new size.

rendezvous ry rendezvous out
zize change (01 ';_:' L new size
ertor in Cno errar) ertror out

If the number of tasks currently waiting at rendezvous is less than or equal to new size, the
first size tasks stop waiting and continue execution.

Wait at Rendezvous
Waits until a sufficient number of tasks have arrived at the rendezvous.

rendezwvous **‘. rendezwvous aut
ms timeout (-1 = tirned out
ertar in Cno errar) o= Eoarror aut

If the number of tasks, including the new one, waiting at rendezvous is less than the
rendezvous size, the VI waits timeout milliseconds (default —1, or forever) before timing out.
If enough tasks arrive at the rendezvous during the wait, timed out returns FALSE. If enough
tasks do not arrive or the rendezvous is not valid, timed out returns TRUE.

Semaphore Vis

Semaphores, also known as Mutex, are used to limit the number of tasks that may
simultaneously operate on a shared (protected) resource. A protected resource or critical
section may include writing to global variables or communicating with external instruments.

You can use the Semaphore VIs to synchronize two or more separate, parallel tasks so that
only one task at a time executes a critical section of code protected by a common semaphore.
In particular, you use these VIs when you want other VIs or parts of block diagram to wait
until another VI or part of a block diagram is finished with the execution of a critical section.

You can access the Semaphore VIs by selecting Functions»Advanced»
Synchronization»Semaphore.
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The semaphore VIs use the Semaphore RefNum control from the Controls»
Path & Refnum palette.

8]

The Semaphore RefNum can be used with the following VIs.

Acquire Semaphore
Acquires access to a semaphore.

sermaphate [:] zemaphote aut
1t
ms timeaut (-1 = tirmed out
error in Cno error) =8 Lo error out

If the semaphore is already acquired by the maximum number of tasks, the VI waits timeout
milliseconds (default —1, or forever) before timing out. If the semaphore becomes available
during the wait, timed out returns FALSE. If the semaphore does not become available or the
semaphore is not valid, timed out returns TRUE.

Create Semaphore

Looks up an existing semaphore or creates a new semaphore and returns a refnum that you
can use when calling other semaphore VIs.

................. created new
b=grror out

o eseisiting (B
return exiziting (F)

ertar in (no error)

narne {unnarned) [:] sernaphore

size specifies how many tasks may acquire the semaphore at the same time. The default size
is 1.

If a name is specified, the VI first searches for an existing semaphore with the same name and
returns its refnum if it exists. If a named semaphore with the same name does not already exist
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and the return existing input is FALSE, the VI creates a new semaphore and return its
refnum. The created new output returns TRUE if the VI creates a new semaphore.

Destroy Semaphore

Destroys the specified semaphore. All Acquire Semaphore VIs that are currently waiting on
this semaphore will time out immediately and return an error.

=zemnaphate zemaphote out
%

errar in kne error) errar out

Get Semaphore Status
Returns current status information of a semaphore.

i’""’""’"""""‘""“ nane
semaphore sernaphare out
] [:] L zize
ertar in (no ertor) # waiting
cttlﬂ====-err-:-r out
Not A Semaphore
Returns TRUE if semaphore is not a valid semaphore refnum.
Semap e @?[:] not a semaphate
Release Semaphore
Releases access to a semaphore.
semaphore ‘ [:] semaphare out
ertor in (no errar) error out

If there is an Acquire Semaphore VI waiting for this semaphore, it stops waiting and
continues execution. If you call the Release Semaphore VI on a semaphore that you have not
acquired, you effectively increment the semaphore size.
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Occurrence Function Descriptions

You can use the occurrence functions to control separate, synchronous activities. In particular,
you use these functions when you want one VI or part of a block diagram to wait until another
VI or part of a block diagram finishes a task without forcing LabVIEW to poll.

You can perform the same task using global variables, with one loop polling the value of the
global until its value changes. However, global variables add overhead, because the loop that
pulls the global variable uses execution time. With occurrences, the polling loop is replaced
with a Wait on Occurrence function and does not use processor time. When some diagram
sets the occurrence, LabVIEW activates all Wait on Occurrence functions in any block
diagrams that are waiting for the specified occurrence.

The following illustration displays the options available on the Occurrences subpalette.

¥ |

C > [D

Generate Occurrence
Creates an occurrence that you can pass to the Wait on Occurrence and Set Occurrence
functions.

@7 DCCUMENCE

Ordinarily, only one Generate Occurrence node is connected to any set of Wait on Occurrence
and Set Occurrence functions. You can connect a Generate Occurrence function to any
number of Wait on Occurrence and Set Occurrence functions. You do not have to have the
same number of Wait on Occurrence and Set Occurrence functions.

Unlike other synchronization VIs, each Generate Occurrence function on a block diagram
represents a single, unique occurrence. In this way, you can think of the Generate Occurrence
function as a constant. When a VI is running, every time a Generate Occurrence function
executes, the node produces the same value. For example, if you place a Generate Occurrence
function inside of a loop, the value produced by Generate Occurrence is the same for every
iteration of the loop. If you place a Generate Occurrence function on the block diagram of a
reentrant VI, Generate Occurrence produces a different value for each caller.
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Set Occurrence

Triggers the specified occurrence. All block diagrams that are waiting for this occurrence

stop waiting.

Wait On Occurrence

oCCurence —[D

Waits for the Set Occurrence function to set or trigger the given occurrence.

occurrence

tirmed out
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Data Acquisition Vis

Part I1, Data Aquisition Vs, introduces the collection of VIs that work with
your data aquisition (DAQ) hardware devices. This part contains the
following chapters:

Chapter 14, Introduction to the LabVIEW Data Acquisition VIs,
contains basic information about the data acquisition (DAQ) VIs and
shows where you can find them in LabVIEW.

Chapter 15, Easy Analog Input VIs, describes the Easy Analog Input
VIs, which perform simple analog input operations.

Chapter 16, Intermediate Analog Input VIs, describes the Intermediate
Analog Input VIs.

Chapter 17, Analog Input Utility VIs, describes the Analog Input
Utility VIs. These VIs—AI Read One Scan, Al Waveform Scan, and
Al Continuous Scan—are single-VI solutions to common analog input
problems. The Analog Input Utility VIs are intermediate-level VIs, so
they rely on the advanced-level VIs.

Chapter 18, Advanced Analog Input VIs, contains reference
descriptions of the Advanced Analog Input VIs. These VIs are the
interface to the NI-DAQ software and are the foundation of the Easy,
Utility and Intermediate Analog Input VlIs.

Chapter 19, Easy Analog Output VIs, describes the Easy Analog
Output VIs in LabVIEW, which perform simple analog output
operations.

Chapter 20, Intermediate Analog Output Vls, describes the
Intermediate Analog Output VIs. These VIs—AO Write One Update,
AO Waveform Gen, and AO Continuous Gen—are single VI solutions
to common analog output problems.

Chapter 21, Analog Output Utility Vs, describes the Analog Output
Utility VIs. The VIs—AO Continuous Generation, AO Waveform
Generation, and AO Write One Update—are single-VI solutions to
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Data Acquisition Vs

common analog output problems. The Analog Output Utility VIs are
intermediate-level VIs, so they rely on the advanced-level VIs.

Chapter 22, Advanced Analog Output Vs, contains reference
descriptions of the Advanced Analog Output VIs. These VIs are the
interface to the NI-DAQ software and are the foundation of the Easy,
Utility, and Intermediate Analog Output VIs.

Chapter 23, Easy Digital 1/0 Vls, describes the Easy Digital I/O VIs,
which perform simple digital I/O operations.

Chapter 24, Intermediate Digital I/0 Vls, describes the Intermediate
Digital I/O VIs. These VIs are single VI solutions to common digital
problems.

Chapter 25, Advanced Digital 1/0 Vls, describes the Advanced Digital
I/0 VIs, which include the digital port and digital group VIs. You use
the digital port VIs for immediate reads and writes to digital lines and
ports. You use the digital group VIs for immediate, handshaked, or
clocked I/0 for multiple ports. These VIs are the interface to the
NI-DAQ software and the foundation of the Easy and Intermediate
Digital I/0 VIs.

Chapter 26, Easy Counter VIs, describes the Easy Counter VIs that
perform simple counting operations.

Chapter 27, Intermediate Counter VIs, describes Intermediate Counter
VIs you can use to program counters on MIO, TIO, and other devices
with the DAQ-STC or Am9513 counter chips. These VIs call the
Advanced Counter VIs to configure the counters for common
operations and to start, read, and stop the counters. You can configure
these VIs to generate single pulses and continuous pulse trains, to
count events or elapsed time, to divide down a signal, and to measure
pulse width or period. The Easy Counter VIs call the Intermediate
Counter VIs for several pulse generation, counting, and measurement
operations.

Chapter 28, Advanced Counter VIs, describes the VIs that configure
and control hardware counters. You can use these VIs to generate
variable duty cycle square waves, to count events, and to measure
periods and frequencies.

Chapter 29, Calibration and Configuration Vls, describes the VIs that
calibrate specific devices and set and return configuration information.

Chapter 30, Signal Conditioning VIs, describes the data acquisition
Signal Conditioning VIs, which you use to convert analog input
voltages read from resistance temperature detectors (RTDs), strain
gauges, or thermocouples into units of strain or temperature.
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This chapter contains basic information about the data acquisition (DAQ)
VIs and shows where you can find them in LabVIEW. Descriptions of these
VIs comprise Chapter 14 through Chapter 29.

LabVIEW includes a collection of VIs that work with your DAQ hardware
devices. With LabVIEW DAQ VIs you can develop acquisition and control
applications.

You can find the DAQ VIs in the Functions palette from your block
diagram in LabVIEW. The DAQ VIs are located near the bottom of the
Functions palette.

To access the Data Acquisition palette, choose Functions»
Data Acquisition, as shown in the following illustration.
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The Data Acquisition palette contains six subpalette icons that take you
to the different classes of DAQ VIs. The following illustration shows what
each of the icons in the Data Acquisition palette means.

Analog Input Vis —mr =

Calibration and
Configuration VIs gl

Analog Output VIs Digital /0 Vls
EO pata
Yy v
- k E'nu k E'mi k E!! k -g Counter Vls
FE g
Hize '-?'L"'}%

Signal Conditioning Vs

This part of the manual is organized in the order that the DAQ VI icons
appear in the Data Acquisition palette from left to right. For example,

in this section, the Analog Input VI chapters are followed by the Analog
Output VI chapters, which are followed by the Digital I/O VI chapters, and
so on. Most often, there are several chapters devoted to one class of

DAQ VIs in the palette, because many of the VI palettes also contain
several subpalettes.

Finding Help Online for the DAQ Vls

You can find helpful information about individual VIs online by using the
LabVIEW Help window (Help»Show Help). When you place the cursor
on a VI icon, the wiring diagram and parameter names for that VI appear
in the Help window. You can also find information for front panel controls
or indicators by placing the cursor over the control or indicator with the
Help window open. For more information on the LabVIEW Help window,
refer to the Getting Help section in Chapter 2, Creating VlIs, of the
LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online
information available. To access this information, select Help»Online
Reference. For most block diagram objects, you can select Online
Reference from the object’s pop-up menu to access the online description.
You can also access this information by pressing the button shown to the
left, which is located at the bottom of LabVIEW’s Help window.

For information on creating your own online reference files, see the
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Creating Your Own Help Files section in Chapter 5, Printing and
Documenting Vls, of the G Programming Reference Manual.

Note Use only the inputs you need on each VI. LabVIEW sets all unwired inputs to their
default values. Many of the DAQ function inputs are optional and do not appear
in the Simple Diagram Help window. These inputs typically specify rarely-used
options. If an input is required, your VI wiring remains “broken” until a value
is wired to the input. Required inputs appear in bold in the Help window,
recommended inputs appear in plain text, and optional inputs are in gray text.

The default values for inputs appear in parentheses beside the input name in the
Help window.

Note Some DAQ VIs use an enumerated data type as a control or indicator terminal.
If you connect a numeric value to an enumerated indicator, LabVIEW converts

the number to the closest enumeration item. If you connect an enumerated control
to a number value, the value is the enumeration index.

The Analog Input Vis

These VIs perform analog input operations.

The Analog Input VIs can be found by choosing Functions»
Data Acquisition»Analog Input. When you click on the Analog Input

icon in the Data Acquisition palette, the Analog Input palette pops up,
as shown in the following illustration.
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There are four classes of Analog Input VIs found in the Analog Input
palette. The Easy Analog Input VIs, Intermediate Analog Input VIs,

Analog Input Utility VIs, and Advanced Analog Input VIs. The following
illustrates these VI classes.

B Analog Input
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< Intermediate
Analog Input Vs

. Advanced

\ Analog Input Vis

Analog Input Utility Vis

Easy Analog Input Vis

The Easy Analog Input VIs perform simple analog input operations.
You can run these VIs from the front panel or use them as subVIs in
basic applications.

You can use each VI alone to perform a basic analog operation.
Unlike intermediate- and advanced-level VIs, Easy Analog Input VIs

automatically alert you to errors with a dialog box that asks you to stop
the execution of the VI or to ignore the error.

The Easy Analog Input VIs provide a basic, convenient interface with
only the most commonly used inputs and outputs. For more complex
applications, you should use the Intermediate Analog Input VIs and
Advanced Analog Input VIs for more functionality and performance.

Refer to Chapter 15, Easy Analog Input Vls, for specific VI information.
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Intermediate Analog Input Vis

You can find intermediate-level Analog Input VIs in two different places
in the Analog Input palette. You can find the Intermediate Analog

Input VIs in the second row of the Analog Input palette. The other
intermediate-level VIs are in the Analog Input Utilities palette, which

is discussed later. The Intermediate Analog Input VIs—AI Config,

Al Start, Al Read, Al Single Scan, and Al Clear—are in turn built from the
fundamental building block layer, called the Advanced Analog Input VIs.
These VIs offer almost as much power as the advanced-level VIs, and they
conveniently group the advanced-level VIs into a tidy, logical sequence.

Refer to Chapter 16, Intermediate Analog Input VlIs, for specific
VI information.

Analog Input Utility Vs

uTIL B
= K

Analog Input
Utility Icon

You can access the Analog Input Utilities palette by choosing the Analog
Input Utility icon from the Analog Input palette. The Analog Input
Utility VIs—AI Read One Scan, Al Waveform Scan, and Al Continuous
Scan—are single-VI solutions to common analog input problems. These
VIs are convenient, but they lack flexibility. These three VIs are built from
the Intermediate Analog Input VIs in the Analog Input palette.

Refer to Chapter 17, Analog Input Utility VIs, for specific VI information.

Advanced Analog Input Vis

=L oY b
F.

Advanced Analog
Input Icon

You can access the Advanced Analog Input palette by choosing the
Advanced Analog Input icon from the Analog Input palette. These VIs
are the interface to the NI-DAQ data acquisition software and are the
foundation of the Easy, Utility, and Intermediate Analog Input VIs.

Refer to Chapter 18, Advanced Analog Input Vs, for specific
VI information.

Locating Analog Input VI Examples

For examples of how to use the analog input Vs, see
examples\dag\anlogin\anlogin.llb.
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Analog Output Vis

These VIs perform analog output operations.

The Analog Output VIs can be found by choosing Functions»Data
Acquisition»Analog Output. When you click on the Analog Output icon
in the Data Acquisition palette, the Analog Output palette pops up, as
shown in the following illustration.
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There are four classes of Analog Output VIs found in the Analog Output
palette: the Easy Analog Output VIs, Intermediate Analog Output Vs,
Analog Output Utility VIs, and the Advanced Analog Output VIs.

The following illustrates these VI classes.
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Easy Analog Output Vis

The Easy Analog Output VIs perform simple analog output operations.
You can run these VIs from the front panel or use them as subVIs in basic
applications.

You can use each VI by itself to perform a basic analog output operation.
Unlike intermediate- and advanced-level VIs, Easy Analog Output VIs
automatically alert you to errors with a dialog box that asks you to stop the
execution of the VI or to ignore the error.

The Easy Analog Output VIs provide a basic, convenient interface with
only the most commonly used inputs and outputs. For more complex
applications, you should use the Intermediate Analog Output VIs and
Advanced Analog Output VIs for more functionality and performance.

Refer to Chapter 19, Easy Analog Output Vls, for specific VI information.

Intermediate Analog Output Vis

You can find intermediate-level Analog Output VIs in two different places
in the Analog Output palette. You can find the Intermediate Analog
Output VIs in the second row of the Analog Output palette. The other
intermediate-level VIs are in the Analog Output Utilities palette, which is
discussed later. The Intermediate Analog Output VIs—AO Config, AO
Write, AO Start, AO Wait, and AO Clear—are in turn built from the
fundamental building block layer, called the Advanced Analog Output VIs.
These VIs offer almost as much power as the advanced-level VIs, and they
conveniently group the advanced-level VIs into a tidy, logical sequence.

Refer to Chapter 20, Intermediate Analog Output Vls, for specific
VI information.

Analog Output Utility Vis

uTIL b
E"‘H

Analog Output
Utility Icon

You can access the Analog Output Utilities palette by choosing the
Analog Output Utility icon from the Analog Output palette. The Analog
Output Utility VIs—AI Read One Scan, AI Waveform Scan, and Al
Continuous Scan—are single-VI solutions to common analog output
problems. These VIs are convenient, but they lack flexibility. These three
VIs are built from the Intermediate Analog Output VIs in the Analog
Output palette.

Refer to Chapter 21, Analog Output Utility Vs, for specific VI information.
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Advanced Analog Output Vis

EPHDU I

Advanced Analog
Output Icon

You can access the Advanced Analog Output palette by choosing the
Advanced Analog Output icon from the Analog Output palette. These
VIs are the interface to the NI-DAQ software and are the foundation of the
Easy, Utility, and Intermediate Analog Output VIs.

Because all these VIs rely on the advanced-level VIs, you can refer to
Chapter 22, Advanced Analog Output VIs, for additional information on the
inputs and outputs and how they work.

Locating Analog Output VI Examples

For examples of how to use the analog output VIs, see the examples in
examples\dag\anlogout\anlogout.1llb.

Digital Function Vis

These VIs perform digital operations.

The Digital I/O VIs can be found by choosing Functions»Data
Acquisition»Digital I/O. When you click on the Digital I/O icon in the
Data Acquisition palette, the Digital I/O palette pops up, as shown in the
following illustration.
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There are three classes of Digital I/O VIs found in the Digital I/O palette.
The Easy Digital I/O VIs, Intermediate Digital I/O VIs, and Advanced
Digital I/O VIs. The following illustrates these VI classes.
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Easy Digital 1/0 Vls

The Easy Digital I/O VIs perform simple digital operations. You can run
these VIs from the front panel or use them as subVlIs in basic applications.

You can use each VI by itself to perform a basic digital operation. Unlike
intermediate- and advanced-level VIs, Easy Digital I/O VIs automatically
alert you to errors with a dialog box that asks you to stop the execution of
the VI or to ignore the error.

The Easy Digital I/O VIs are actually composed of Advanced Digital I/O
VIs. The Easy Digital I/O VIs provide a basic, convenient interface with
only the most commonly used inputs and outputs. For more complex
applications, you should use the intermediate- or advanced-level VIs for

more functionality and performance.

Refer to Chapter 23, Easy Digital I/0 Vs, for specific VI information.

Intermediate Digital 1/0 Vis
You can find intermediate-level Digital I/O VIs in the second and third
rows of the Digital I/O palette. The Intermediate Digital /O VIs are in turn
built from the fundamental building block layer, called the Advanced
Digital I/O VIs. These VIs offer almost as much power as the
advanced-level VIs, and they conveniently group the advanced-level
VIs into a tidy, logical sequence.

Refer to Chapter 24, Intermediate Digital 1/0 Vls, for specific
VI information.
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Advanced Digital 1/0 Vls
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Advanced Digital
1/0 Icon

You can access the Advanced Digital I/0 palette by choosing the
Advanced Digital I/O icon from the Digital I/O palette. These VIs are the
interface to the NI-DAQ software and are the foundation of the Easy,
Utility, and Intermediate Digital I/O Vls.

Because all these VIs rely on the advanced-level VIs, you can refer to
Chapter 25, Advanced Digital 1/0 VIs, for additional information on the
inputs and outputs and how they work.

Locating Digital 1/0 VI Examples

Counter Vs

For examples of how to use the Digital I/O VIs, see the examples in
examples\dag\digital\digio.1llb.
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These VIs perform counting operations.

The Counter VIs can be found by choosing Functions»Data
Acquisition»Counter. When you click on the Counter icon in the

Data Acquisition palette, the Counter palette pops up, as shown in the
following illustration.

© National Instruments Corporation



Easy Counter Vs

Chapter 14 Introduction to the LabVIEW Data Acquisition Vs

There are three classes of Counter VIs found in the Counter palette: the
Easy, Intermediate, and Advanced Counter VIs. The following illustrates
these VI classes.
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Intermediate Counter Vis

The Easy Counter VIs perform simple counting operations. You can run
these VIs from the front panel or use them as subVlIs in basic applications.

You can use each VI by itself to perform a basic counting operation. Unlike
intermediate- and advanced-level VIs, Easy Counter VIs automatically
alert you to errors with a dialog box that asks you to stop the execution of
the VI or to ignore the error.

The Easy Counter VIs are actually composed of Intermediate Counter VIs,
which are in turn composed of Advanced Counter VIs. The Easy Counter
VIs provide a basic, convenient interface with only the most commonly
used inputs and outputs. For more complex applications, you should use the
intermediate- or advanced-level VIs for more functionality and
performance.

Refer to Chapter 26, Easy Counter Vls, for specific VI information.

Intermediate Counter Input Vis
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Intermediate
Counter VI Icon

You can find the Intermediate Counter VIs in the second row of the
Counter palette. The Intermediate Counter VIs are in turn built from the
fundamental building block layer, called the Advanced Counter VIs. These
VIs offer almost as much power as the advanced-level VIs, and they
conveniently group the advanced-level VIs into a tidy, logical sequence.

Refer to Chapter 27, Intermediate Counter VIs, for specific VI information.

© MNational Instruments Corporation 14-11 LabVIEW Function and VI Reference Manual



Chapter 14 Introduction to the LabVIEW Data Acquisition Vs

Advanced Counter Vis
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Advanced
Counter VI Icon

You can access the Advanced Counter palette by choosing the Advanced
Counter icon from the Counter palette. These VIs are the interface to the
NI-DAQ software and are the foundation of the Easy and Intermediate
Counter VIs.

Because all these VIs rely on the advanced-level VIs, you can refer to
Chapter 28, Advanced Counter Vls, for additional information on the inputs
and outputs and how they work.

Locating Counter VI Examples

For examples of how to use the Counter VIs, open the example libraries by
opening examples\dag\counter\DAQ-STC. 11b,
examples\dag\counter\am9513.11b, and
examples\dag\counter\8253.11b.

Calibration and Configuration Vls

These VIs calibrate specific devices and set and return configuration
information.

See Chapter 29, Calibration and Configuration VlIs, for information on
locating these VIs and examples.

Signal Conditioning Vls

These VIs convert analog input voltages read from resistance temperature
detectors (RTDs), strain gauges, or thermocouples into units of strain or
temperature.

See Chapter 30, Signal Conditioning Vls, for information on locating these
VIs and examples.
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This chapter describes the Easy Analog Input VIs, which perform simple

analog input operations. You can run these VIs from the front panel or use
them as subVIs in basic applications.

You can access the Easy Analog Input VIs by choosing Functions»Data
Acquisition»Analog Input. The Easy Analog Input VIs are the VIs on the
top row of the Analog Input palette, as shown below.

[I:I Analog Input

Al ]
wtt #7 || nT et || omME £T|| oME PT |[~<@——F—— Easy Analog Input Vis

Easy Analog Input VI Descriptions

The following Easy Analog Input VIs are available.

Al Acquire Waveform

Acquires a specified number of samples at a specified sample rate from a single input channel
and returns the acquired data.

device il
HILT FT wavefom
channel [0] gt

number of samples [T

zample rate (1000 samples/sec]
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The AI Acquire Waveform VI performs a hardware-timed measurement of a waveform
(multiple voltage readings at a specified sampling rate) on a single analog input channel.
If an error occurs, a dialog box appears, giving you the option to stop the VI or continue.

Refer to Appendix B, DAQ Hardware Capadbilities, for the channel numbers and input limits
available with your DAQ device.

Al Acquire Waveforms
Acquires data from the specified channels and samples the channels at the specified scan rate.

channedlg?(lﬁg o] it f:;;?t;ra;ns
number of samplesfch T8l “period (sec)

scan rate (1000 scansfsec) -
high Tirnit (0.0 —
Tow Tirmit (000

The AI Acquire Waveforms VI performs a timed measurement of multiple waveforms on the
specified analog input channels. If an error occurs, a dialog box appears, giving you the option
to abort the operation or continue execution.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel numbers and input limits
available with your DAQ device.

Al Sample Channel
Measures the signal attached to the specified channel and returns the measured value.
device Al
channel (0] ,i"f zample

The AI Sample Channel VI performs a single, untimed measurement of a channel. If an error
occurs, a dialog box appears giving you the option to stop the VI or continue.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel numbers and input limits
available with your DAQ device.
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Al Sample Channels

Performs a single reading from each of the specified channels.

device .
channels (0] - ¥ zamples

The AI Sample Channels VI measures a single value from each of the specified analog input
channels. If an error occurs, a dialog box appears, giving you the option to stop the VI or
continue.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel numbers and input limits
available with your DAQ device.
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This chapter describes the Intermediate Analog Input VIs. These VIs are
convenient, but they lack flexibility.

You can access the Intermediate Analog Input VIs by choosing
Functions»Data Acquisition»Analog Input. The Intermediate Analog

Input VIs are the VIs on the second row of the Analog Input palette, as
shown below.
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Handling Errors

LabVIEW makes error handling easy with the Intermediate Analog Input
VIs. Each intermediate-level VI has an error in input cluster and an error
out output cluster. The clusters contain a Boolean that indicates whether an
error occurred, the error code for the error, and the name of the VI that
returned the error. If error in indicates an error, the VI returns the error
information in error out and does not continue to run.

Note The AI Clear VI is an exception to this rule—this VI always clears the acquisition
regardless of whether error in indicates an error.
© National Instruments Corporation 16-1
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When you use any of the Intermediate Analog Input VIs in a While Loop,
you should stop the loop if the status in the error out cluster reads TRUE.
If you wire the error cluster to the General Error Handler VI, the VI
deciphers the error information and describes the error to you.

The General Error Handler VI is in Functions»Time and Dialog in
LabVIEW.

Intermediate Analog Input VI Descriptions

The following Intermediate Analog Input VIs are available.

Al Clear

Clears the analog input task associated with taskID in.

tazklD in LR tazkID out
error in [no error) SenEl error out

The Al Clear VI stops an acquisition associated with taskID in and release associated internal
resources, including buffers. Before beginning a new acquisition, you must call the AI Config
VI. Refer to Chapter 18, Advanced Analog Input VIs, for description of the Al Control VI.

= Note The Al Clear VI always clears the acquisition regardless of whether error in
indicates that an error occurred.

When you use any of the Intermediate Analog Input VIs in a While Loop, you should stop the
loop if the status in the error out cluster reads TRUE. If you wire the error cluster to the
General Error Handler VI, the VI deciphers the error information and describes the error

to you.

The General Error Handler VI is in Functions»Time and Dialog in LabVIEW. For more
information on this VI, refer to Chapter 10, Time, Dialog, and Error Functions.

Al Config

Configures an analog input operation for a specified set of channels. This VI configures the
hardware and allocates a buffer for a buffered analog input operation.
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Intermediate Analog Input Vis

allacation made [no change:0]
[Fumber of Ak boards] [no...

interchannel delay [zecs] [
meazurement mode struckuneg s
caupling & input canfig [no..
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tazk|D

device [1]

channels (0] = s

buffer size (1000 scanz)
group] (0]

2rrar in [ho ermar]
[nurmber of buffers] 1]

mg; nurmber of channels
““Lm DSF handle structure out

error ot

You can allocate more than one buffer only with the following devices.

*  (Macintosh) NB-A2000, NB-A2100, and NB-A2150

Refer to Appendix B, DAQ Hardware Capabilities, for the channel ranges, input limits, and
scanning order you can use with your National Instruments DAQ device.

Al Read

Reads data from a buffered data acquisition.

zcan backlog

conditional retriesal [off] 7| | number read
tazklD in wiln taskID out
number of scans toread (1., - = zraled data
TIHET P AE -
tirme lirnit in z2c (Mo chana... J_ """" binany data
output units [zcaled: 1) e retrignial complete
error in [no emor| error out

read/zearch pozition [from .. e
DSP handle stouctne s

The AI Read VI calls the AI Buffer Read VI to read data from a buffered analog input

acquisition.

Al Single Scan

Returns one scan of data from a previously configured group of channels.

data remaining

tasklD out

tasklD in Al
opcode —f i

tirne limit in zec [ho change:-1 —l_. T
sutput units ([acaled: 1} —I_H

eror in [no eror

% binary data
H acquizition state

L xoabed data

error out
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If you have already started an acquisition with the Al Start VI, this VI reads one scan from
the acquisition buffer data, or the onboard FIFO if the acquisition is not buffered. If you have
not started an acquisition, this VI starts an acquisition, retrieves a scan of data, and then
terminates the acquisition. The group configuration determines the channels the VI samples.

If you do not call the AI Start VI, this VI initiates a single scan using the fastest safe channel
clock rate. You can alter the channel clock rate with the AI Config VI.

If you run the Al Start VI, a clock signal initiates the scans.

You must use the Al Start VI to set the clock source to external, for externally-clocked
conversions.

If clock sources are internal and you do not allocate memory, a timed nonbuffered acquisition
begins when you run the Al Start VI. You use this type of acquisition for synchronizing analog
inputs and outputs in a point-to-point control application. The following devices do not
support timed, nonbuffered acquisitions.

e (Macintosh) NB-A2000, NB-A2100, and NB-A2150

Note LabVIEW restarts the device in the event of a FIFO overflow during a timed,
nonbuffered acquisition.

When you set opcode to 1 for a nonbuffered acquisition, the VI reads one scan from the FIFO
and returns the data. If opcode is 2, the VI reads the FIFO until it is empty and returns the last
scan read.

Al Start

Starts a buffered analog input operation. This VI sets the scan rate, the number of scans to
acquire, and the trigger conditions. The VI then starts an acquisition.

:
taskID in Al taskID out
number of scans to acguire ..

—
scan rate (1000 scans/sec) J_ A= 1&.@

ermar in [ho errar)

efrar ouk

Refer to Appendix B, DAQ Hardware Capabilities, for the channel ranges, input limits,
scanning order, triggers, and clocks you can use with your National Instruments DAQ device.
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This chapter describes the Analog Input Utility VIs. These VIs—AI Read
One Scan, AI Waveform Scan, and Al Continuous Scan—are single-VI
solutions to common analog input problems. The Analog Input Utility VIs
are intermediate-level VIs, so they rely on the advanced-level VIs. You can
refer to Chapter 18, Advanced Analog Input Vls, for additional information
on the inputs and outputs and how they work.

You can access the Analog Input Ultilities palette by choosing
Functions»Data Acquisition»Analog Input»Analog Input Utilities. The
icon that you must select to access the Analog Input Utility VIs is on the
bottom row of the Analog Input palette, as shown below.

Analog Input Utility Vs
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Handling Errors

LabVIEW makes error handling easy with the intermediate-level Analog
Input Utility VIs. Each intermediate-level VI has an error in input cluster
and an error out output cluster. The clusters contain a Boolean that
indicates whether an error occurred, the error code for the error, and the
name of the VI that returned the error. If error in indicates an error, the VI
returns the error information in error out and does not continue to run.

When you use any of the Analog Input Utility VIs in a While Loop, you
should stop the loop if the status in the error out cluster reads TRUE.
If you wire the error cluster to the General Error Handler VI, the VI
deciphers the error information and describes the error to you.

The General Error Handler VI is in Functions»Time and Dialog in
LabVIEW. For more information on this VI, refer to Chapter 10,
Time, Dialog, and Error Functions.

Analog Input Utility VI Descriptions

The following VIs are available through the Analog Input Utility subpalette.

Al Continuous Scan

Makes continuous, time-sampled measurements of a group of channels, stores the data in a
circular buffer, and returns a specified number of scan measurements on each call.

device [1] — zaled data

channels [0] = .
nurmber of scans ta read [300] J_' """ : =
zan rate (1000 scanzdzec) i
error in [no eror)
iteration [init: 0] :

clear acquisitiu:un [T] ....................... i

=

errar out

m The AI Continuous Scan VI scans a group of channels indefinitely, as you
might do in data logging applications. Place the VI in a While Loop and

fteration wire the loop’s iteration terminal to the VI iteration input.

terminal
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Also wire the condition that terminates the loop to the clear acquisition input, inverting the
signal if necessary so that it reads TRUE on the last iteration. On iteration 0, the VI calls the
Al Config VI to configure the channel group and hardware and allocates a data buffer; the VI
calls the AI Start VI to set the scan rate and start the acquisition. On each iteration, the VI
calls the AI Read VI to retrieve the number of measurements specified by number of scans
to read, scales them, and returns the data as an array of scaled values. On the last iteration
(when clear acquisition is TRUE) or if an error occurs, the VI calls the Al Clear VI to clear
any acquisition in progress. You should not need to call the AI Continuous Scan VI outside
of a loop, but if you do, you can leave the iteration and clear acquisition inputs unwired.

When calling the AI Continuous Scan VI in a loop to read portions of the data from the
ongoing acquisition, you must read the data fast enough so that newly acquired data does
not overwrite it. The scan backlog output tells you how much data acquired by the VI, but
remains unread. If the backlog increases steadily, your new data may eventually overwrite old
data. Retrieve data more often, or adjust the buffer size, the scan rate, or the number of
scans to read to fix this problem

Refer to Appendix B, DAQ Hardware Capabilities, for the channel ranges, input limits, and
scanning order you can use with your National Instruments DAQ device.

Al Read One Scan

Measures the signals on the specified channels and returns the measurements in an array of
scaled or binary values.

coupling & input config (no change :0
input limits {no change)

b qlevtiﬁi '1 LFIH‘ scakbddata
channels - .
autput units {zcaled: 1) ’ binary data

- =
error 1 \no error) : —==error out

iteration (init:0)
[rurnber of &MMUE boards] (00

m The Al Read One Scan VI performs an immediate measurement of a group

of one or more channels. If you place the VI in a loop to take multiple
measurements from a group of channels, wire the loop iteration terminal to
the VI iteration parameter.

iteration
terminal

On iteration 0, this VI calls the AI Config VI to configure the channel group and hardware,
then calls the AI Single Scan VI to measure and report the results. On subsequent iterations,
the VI avoids unnecessary configuration and calls only the AI Single Scan VI. If you call the
Al Read One Scan VI once to take a single measurement from the group of channels, the
iteration parameter can remain unwired.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel ranges, input limits, and
scanning order available with your DAQ device.
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Al Waveform Scan
Acquires the specified number of scans at the specified scan rate and returns all the data
acquired. You can trigger the acquisition.

time limit in sec [compute...

trigger and clack [na trig ... soccecmoo

caupling & nput config (no. .. e
input Tirnils (o change)

derice
chamnels (0) & WHYE scaled data

number of scans f e atual san pariod (sec)
scan rate (1000 scans fsec) error out
error in (so error)
iteration (init:0)

tlear acquisition (Yes T) -

[rurrber of AMUE boards] (...

m The AI Waveform Scan VI acquires a specified number of scans from a

channel group at a specified scan rate. If you place this VI in a loop to take
multiple acquisitions from the same group of channels, wire the iteration
terminal of the loop to the VI iteration input.

iteration
terminal

Also wire the condition that terminates the loop to the VI clear acquisition input, inverting
the signal if necessary so that it reads TRUE on the last iteration. On iteration zero, this VI
calls the AI Config VI to configure the channel group and hardware and allocate a data buffer.
On each iteration, this VI calls the AI Start and Al Read VIs. The AI Start VI sets the scan
rate and trigger conditions and starts the acquisition. The VI stores the measurements in the
buffer as they are acquired, and the Al Read VI retrieves them from the buffer, scales them,
and returns all the data as an array of scaled values. On the last iteration (when clear
acquisition is TRUE) or if an error occurs, the VI also calls the Al Clear VI to clear the
acquisition in progress. If you call the AT Waveform Scan VI only once, you can leave
iteration and clear acquisition unwired.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel ranges, input limits,
scanning order, triggers, and clocks you can use with your National Instruments DAQ device.

Note These VIs use an uninitialized shift register as local memory to remember the
taskID for the group of channels between VI calls. You normally use one VI in one
place on your diagram, but if you use it more than once, the multiple instances of
the VI share the same taskID. All calls to one of these VIs configure, read data
Jrom, or clear the same acquisition. Occasionally you may want to use each VI in
multiple places and have each instance refer to a different taskID (for example,
when you measure two devices simultaneously). Save a copy of the VI with a new
name (for example, AI Waveform Scan R) and make your new VI reentrant.
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% Note For all Analog Input Utility VIs, if your program iterates more than 231 _ ] times,
do not wire the iteration input to the loop iteration terminal. Instead, set iteration
to 0 on the first loop, then to any positive value on all other iterations. The VI
reconfigures and restarts if iteration <0.
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This chapter contains reference descriptions of the Advanced Analog Input
VIs. These VlIs are the interface to the NI-DAQ software and are the
foundation of the Easy, Utility and Intermediate Analog Input VIs.

You can access the Advanced Analog Input palette by choosing
Functions»Data Acquisition»Analog Input»Advanced Analog Input.
The icon that you must select to access the Advanced Analog Input VIs is
on the bottom row of the Analog Input palette, as shown below.

El:l Analog Input i

Rl Al |
HULT FT || HULTFT || OME FT || OME FT

o | N ITECTY e | B ETTECTY e | N ETTCTY e | B ETTIE) 1
VAL B i Advanced
‘ < Analog Input Vls

Advanced Analog Input VI Descriptions

The following Advanced Analog Input VIs are available.
Al Buffer Config

Allocates memory for LabVIEW to store analog input data until the AI Buffer Read VI can
deliver it to you. LabVIEW refers to the buffer(s) allocated by the Al Buffer Config VI as
internal buffers because you do not have direct access to them.

task ID Config task ID out
scans per buffer (—1:no ch.__ "‘:‘_',, DSP rermory handle out
[ nurnber of buffers 1 (-1:... — e =

error out
error in (no error)

allacation mode (0: no change)
'SP mernory handle (00
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% Note When you run the AI Control VI with control code set to 4 (clear), the VI performs
the equivalent of running the Al Buffer Config VI with allocation mode set to 1.
That is, both VIs deallocate the internal analog input data buffers. However,
acquisitions that use DSP or expansion card memory are an exception. The Al
Control VI does not deallocate DSP memory when clearing an acquisition. You
must explicitly call the AI Buffer Config VI to deallocate DSP acquisition buffers.

Table 18-1 lists default settings and ranges for the AI Buffer Config VI. The first row gives
the values for most devices, and the other rows give the values for devices that are exceptions

to the rule.
Table 18-1. Al Buffer Config VI Device-Specific Settings and Ranges
Scans per Buffer | Number of Buffers | Allocation Mode
Default Default Default

Device Setting | Range | Setting | Range Setting | Range
Most Devices 100 0, n=3 1 0,1 2 1,2
Lab-NB 100 n=3 1 0,1 2 1,2
Lab-LC
NB-A2000 100 n=0 1 n=0 2 1,2
NB-A2100
NB-A2150
5102 Devices 100 n=3 1 1 2 1,2

Al Buffer Read

Returns analog input data from the internal data buffer(s).

rmark locations

conditional retrieval specification (aff) acquisition state
number tt:Erke;[; = Rea ::rillge:'nr:;:lt
read fsearch lacation (no change) mj—lm“-{ scalked data
autput type ( zcaled i1) binary data
error in {no error) | | error out

tirne Tirmit (no change) san backlog

read specification (no change)

Note When the VI reads from the trigger mark, it does not return data until the
acquisition completes for the buffer containing the trigger.
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Al Clock Config

Sets the channel and scan clock rates.

[ configuration made ]
[ Fetrigger mode ]

tazk ID k tazk ID out
which clock ———]%onT g oy B aitual clock rate specification
clock frequency — 1™
error in (no error
clock Soupce S H
[ alternate clock rate specification | s i

e error out

Refer to Appendix B, DAQ Hardware Capabilities, for the clocks available with your
DAQ device.

For devices that have only a channel clock (Lab-LC, Lab-NB, NB-MIO-16, Lab-PC+,
PCI-1200, PC-LPM-16, DAQCard-500, DAQCard-700, and DAQCard-1200), you cannot
set independent channel and scan clock rates. Setting one resets the other because the channel
rate equals scan rate/number of channels to scan.

For devices that have no channel clock (NB-A2000, NB-A2100, and NB-A2150), setting the
channel clock produces an error.

If you specify a value of 0 for the scan clock rate, interval scanning turns off, and channel
scanning (or round-robin scanning) proceeds at the channel clock rate. This option is
meaningful only for devices with independent channel and scan clocks.

The clock rate is the rate at which LabVIEW samples data or acquires scans. You can express
the clock rate three ways—with clock frequency, with clock period, or with timebase
source, timebase signal, and timebase divisor. The VI searches these parameters in that
order and sets the clock rate using the first one with a value not equal to -1.
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Table 18-2 lists default settings and ranges for the controls of the AI Clock Config VI.

Table 18-2. Device-Specific Settings and Ranges for Controls in the Al Clock Config VI

Configuration Retrigger
Mode Mode Which Clock Clock Source
Default Default Default Default
Device Setting | Range Setting Setting | Range | Setting | Range
AT-MIO-16E1 1 1,3 no 1 1,2 1 1,2
AT-MIO-16E-2 support 4<n<l11
AT-MIO-64E-1
NEC-MIO-16E-4
PCI-MIO-16E-1
PCI-MIO-16E-4
PCI-MIO-16XE-10
PCI-6110E 1 1,3 no 1 1 1 1,2
PCI-6111E support 4<n<11
AT-MIO-16E-10 1 1,3 no 1 1,2 1 1,2
AT-MIO-16DE-10 support 4<n<9
AT-MIO-16XE-50
PCI-MIO-16XE-50
NB-A2150 1 1,3 no 1 1 1 1<n<3
NB-A2100 support
NB-A2000
DSA Devices 1 1,3 no 1 1 1 1
support
PC-LPM-16 1 1,3 no 1 1,2 1 1,2
DAQCard-500 support
DAQCard-516
DAQCard-700
Lab-PC
Lab-LC 1 1,3 no 1 2 1 1,2
Lab-NB support
NB-MIO-16
5102 1 1,3 no 1 1 1 1,6
support
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Table 18-2. Device-Specific Settings and Ranges for Controls in the Al Glock Config VI (Continued)

Configuration Retrigger
Mode Mode Which Clock Clock Source
Default Default Default Default

Device Setting | Range Setting Setting | Range | Setting | Range

5911, 5912 1 1,3 no 1 1,2 1 1<n<3
support

All Other Devices 1 1,3 no 1 1,2 1 1<n<3
support

Al Control

Controls the analog input tasks and specifies the amount of data to acquire.

Note

= Note

rinirurn pretrigger scans to acquire
task ID

Cantrl} task ID out
control code _|—_'_n,
total scans to acquire Pl e
error in (no error) el error out
[number of buffers to acquire]

You cannot use this VI to start an acquisition when you use a PC-LPM-16,
DAQCard-500, or a DAQCard-700 device to scan multiple SCXI channels in
multiplexed mode. For this special case, you must use the Al SingleScan VI to
acquire data. (For more information about the Al SingleScan VI, refer to

its description in this chapter.) However, you can use the AI Control VI for a Lab
and 1200 Series device, PC-LPM-16, DAQCard-500, or DAQCard-700 device
when you scan SCXI channels in parallel mode or sample a single SCXI channel
in multiplexed mode. You can use this VI for an MIO device scanning

SCXI channels in either mode.

Nonbuffered acquisitions are not supported for the following devices.

e (Macintosh) NB-A2000
e (Macintosh) NB-A2100
e (Macintosh) NB-A2150
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Table 18-3 lists default settings and ranges for the AI Control VI.

Table 18-3. Device-Specific Settings and Ranges for the Al Control VI

Minimum Number of
Control Total Scans Pretrigger Buffers to
Code to Acquire Scans to Acquire Acquire
Device DS* R* DS* R* DS* R* DS* R*
NB-A2000 0 0,1,4 0 0, n=0 0 0, n=3 1 n=0
NB-A2150
PC-LPM-16 0 0,1,4 0 0, n=3 0 no 1 1
DAQCard-500 support
DAQCard-700
MIO-E Series 0 0,1,4 0 0, n=3 0 0, n=3 1 1
5102 Devices 0 0,1,4 0 n=0 0 n=0 1 1
5911, 5912 0 0,4 0 n=1 0 n=0 1 1
All Other 0 0,1,4 0 0, n=3 0 n=0 1 1
Devices

* DS = Default Setting; R = Range

Al Group Config

Defines what channels belong to a group and assigns them.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel ranges and scanning order

dewice

[ group (03] T
channel scan list (empiy)
error in (no error)

ol

Group task ID
E{:"f : scan width
o error out

available with your DAQ device.

Table 18-4 lists default settings and ranges for the AI Group Config VI. The first row of the
table gives the values for most devices, and the other rows give the values for devices that are

exceptions to the rule.

LabVIEW Function and VI Reference Manual

18-6

© National Instruments Corporation




Chapter 18 Advanced Analog Input Vs

Table 18-4. Device-Specific Settings and Ranges for the Al Group Config VI

Group Channel Scan List
Default Default

Device Setting Range Setting Range
Most Windows Devices 0 0<n<15 all channels 0<n<15
Most Macintosh Devices 0 0<n<15 all channels 0<n<15
AT-MIO-64F-5 0 0<n<l15 all channels 0<n<63
AT-MIO-64E-1*
Lab-PC+, PCI-1200, 0 0<n<15 all channels 0<n<7
DAQCard-1200
Lab-LC, Lab-NB 0 0<n<15 all channels 0<n<7
NB-A2000, NB-A2150 0 0=<n<l15 all channels 0=n<3
NB-A2100 0 0<n<15 all channels 0,1
5102 Devices 0 0<n<l15 all channels 0,1
PCI-4452, PCI-4451 0 0<n<l15 all channels 0,1
PCI-4452, PCI-4552 0 0<n<15 all channels 0<n<3

* The valid channels for the AT-MIO-64E-1 in Differential Mode are 0-7, 16-23, 34-39, 48-55.

Note The Lab-LC, Lab-NB, Lab-PC+, PCI-1200, PC-LPM-16, DAQCard-500,
DAQCard-700, and DAQCard-1200 must scan channel lists containing multiple
channels from channel n (n 2 0) to channel 0 in sequential order, including
all channels between n and 0. The NB-A2000, NB-A2150, EISA-A2000, and
AT-A2150 allow only the following scan lists: (0), (1), (2), (3), (0, 1), (2, 3), and (0,
1, 2, 3). The NB-A2100 allows the following scan lists: (0), (1), (0, 1), and (1, 0).

The channel scan list range shown above is for single-ended mode. Please refer to
Appendix B, DAQ Hardware Capabilities, to determine the valid range for
channels in differential mode.

SCXI modules in multiplexed mode must scan channels in ascending consecutive order,
starting from any channel on the module. The module order you specify can be arbitrary.
SCXI modules in parallel mode must follow the DAQ device restrictions on the order of
channel scan lists. Refer to the Channel, Port, and Counter Addressing section of Chapter 3,
Basic LabVIEW Data Acquisition Concepts, in the LabVIEW Data Acquisition Basics
Manual for information about SCXI channel string syntax.
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Al Hardware Config

Configures either the upper and lower input limits or the range, polarity, and gain.
The AI Hardware Config VI also configures the coupling, input mode, and number of
AMUX-64T devices. The configuration utility determines the default settings for the
parameters of this VI.

tazk |0 Elrd;_qr tazk 10 out
_chan i
ifiput limitz(no change] = ermar oLt

error in [no emor) mr
[~ == —------

You can use this VI to retrieve the current settings by wiring taskID only or by wiring both
taskID and channel list. If channel list is empty, the VI configures channels on a per group
basis. This means that the configuration applies to all the channels in the group. When you
specify one or more channels in channel list, the VI configures channels on a per channel
basis. This means that the configuration applies only to the channels you specify. This VI
always returns the current settings for the entire group.

When the configuration is on a per channel basis, channel list can contain one or more
channels. The channels in channel list must belong to the group named by taskID. You
specify channels the same way you specify them for the Al Group Config VI. If you

take multiple samples of a channel within a scan and you want to change the hardware
configuration for that channel at each sample, you must supply the settings for each instance
of the channel within the scan. If an element of channel list specifies more than one channel,
the corresponding element of the other arrays applies to all those channels.

The VI applies the values contained in the configuration arrays (upper input limits, lower
input limits, coupling, range, polarity, gain, and mode) to the channels in the group (if you
configured on a per group basis) or the channels in channel list (if you configured on a per
channel basis) in the following way. The VI applies the values listed first in the arrays (at
index 0) to the first channel in the group or the channel(s) listed in index O of channel list.
The VI applies the values listed second in the configuration arrays (at index 1) to the second
channel in the group or channel(s) listed in index 1 of channel list. The VI continues to apply
the values in this fashion until the arrays are exhausted. If channels in the group or channel
list remain unconfigured, the VI applies the final values in the arrays to all the remaining
unconfigured channels.

Table 18-5 gives examples of this method. The parameter channel scan list, which is part of
the AI Group Config VI, is used in the following table.
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Table 18-5. Al Hardware Config Channel Configuration

Configuration
Basis Array Values Results
Group Group channel scan list = 1, 3,4, 5, 7| All channels in the group have
channel list is empty input limits of —1.0 to +1.0.
lower input limit [0] =-1.0
upper input limit [0] = +1.0
Group Group channel scan list =1, 3,4, 5, 7| Channel 1 has input limits of
channel list is empty —1.0 to +1.0. Channel 3 has
lower input limit [0] =-1.0 input limits 0.0 to +5.0.
upper input limit [0] = +1.0 Channels 4, 5, and 7 have input
lower input limit [1] = 0.0 limits of —10.0 to +10.0.
upper input limit [1] = +5.0
lower input limit [2] =-10.0
upper input limit [2] = +10.0
Channel Group channel scan list=1, 3,4, 5, 7| Channels 1, 3, 4, and 5 have
channel list [0] =1 input limits of —1.0 to +1.0.
channel list [1] = 3:5 Channel 7 has the default input
lower input limit [0] =-1.0 limits set by the configuration
upper input limit [0] = +1.0 utility. It is unchanged because
it is not listed in channel list.
Channel Group channel scan list = 1, 3,4, 5, 7| Channel 1 has input limits of
channel list [0] = 1 —1.0 to +1.0. Channels 3, 4,
channel list [1] = 3:5 and 5 have input limits of 0.0
lower input limit [0] =-1.0 to +5.0. Channel 7 has the
upper input limit [0] = +1.0 default input limits set by the
lower input limit [1] = 0.0 configuration utility.
upper input limit [1] = +5.0
Group Group channel scan list =0, 1, 0, 1 Channels 0 and 1 have input
channel list is empty limits of —1.0 to +1.0 the first
lower input limit [0] =-1.0 time they are sampled and
upper input limit [0] = +1.0 input limits of —10.0 to +10.0
lower input limit [1] =-1.0 the second time they are
upper input limit [1] = +1.0 sampled.
lower input limit [2] =-10.0
upper input limit [2] = +10.0
lower input limit [3] =-10.0
upper input limit [3] = +10.0

© MNational Instruments Corporation 18-9

LabVIEW Function and VI Reference Manual



Chapter 18

Advanced Analog Input Vis

The range, polarity, and gain determine the lower and upper input limits. When you wire
valid input limit arrays (that is, arrays of lengths greater than zero) the VI chooses suitable
input ranges, polarities, and gains to achieve these input limits. The VI ignores the range,
polarity, and gain arrays.

If you do not wire the input limit arrays, the VI checks range, polarity, and gain. Where the
VI finds an array, it sets the corresponding input property to the values in the array. Where
the VI does not find an array, it leaves the corresponding input property unchanged.

For some devices and SCXI modules, onboard jumpers set range, polarity, and/or gain.
LabVIEW does not alter the settings of jumpered parameters when you specify input limits.
If LabVIEW cannot achieve the desired input limits using the current jumpered settings,

it returns a warning.

To override the current jumper values, you must call the Al Hardware Config VI and specify
range, polarity, and/or gain explicitly. The configuration utility determines the initial setting
for these parameters (the default value is the factory jumper setting).

If a pair of input limits values are both 0, the VI does not change the input limits.

SCXI channel hardware configurations are actually a combination of SCXI module and
DAAQ device settings and require special considerations. The way you specify channels
indicates whether LabVIEW alters the SCXI module settings and/or the DAQ device settings.
The input limits parameter always applies to the entire acquisition path.

When you configure on a per group basis, LabVIEW may alter both SCXI module and
DAQ device settings. In this case, gain applies to the entire path and is the product of the
SCXI channel gain and acquisition device channel gain. LabVIEW sets the highest gain
needed on the SCXI module, then adds DAQ device gain if necessary.

When configuration is on a per channel basis, you can specify the channels in one of three
ways. The first way is to specify the entire path, as in the following example.

OBO!SC1!MD1!CHO:7

Also, you can specify the path using channel names configured in the DAQ Channel Wizard,
as in the following example.

temperature

If you use either of these methods, LabVIEW can alter both SCXI and DAQ device settings,
and gain applies to the product of the SCXI channel gain and the DAQ device gain. LabVIEW
sets the highest gain needed on the SCXI module, then adds DAQ device gain if necessary.

The second method is to specify the SCXI channel only, as in the following example.

SC1!MD1!CHO:7
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This specification indicates that LabVIEW should alter SCXI settings only. Additionally,
gain applies only to the SCXI channel.

The third way is to specify the acquisition device channel only, as in the following example.

OBO

In this case, LabVIEW alters only DAQ device settings. The gain parameter applies to the
onboard channel only.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel ranges, input limits, and
scanning order available with your DAQ device.

Tables 18-6 through 18-9 list default settings and ranges for the AI Hardware Config VI.

A tilde (~) indicates that the parameter is configurable on a per group basis only. This means
you cannot configure it by channel. The first row of these tables gives the values for most
devices, and the other rows give the values for devices that are exceptions to the rule. If you
did not set the default settings with the configuration utility, use the default settings shown in
these tables.

Tabhle 18-6. Device-Specific Settings and Ranges for the Al Hardware Config VI

Channel Input
Configuration Cluster
Number Channel
Coupling Input Mode ~ of AMUX List

Device DS* R* DS* R* DS* R* DS*
Most Devices 1 1 1 1 <n<3 0 0<n<4 empty
NB-A2000 2 1,2 2 2 0 0 empty
PC-LPM-16, 1 1 2 2 0 0 empty
Lab-LC,
Lab-NB
Lab and 1200 1 1 2 1 <n<3 0 0 empty
Series devices
AT-MIO-16X, 1 1 1 (no ~) 1 <n<3 0 0 <n<4 empty
AT-MIO-64F-5
NB-A2100, 1 1,2 2 2 0 0 empty
NB-A2150
DAQCard-500, 1 1 2 1,2 0 0 empty
DAQCard-516,
DAQCard-700
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Table 18-6. Device-Specific Settings and Ranges for the Al Hardware Config VI (Continued)

Channel Input
Configuration Cluster
Number Channel
Coupling Input Mode ~ of AMUX List

Device DS* R* DS* R* DS* R* DS*
5102 Devices 1 1,2 2 2 0 0 empty
PCI-6110E, 1 1,2 1 1 0 0 empty
PCI-6111E,
PCI-4451,
PCI-4551,
PCI-4452,
PCI-4552

* DS = Default Setting; R = Range

Channels 0 and 1 and channels 2 and 3 must have the same coupling for the
NB-A2150.

= Note

Al Parameter

Configures and retrieves miscellaneous parameters associated with Analog Input of an
operation of a device that are not covered with other Al VlIs.

=tring in

float in

walue in

boolean in
tackID in
channels
operation
parameter name
errorin (no emor)

tack ID out

error out

string out
float out
value out
boolean out
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Al SingleScan
Returns one scan of data. If you started an acquisition with the Al Control VI, this VI
reads one scan of the data from the internal buffer. On the Macintosh and in Windows, the
VI reads from the onboard FIFO if the acquisition is nonbuffered. If you have not started an
acquisition, this VI starts an acquisition, retrieves a scan of data, and then terminates the

acquisition. The group configuration determines the channels the VI sample. This VI does not
support 5102, DSA, and 59xx devices.

r agqQuisition state
task ID Single task I out
cutput type Cscaled ) Scan scaked data
opeode tne changs) — ot “a i binary data
error in (no error) error out
time Timit Cno change) data remaining

If you do not call the AI Control VI, this VI initiates a single scan using the fastest and most
safe channel clock rate. You can, however, alter the channel clock rate with the AI Clock
Config VI.

If you run the AI Control VI with control code set to 0 (Start), a clock signal initiates
the scans.

If you want externally clocked conversions, you must use the AI Clock Config VI to set the
clock source to external.

If clock sources are internal and you do not allocate memory, a timed, nonbuffered acquisition
begins when you run the AI Control VI with control code set to 0. This type of acquisition is
useful for synchronizing analog inputs and outputs in a point-to-point control application.
The following devices do not support timed, nonbuffered acquisitions:

*  (Macintosh) Lab-NB, Lab-LC, NB-A2000, NB-A2100, and NB-A2150

Note In the event of a FIFO overflow during a timed, nonbuffered acquisition,
LabVIEW restarts the device.
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Table 18-7 lists default settings and ranges for the Al SingleScan VI.

Table 18-7. Device-Specific Settings and Ranges for the Al SingleScan VI

Output Type Opcode Time Limit
Device DS R DS R DS R
NB-A2000, NB-A2100, 1 1<n<3 1 1 variable | n=0
NB-A2150
All Other Devices 1 1=n<3 1 1<n<4 1<n<4 n=0
* DS = Default Setting; R = Range
Al Trigger Config
Configures the trigger conditions for starting the scan and channel clocks and the scan
counter.

additional trigger specific...
level (0.00) ———— E
task ID Trigger] task ID out
trigger type (0: no change) - EE_'}% B sctual trigger specificatior
mode (0: no change) ;Lr ] error out
error in (no error)
trigger source Cernpty string)
trigger or pause condition ...

Refer to Appendix B, DAQ Hardware Capabilities, for information on the triggers available
with your DAQ device. Refer to your E Series device user manual for a detailed description
of the triggering capabilities of the device.

The following is a detailed description of trigger types 1 (analog trigger), 2 (digital trigger A),
and 3 (digital trigger B) as they apply to three types of applications: posttrigger, pretrigger
with software start, and pretrigger with hardware start. The other trigger types are discussed
at the end of this section.

Application Type 1: Posttriggered Acquisition (Start Trigger Only)

If total scans to acquire is = 0 and pretrigger scans to acquire is 0, you are performing

a posttriggered acquisition. A trigger type of 1 or 2 (analog trigger or digital trigger A,
respectively) starts the acquisition (digital trigger B is illegal). You provide a start trigger.
Refer to Table 18-10, parts 2 and 3, to determine the default pin to which you connect your
trigger signal. On some devices you can specify an alternative source through the trigger
source parameter.

LabVIEW Function and VI Reference Manual 18-14 © MNational Instruments Corporation



Chapter 18 Advanced Analog Input Vs

With E-Series devices, if you are using an analog trigger and the analog signal is connected
to one of the analog input channels, that channel must be first in the scan list. This restriction
does not apply if you connect the analog signal to PFIO.

! = acquired data —=
o i
o —~
inpu N S NA
signal » N Jr: 1 7
SV T —
5.0 . —

In the above illustration, total scans to acquire is 1000 and pretrigger scans to acquire
is 0. The start trigger can come from digital trigger A or an analog trigger (trigger or pause
condition = 1: Trigger on a rising edge or slope, level = 5. 5, window size = 0. 2).

Application Type 2: Pretriggered Acquisition (For All Trigger Types)

If total scans to acquire and pretrigger scans to acquire are both > 0, a trigger type of 1
or 2 (analog trigger or digital trigger A, respectively) starts the acquisition of posttrigger data
after the pretrigger data is acquired. The trigger is called a stop trigger because the acquisition
does not stop until the trigger occurs. A software strobe starts the acquisition. This is a
software start pretrigger acquisition. You provide the stop trigger. Refer to Table 18-10,
parts 2 and 3, to determine the default pin to which you connect your trigger signal. On some
devices, you can specify an alternative source through the trigger source parameter.

le— acquired data ——|
g0 fﬁ\

. 5.0 | 1

input N AN
signal a0 N i

AV VN~
50 W/

T
1
o AT
I
1

=top |_|
trigger
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In the previous illustration, total scans to acquire is 1000 and pretrigger scans to acquire
is 900. The stop trigger can come from digital trigger A or an analog trigger (trigger or pause
condition = 1: Trigger on rising edge or slope, level = 3. 7, window size = 0. 5).

With E Series devices, if you are using an analog trigger and the analog signal is connected
to an analog input channel, that channel must be the only channel in the scan list (no multiple
channel scan allowed). This restriction does not apply if you connect the analog signal

to PFIO.

Application Type 3: Pretriggered Acquisition (Start and Stop Trigger)

Application Type 3 is used infrequently. Unless you plan to provide both a start trigger and a
stop trigger, skip this section.

On MIO devices, you can enable both the start trigger and the stop trigger. (You must call the
Al Trigger Config VI twice to do this.) In this case, a digital or analog trigger signal starts the
acquisition rather than a software strobe. This is a hardware start pretriggered acquisition.
You provide both the start trigger (as described in Application Type 1) and the stop trigger
(as described in Application Type 2). Refer to Tables 18-11 and 18-12 to determine the
default pin to which you connect your trigger signal. On some devices, you can specify an
alternative source through the trigger source parameter.

E I acquirad data—l—-: |
Ll L;A\\ i
. A AN ;
input r ! NN L
E N \ 7
i "~
30 ! i/ :

I — !
tsllzart |_| :
rigger .
st p rL
Higqer

In the above illustration, total scans to acquire is 1000 and pretrigger scans to acquire

is 900. The start trigger can come from digital trigger B or an analog trigger (trigger or pause
condition = 1 : Trigger on rising edge or slope, level = 5.5, window size = 0. 2). The stop
trigger can come from digital trigger A or an analog trigger (trigger or pause condition=1:
Trigger on rising edge or slope, level = 4.0, window size = 0. 2). Notice that some of the
data after the start trigger has been discarded, because all 900 pretrigger scans have been
collected and the stop trigger is more than 900 scans away from the start trigger.
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When using analog triggering on E Series devices, there are several restrictions that apply, as
shown in Table 18-8.

Table 18-8. Restrictions for Analog Triggering on E-Series Devices

Start Stop
Trigger Trigger Restrictions

Digital A | Digital B None

Digital B | Analog Analog signal must be connected to PFIO, unless you are
scanning only one channel, in which case the input to that
channel can be used.

Analog Digital A | Analog signal must be first in scan list if it is connected to an
analog input channel.

A trigger type of 4 (digital scan clock gating) enables an external TTL signal to gate the scan
clock on and off, effectively pausing and resuming an acquisition.

Channel clock and scan clock are the same on the NB-MIO-16. Therefore, if the scan clock
gate becomes FALSE, the current scan does not complete and the scan clock ceases operation.
When the scan clock gate becomes TRUE, the scan clock immediately begins operation
again, where it left off previously. You wire your signal to the EXTGATE pin.

A trigger type of 5 (analog scan clock gating) enables an external analog signal to gate the
scan clock on and off, effectively pausing and resuming an acquisition. A trigger type of 6
allows you to use the output of the analog trigger circuitry (ATCOUT) as a general purpose
signal. For example, you can use ATCOUT to start an analog output operation, or you can
count the number of analog triggers appearing at ATCOUT.

Note Triggertypes 1, 5, and 6 on E-Series devices use the same analog trigger circuitry.
All three types can be enabled at the same time, but the last one enabled dictates
how the analog trigger circuitry behaves. The E Series restrictions described in the
trigger applications apply to all three trigger types.

Trigger type 5 on E-Series devices uses the digital scan clock gate and the analog trigger
circuitry. Therefore, enabling trigger type 5 overwrites any settings made for trigger type 4.

For some devices, digital triggering is supported, but for these devices the source is
predetermined. Therefore, the trigger source parameter is invalid. Table 18-9 shows the pin
names on the I/O connector to which you should connect your digital trigger signal.

© MNational Instruments Corporation 18-17 LabVIEW Function and VI Reference Manual



Advanced Analog Input Vis

Table 18-9. Digital Trigger Sources for Devices with Fixed Digital Trigger Sources

Posttriggering Pretriggering
Start Start Stop
Device Trigger Pin Trigger Pin Trigger Pin

MIO-16L/H, MIO-16DL/DH STARTTRIG* STARTTRIG* | STOPTRIG
NB-MIO-16L/H STARTTRIG* no support no support
AT-MIO-16X, AT-MIO-16F-5, | EXTTRIG* EXTTRIG* EXTTRIG*
AT-MIO-64F-5
Lab and 1200 Series devices EXTTRIG no support EXTTRIG
PC-LPM-16, DAQCard-500, no support no support no support
DAQCard-700
NB-A2000, NB-A2100, EXTTRIG* no support EXTTRIG*
NB-A2150
DSA 45xx EXTTRIG* EXTTRIG* EXTTRIG*

* On the AT-MIO-16X, AT-MIO-16F-5, and AT-MIO-64F-5, the same pin is used for both the start trigger and the
stop trigger. Refer to your hardware user manual for more details.

Table 18-10 lists the default settings and ranges for the Al Trigger Config VI. The first row
of each table gives the values for most devices, and the other rows give the values for devices
that are exceptions to the rule.
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Table 18-10. Device-Specific Settings and Ranges for the Al Trigger Config VI (Part 1)

Trigger or
Trigger Pause
Type Mode Condition Level
Device DS* R* DS* R* DS* R* DS* R*
Most Devices 2 2,3 1 1<n<3 no support no support
AT-MIO-16E-10, 2 2<n<4 1 1<n<3 1 1,2, no support
AT-MIO-16DE-10, 7,8
AT-MIO-16XE-50,
PCI-MIO-16XE-50
AT-MIO-16E-2, 2 1<n<6 1 1<n<3 1 1<n<8 0 -10
AT-MIO-64E-3, <n<
NEC-MIO-16E-4 10
Lab and 1200 Series 2 2 1 1=<n<3 no support no support
devices
PC-LPM-16, no support no support no support no support
DAQCard-500,
DAQCard-700
NB-A2100, 1 1,2 1 1<n<3 1 1,2 0 -2.828
NB-A2150 <n<
2.828
NB-A2000 1 1,2 1 1<n<3 1 1,2 0 -5.12
<n<
5.12
5102 Devices 1 1,2, 3, 1 1<n<3 1 1,2, 3, 0 -5<n<s
6 4
5911, 5912 1 1,2, 3, 1 1<n<3 1 1,2, 3, 0 -10sn<
6 4 10
DSA Devices 1 1,2,3 1 1<sn<3 1 1<sn<4 0 -42<n<
42
* DS = Default Setting; R = Range
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Table 18-11. Device-Specific Settings and Ranges for the Al Trigger Config VI (Part 2)

Additional Trigger
. Specifications Cluster
Trigger Source
(Analog) Window Size Coupling
Default Default Default
Device Setting Range Setting Range Setting Range

AT-MIO-16E-1 0 0=<n<l1s, 0 0=n<20 no support
AT-MIO-16E-2 PFIO
NEC-MIO-16E-4
PCI-MIO-16E-1
PCI-MIO-16E-1
PCI-MIO-16XE-10
AT-MIO-64E-3 0 0<n<63, 0 0=n<20 no support

PFIO
NB-A2000 0 0<n<3 no support 2 1,2
NB-A2100 0 0<n<3 0 0 <n< 1 1,2
NB-A2150 5.656
5102 Devices 0 1,1, 0 0<n< 10 1 1,2

TRIG
PCI-6110E 0 0<n<4 0 0<n< 80 1 1,2

PFIO
PCI-6111E 0 0<n<?2 0 0<n< 80 1 1,2

PFIO
4451, 4551 0 0,1 0 0<n< 84 no support
4452, 4552 0 O<n<4 0 0<n< 84 no support
All Other Devices no support no support no support
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Table 18-12. Device-Specific Settings and Ranges for the Al Trigger Config VI (Part 3)

Trigger Source (Digital)
Device DS R
E-Series Start Trigger PFIO PFI 0~9, RTSI 0~6, GPCTRO
E-Series Stop Trigger PFI1 PFI 0~9, RTSI 0~6
E-Series Digital Scan Clock Gate PFIO PFI 0~9, RTSI 0~6
5102 Devices with RTSI, Start and Stop PFIO PFI 1-2, RTSI 0-6
Triggers
5102 Devices without RTSI, Start and PFIO PFI1-2
Stop Triggers
5911, 5912 PFI1 PFI 1-2, RTSI 0-6
DSA 44xx Start Trigger PFIO PFI0, PFI1, PFI3, PFI4, PFI6,
RTSI 0~6
OSA 44xx Stop Trigger PFI1 PFIO, PFI1, PFI3, PFI4, PFI6,
RTSI 0~6
DSA 45xx Start and Stop Trigger dedicated PFI 0~33, RTSI 0~6
EXTTRIG*
pin
All Other Devices no support*

* See Table 18-9 for devices with fixed digital trigger sources.
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Table 18-13. Device-Specific Settings and Ranges for the Al Trigger Config VI (Part 4)

Additional Trigger Specifications Cluster

Skip Time
Delay Count Limit
Device DS R DS| R |[DS| R

NB-A2000 0 0<n<655.35 | no support | no support
NB-A2100, NB-A2150S 0 0=n<32.77 | no support | no support
NB-A2150C 0 0<n<16.38 | no support | no support
NB-A2150F 0 0<n<17.05 | no support | no support
All Other Devices no support no support | no support

* DS = Default Setting; R = Range
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This chapter describes the Easy Analog Output VIs in LabVIEW, which
perform simple analog output operations. You can run these VIs from the
front panel or use them as subVIs in basic applications.

You can access the Easy Analog Output VIs by choosing Functions»
Data Acquisition»Analog Output. The Easy Analog Output VIs are the
VIs on the top row of the Analog OQutput palette, as shown below.

E] Analeg Dutput'

—— Easy Analog Output Vis

Easy Analog Output VI Descriptions

The following Easy Analog Output VIs are available.

AO Generate Waveform

Generates a voltage waveform on an analog output channel at the specified update rate.

device

channel [0]

update rate [1000 updates/zec]
vaavefonm

[
HULT FT

The AO Generate Waveform VI generates a multipoint waveform on a specified analog output
channel. If an error occurs, a dialog box appears, giving you the option to stop the VI or

continue.
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AO Generate Waveforms

Generates multiple waveforms on the specified analog output channels at the specified
update rate.

device W
channels [0] ~ &
update rate (1000 updates sec) = Rt
waveforms

If an error occurs, a dialog box appears, giving you the option to stop the VI or continue.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel numbers you can use with
your DAQ device.

A0 Update Channel

Writes a specified value to an analog output channel.

1 Ao
device e
channel (0]~ g , ~
=
valle =

The AO Update Channel VI writes a single update to an analog output channel. If an error
occurs, a dialog box appears, giving you the option to stop the VI or continue.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel numbers and output limits
available with your DAQ device.

AO Update Channels

Writes values to each of the specified analog output channels.

i AN
device e
channels (0]~ g &
=
wvalligs =

The AO Update Channels VI updates multiple analog output channels with single values. If
an error occurs, a dialog box appears, giving you the option to stop the VI or continue.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel numbers you can use with
your DAQ device.

LabVIEW Function and VI Reference Manual 19-2 © MNational Instruments Corporation



Intermediate Analog Output Vis

This chapter describes the Intermediate Analog Output VIs. These VIs
are single VI solutions to common analog output problems. The
intermediate-level VIs are convenient, but they lack flexibility. Because
all the VIs in this chapter rely on the advanced layer, you can refer to
Chapter 22, Advanced Analog Output Vls, for additional information on the
inputs and outputs and how they work.

You can access the Intermediate Analog Output VIs by choosing
Functions»Data Acquisition»Analog Output. The Intermediate Analog
Output VIs are the VIs on the second row of the Analog Output palette, as
shown below.

ED Analog Dutput

A0 AO A0 AO
HULT FT HULT.-{I OME FT || OME P,.-Tw
*ﬁ.‘.ﬂ *:}i':ll EI— -\; - Elm \t_-.:ﬁ
;1] HY A HY RO .
CONFIG| | "wRITE ETART '-.'\.-'FII'IIé:I CLEAR Intermediate
Bl | (B | | B e | [ Bz | | B Analog Output Vis
UTIL k AON
E"“x E"“x

Handling Errors

LabVIEW makes error handling easy with the Intermediate Analog Output
VIs. Each intermediate-level VI has an error in input cluster and an error
out output cluster. The clusters contain a Boolean that indicates whether an
error occurred, the error code for the error, and the name of the VI that
returned the error. If error in indicates an error, the VI returns the error
information in error out and does not continue to run.

I+ Note The AO Clear VI is an exception to this rule—this VI always clears the acquisition
regardless of whether error in indicates an error.
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When you use any of the Intermediate Analog Output VIs in a While Loop,
you should stop the loop if the status in the error out cluster reads TRUE.
If you wire the error cluster to the General Error Handler VI, the VI
deciphers the error information and describes the error to you.

The General Error Handler VI is in Functions»Time and Dialog in
LabVIEW. For more information on this VI, refer to your LabVIEW User
Manual.

Analog Output VI Descriptions

The following Analog Output VIs are available.

AO Clear

Clears the analog output task associated with taskID in.

H A
tazklD in CLEAR tasklD out
error in [no errar] B error out

The AO Clear VI always clears the generation regardless of whether error in indicates
an error.

A0 Config

Configures the channel list and output limits, and allocates a buffer for analog output
operation.

Tirnit zettings (no change) ;
device A taskID

channels (D) w¥f COHFIG L numnber of channels
buffer size (1000 updates) — @y [ ke DSP handle structurs out

[group] (0} error out
error in (no error)
allocate mode

'SP handle structure

Refer to Appendix B, DAQ Hardware Capabilities, for the channel ranges and output limits
available with your DAQ device.
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A0 Start
Starts a buffered analog output operation. This VI sets the update rate and then starts the
generation.
taskiD in [ taskiD out
number(u:-f buffer iteratin}'us (1% e TF'RT L actual update rate
update rate (1000 updatesfsec Ea v
error in (no error) o= 1 error out
clack Cupdate clock 1:1)
clock source Cinternal:1)
A0 Wait

Waits until the waveform generation of the task completes before returning.

tazkID in Al tazkID out

update rake [1000 updates/sec] J__I f,l,é:-

check everny M updates (5] nﬂr‘ i errar oLt

error in [no error)

Use the AO Wait VI to wait for a buffered, finite waveform generation to finish before calling
the AO Clear VI. The AO Wait VI checks the status of the task at regular intervals by calling
the AO Write VI and checking its generation complete output. The AO Wait VI waits
asynchronously between intervals to free the processor for other operations. The VI calculates
the wait interval by dividing the check every N updates input by the update rate. You should
not use the AO Wait VI when you generate data continuously, because the generation never
finishes. The AO Clear VI stops a continuous waveform generation.

AOQ Write
Writes data into the buffer for a buffered analog output operation.
tazklD in tazklD out
zcaled data
ermar in (o errar) 2ror oLt
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This chapter describes the Analog Output Utility VIs. The VIs—

AO Continuous Generation, AO Waveform Generation, and AO Write
One Update—are single-VI solutions to common analog output problems.
The Analog Output Utility VIs are intermediate-level VIs, so they rely on
the advanced-level VIs. You can refer to Chapter 22, Advanced Analog
Output VlIs, for additional information on the inputs and outputs and how
they work.

You can access the Analog Output Ultilities palette by choosing
Functions»Data Acquisition»Analog Output»Analog Output Utilities.
The icon that you must select to access the Analog Output Utility VIs is
on the bottom row of the Analog Output palette, as shown below.

ED Analog Dutput |

A Al H
HULT FT || HULT FT || @ME FT || OME FT

Analog Output Utility VIs

Handling Errors

LabVIEW makes error handling easy with the intermediate-level Analog
Output Utility VIs. Each intermediate-level VI has an error in input cluster
and an error out output cluster. The clusters contain a Boolean that
indicates whether an error occurred, the error code for the error, and the
name of the VI that returned the error. If error in indicates an error, the VI
returns the error information in error out and does not continue to run.
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When you use any of the Analog Output Utility VIs in a While Loop, you
should stop the loop if the status in the error out cluster reads TRUE. If

you wire the error cluster to the General Error Handler VI, the VI deciphers
the error information and describes the error to you.

The General Error Handler VI is in Functions» Utilities in LabVIEW.
For more information on this VI, refer to Chapter 10, Time, Dialog, and
Error Functions.

Analog Output Utility VI Descriptions

The following Analog Output Utility VIs are available.

AO Continuous Gen

Generates a continuous, timed, circular-buffered waveform for the given output channels at
the specified update rate. The VI updates the output buffer continuously as it generates the

data. If you simply want to generate the same data continuously, use the AO Waveform Gen
VI instead.

buffer gize (1000 updates)

device [1] —zl [T
channels [0] =4 o —

update rate (1000 updates/sec] ﬂ“ b arrar out

scaled data

eror in [no error)
iteration [O:initialize]
clear generation (e T] -

m You use the AO Continuous Gen VI when your waveform data resides on

disk and is too large to hold in memory, or when you must create your
waveform in real time. Place the VI in a While Loop and wire the iteration
terminal to the VI iteration input.

iteration
terminal

Note If your program iterates more than 2 31_] times, do not wire this VI iteration
terminal to the loop iteration terminal. Instead, set iteration to 0 on the first loop,
then to any positive value on all other iterations. The VI reconfigures and restarts
if iteration < 0.

Also wire the condition that terminates the loop to the VI's clear acquisition input, inverting
the signal if necessary so that it is TRUE on the last iteration. On iteration 0, the VI calls the
AO Config VI to configure the channel group and hardware and to allocate a buffer for the

data. It also calls the AO Write VI to write the given data into the buffer, and then the AO Start
VI to set the update rate and start the signal generation. On each subsequent iteration, the VI
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calls the AO Write VI to write the next portion of data into the buffer at the current write
position. On the last iteration (when clear generation is TRUE) or if an error occurs, the VI
also calls the AO Clear VI to clear any generation in progress. Although it is not normally
necessary, you can call the AO Continuous Gen VI outside of a loop (that is, to call it only
once). But if you do, leave the iteration and clear generation inputs unwired.

The first call to the AO Write VI sets allow regeneration to TRUE, so that the same data can
be generated more than once. If you change allow regeneration to FALSE, you must write
new data fast enough that new data is always available to be generated. If you do not fill the
buffer fast enough, you get a regeneration error. To correct this problem, decrease the update
rate, increase the buffer size, increase the amount of data written each time, or write data
more often.

If you set allow regeneration to FALSE, and your device has an analog output FIFO, your
buffer size must be at least twice as big as your FIFO.

If an error occurs, the VI calls the AO Clear VI to clear any generation in progress, then
passes the unmodified error information to error out. If an error occurs inside the AO
Continuous Gen VI, the AO Clear VI clears any generation in progress and passes its
error information out.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel ranges and output limits
available with your DAQ device.

Note The AO Continuous Gen VI uses an uninitialized shift register as local memory to
remember the taskID of the output operation between calls. You normally use this
VI in one place on a diagram, but if you use it in more than one place, the multiple
instances of the VI share the same taskID. All calls to this VI configure, write
data, or clear the same generation. Occasionally, you may want to use this VI
in multiple places on the diagram but have each instance refer to a different
taskID (for example, when you want to generate waveforms with two devices
simultaneously). Save a copy of this VI with a new name (for example,
AO Continuous Gen R) and make your new VI reentrant.
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AO Waveform Gen

Generates a timed, simple-buffered or circular-buffered waveform for the given output
channels at the specified update rate. Unless you perform indefinite generation, the VI returns
control to the LabVIEW diagram only when the generation completes.

device —— w1
update rate (1000 upuates.ﬂsénj — )

m If you place this VI in a loop to generate multiple waveforms with the same
iteration group of channels, wire the iteration terminal to the VI iteration input.
terminal

Note If your program iterates more than 2313 times, do not wire this VI iteration

terminal to the loop iteration terminal. Instead, set the iteration value to 0 on the
first loop, then to any positive value on all other iterations. The VI reconfigures
and restarts if iteration < 0.

On iteration 0, the VI calls the AO Config VI to configure the channel group and hardware
and to allocate a buffer for the data. On each iteration, the VI calls the AO Write VI to write
the data into the buffer, then the AO Start VI to set the update rate and start the generation. If
you call the AO Waveform Gen VI only once, you can leave iteration unwired. The iteration
parameter defaults to 0, which tells the VI to configure the device before starting the
waveform generation.

If an error occurs, the VI calls the AO Clear VI to clear any generation in progress, then passes
the error information unmodified through error out. If an error occurs inside the AO
Waveform Gen VI, it clears any generation in progress and passes its error information out.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel ranges, output limits, and
scanning order available with your DAQ device.

= Note The AO Waveform Gen VI uses an uninitialized shift register as local memory to
remember the taskID of the output operation between calls. You normally use this
VI in one place on your diagram, but if you use it in multiple places, all instances
of the VI share the same taskID. All calls to this VI configure, write data, or clear
the same generation. Occasionally, you may want to use this VI in multiple places
on the diagram, but have each instance refer to a different taskID. Save a copy of
this VI with a new name (for example, AO Waveform Gen R) and make the new
VI reentrant.
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AQ Write One Update

Writes a single value to each of the specified analog output channels.

device [1] —ﬂfﬁpl:
channels [0] =4 =
zcaled data 1 ermar ot
2rrar in [ho ermar]
m The AO Write One Update VI performs an immediate, untimed update of

a group of one or more channels. If you place the VI in a loop to write more

Itteerﬁtilr?; than one value to the same group of channels, wire the iteration terminal to
the VI iteration input.
Note If your program iterates more than 2 31_g times, do not wire this VI iteration

terminal to the loop iteration terminal. Instead, set the iteration value to 0 on the
first loop, then to any positive value on all other iterations. The VI reconfigures
and restarts if iteration <0.

On iteration 0, the VI calls the AO Config VI to configure the channel group and hardware,
then calls the AO Single Update VI to write the voltage to the output channels. On future
iterations, the VI calls only the AO Single Update VI, avoiding unnecessary configuration. If
you call the AO Write One Update VI only once to write a single value to each channel, leave
the iteration input unwired. Its default value of 0 tells the VI to perform the configuration
before writing any data.

Refer to Appendix B, DAQ Hardware Capabilities, for the channel ranges, output limits, and
scanning order available with your DAQ device.

Note The AO Write One Update VI uses an uninitialized shift register as local memory
to remember the taskID for the group of channels when calling between VIs.
Usually, this VI appears in one place on your diagram. However, if you use it
in more than one place, the multiple instances of the VI share the same taskID.
All calls to this VI configure or write data to the same group. If you want to use
this VI in more than one place on your diagram, and want each instance to refer
to a different taskID (for example, to write data with two devices at the same time),
you should save a copy of this VI with a new name (for example, AO Write One
Update R) and make your new VI reentrant.
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This chapter contains reference descriptions of the Advanced Analog
Output VIs. These VIs are the interface to the NI-DAQ software and are the
foundation of the Easy, Utility, and Intermediate Analog Output VIs.

You can access the Advanced Analog Output palette by choosing
Functions»Data Acquisition»Analog Output»Advanced Analog
Output. The icon that you must select to access the Advanced Analog
Output Vs is on the bottom row of the Analog Output palette, as shown
below.

E"U"L.I =t d - Advanced
Analog Output Vis

Advanced Analog Output VI Descriptions

The following Advanced Analog Output VIs are available.

A0 Buffer Config

Allocates memory for an analog output buffer. If you are using interrupts, you can allocate a
series of analog output buffers and assign them to a group by calling the AO Buffer Config
VI multiple times. Each buffer can have its own size. If you are using DMA, you may allocate
only one buffer.
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Use the number you assign to the buffer with this VI when you need to refer to this buffer for

other VIs.

'SP handle

task ID Config| task ID out
channel list ok .}Hl — DEP handle out
number of updates — __ == error out

error in (no error)

allocate mode

buffer nurmber
A0 Buffer Write

Writes analog output data to buffers created by the AO Buffer Config VI.

ey

tazk D Uk ite tazk 10 ot
-] j\" .

=R arror out

zcaled data [empty]
errar in (o ermar] mr‘ ‘

You wire the new data to one of three inputs—scaled data, binary data, or DSP memory
handle. The VI searches these inputs in that order for the first array with a length greater than
zero. The VI then writes the data from this array to the output buffer. The length of the scaled
data or binary data arrays determines the number of updates the VI writes. If DSP memory
handle points to the source of the data, updates to write must indicate how many updates the
Vlis to write. When no data is wired, this VI is still useful for reporting update progress
information.

The total number of updates written to a buffer before you start it can be less than the number
of updates you allocated the buffer to hold when you called the AO Buffer Config VI.
LabVIEW generates only the updates written to the buffer.
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A0 Clock Config

Configures an update or interval clock for analog output.

clock source specifization

config rade [0 no change)
alternate rate set (no change) = |

tazk IO Clock task 1D oot
buffer nurmber (-1 : no change) — ':"""f"g LE Boactual rates used
.J errar out

clock (0: no change:l
error in [no errar) mr:
ticks per second [-1:noch...
clock source [0 no change)

Refer to Appendix B, DAQ Hardware Capabilities, for the clocks available with your
DAQ device.

You can express clock rates three ways—with ticks per second, seconds per tick, or the three
timebase parameters. The VI searches these parameters in that order and expresses clock rates
on the first parameter with a wired valid input. When you configure an update clock, one tick
equals one update. When you configure the interval clock, one tick equals one interval.

AO Control
Starts, pauses, resumes, and clears analog output tasks.
task ID Can- task ID out
control code ———— irm
ztaging list error out

error in (no errur]
iterations Q

pauzeSresume channel list

A0 Group Config

Assigns a list of analog output channels to a group number and produces the taskID that all
the other analog output VIs use.

device ur'wP task ID out
q:hnfug

gr o ~ — Jroup size
LR
t:hannel Tis ﬁ;::j error out
error in (no error)

Refer to Appendix B, DAQ Hardware Capabilities, for the channels available with your
DAQ device.
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AOQ Hardware Config

Configures the limits (polarity and reference) and whether data for a given channel is

expressed in volts milliamperes if you are using channel numbers. This VI always returns the
current settings for all the channels in the group.

task ID

channel list 2

channel type

error in (no error) e
Timit settings e

task ID out
ig EEEERacgrrent hardware settings

oo arror out

Refer to Appendix B, DAQ Hardware Capabilities, for the channel ranges, and output limits
available with your DAQ device.

AO Parameter

Sets miscellaneous parameters associated with the Analog Output operation of the devices
that are not covered with other Analog Output VlIs.

float in
walue in
boolean in .
tazsk ID in [ETw— tack ID out
channels
parameter name —| /BT error oul
ermor in (no ermor]

A0 Single Update
Performs an immediate update of the channels in the group.
task [0 Sngle tazk 1D out
T Update | .
g5
galed array [emply] ’"'H S——F="==== grror out
error in [no ermor|

A0 Trigger and Gate Config (Windows)

Configures the trigger and gate conditions for analog output operations on E-Series devices
and 5411 devices.

tazk |D Trigger tazk |0 out
trigger or gate source [0; ... Gontig

trigger or gate condition ... B e
&frar in [t errar)
trigger or gake =ource zpe...

erar out
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This chapter describes the Easy Digital I/O VIs, which perform simple
digital I/O operations. You can run these VIs from the front panel or use

them as subVIs in basic applications.

Access the Easy Digital I/O VIs by choosing Functions»Data
Acquisition»Digital I/0.

! Digital 1/0
vre_|[eie |[oIs |[oIe
LIME || FORT [|LINME || PORT | < Easy Digital /0 Vs

B || B B | (B
(3] DIO oI DIn [}

GONFIG| | RERD || WRITE || START || whiT
e 2| | i B | B [ aonn | | B

010 |[oIo 1 LU
CLEAR || r#w ER,
nhis E i

The Easy Digital I/O VIs are the VIs on the top row of the Digital I/O
palette. For examples of how to use the Easy Digital I/O VIs, open the
example library by opening examples\dag\digital\digital.llb.

Easy Digital 1/0 Descriptions

The following Easy Digital I/Os are available.

Read from Digital Line
Reads the logical state of a digital line on a digital channel that you configure.

. '
device n1E lite state
digital channel —
d B

ine ="

If an error occurs, a dialog box appears, giving you the option to stop the VI or continue.
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% Note When you call this VI on a digital 1/0 port that is part of an 8255 PPI when your
iteration terminal is left at 0, the 8255 PPI goes through a configuration phase,
where all the ports within the same PPI chip get reset to logic low, regardless of
the data direction. The data direction on other ports, however, is maintained. To
avoid this effect, connect a value other than 0 to the iteration terminal once you
have configured the desired ports.

Read from Digital Port

Reads a digital channel that you configure.

-

| (1]
device pre pattern

digital channel ~"" B

T

If an error occurs, a dialog box appears, giving you the option to stop the VI or continue.

= Note When you call this VI on a digital I/0O port that is part of an 8255 PPI when your
iteration terminal is left at 0, the 8255 PPI goes through a configuration phase,
where all the ports within the same PPI chip get reset to logic low, regardless of
the data direction. To avoid this effect, connect a value other than 0 to the iteration
terminal once you have configured the desired ports.

Write to Digital Line

Sets the output logic state of a digital line to high or low on a digital channel that you specify.

device

digital channel ~*
line —

If an error occurs, a dialog box appears, giving you the option to stop the VI or continue.

Note When you call this VI on a digital I/0 port that is part of an 8255 PPI when your
iteration terminal is left at 0, the 8255 PPI goes through a configuration phase,
where all the ports within the same PPI chip get reset to logic low, regardless of
the data direction. The data direction on other ports, however, is maintained. To
avoid this effect, connect a value other than 0 to the iteration terminal once you
have configured the desired ports.
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Write to Digital Port

Outputs a decimal pattern to a digital channel that you specify.

device

digital channel """ g+ -
pattern —— ==

If an error occurs, a dialog box appears, giving you the option to stop the VI or continue.

Note When you call this VI on a digital I/O port that is part of an 8255 PPI when your
iteration terminal is left at 0, the 8255 PPI goes through a configuration phase,
where all the ports within the same PPI chip get reset to logic low, regardless of
the data direction. The data direction on other ports, however, is maintained. To
avoid this effect, connect a value other than 0 to the iteration terminal once you
have configured the desired ports.
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This chapter describes the Intermediate Digital I/O VIs. These VIs are
single VI solutions to common digital problems.

For example, the DIO Single Read/Write VI is a single VI solution for
non-buffered digital reads and writes. The DIO Single Read/Write VI
works with any device with digital ports.

You combine the other VIs—DIO Config, DIO Start, DIO Read,

DIO Write, DIO Wait, and DIO Clear—to build more demanding
applications using buffered digital reads and writes. Your device must
support handshaking to use these VIs.

All the VIs described in this chapter are built from the fundamental building
block layer, the advanced-level VIs.

You can access the Intermediate Digital I/O VIs by choosing Functions»
Data Acquisition»Digital I/O. The Intermediate Digital I/O VIs are the
VIs on the second and third rows of the Digital palette, as shown below.

ES! Digital 1/0

DI DIc DIe DI
LIME FOET LIME POET

B | | B | B | B

010 DI DI [31] DIo i
GONFIG | READ || WRITE || STRRT || wAIT Qﬁg%a\tﬁs
;uﬁ n.ru+ "J'Ln.l' mr? /’ 9

pIo0 | loIo 1 AOM

cLERR || B Er,
S| | S
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Handling Errors

LabVIEW makes error handling easy with the Intermediate Digital I/O VIs.
Each intermediate-level VI has an error in input cluster and an error out
output cluster. The clusters contain a Boolean that indicates whether an
error occurred, the error code for the error, and the name of the VI that
returned the error. If error in indicates an error, the VI returns the error
information in error out and does not continue to run.

Note The DIO Clear VI is an exception to this rule—this VI always clears the
acquisition regardless of whether error in indicates an error.

When you use any of the Intermediate Digital I/O VIs in a While Loop, you
should stop the loop if the status in the error out cluster reads TRUE. If you
wire the error cluster to the General Error Handler VI, the VI deciphers the
error information and describes the error to you.

The General Error Handler VI is in Functions»Time and Function in
LabVIEW. For more information on this VI, refer to Chapter 10,
Time, Dialog, and Error Functions.

Intermediate Digital I/0 VI Descriptions

The following Intermediate Digital I/O VIs are available.

DIO Clear
Calls the Digital Group Buffer Control VI to halt a transfer and clear the group.

taskll in —{ -[iog — taskID out
error in (no error) o g8 error out
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DIO0 Config
The DIO Config VI calls the advanced Digital Group Config VI to assign a list of ports to the
group, establish the group's direction, and produce the taskID. The VI then calls the Digital
Mode Config VI to establish the handshake parameters, which only affect the operation of the
DIO-32 devices. Finally, the VI calls the Digital Buffer Config VI to allocate a buffer to hold
the scans as they are read or the updates to be written.

# of zcans fupdates( 10007

device ] taskiD
group —oaan COHFIG
—

port lis vl ] =l
group direction —|_£ r===error out

error in (no error)
handshaking mode paraneters o

Refer to Appendix B, DAQ Hardware Capabilities, for the ports and directions available with
your DAQ device.

DIO Read

Calls the Digital Buffer Read VI to read data from the internal transfer buffer and returns the
data read in pattern.

taskID in g taskID out
rumber of scans to read - e L port data
n.ru i

errar in (o errar) mﬂm “‘L_ ermar oLt

DIO Single Read/Write
Reads or writes digital data to the digital channels specified in the digital channel list. This
single VI configures and transfers data. When you use this VI in a loop, wire the iteration
counter to the iteration input so that configuration takes place only once.

device oIo 1 zcans read
R4l

digital channel lizt 'j— _._%_,-_I -

group direction
operation code E Ean error out
Er1ar in (o error]

updates to write
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DIO Start

Starts a buffered digital I/O operation. This VI calls the Digital Clock Config VI to set the
clock rate if the internal clock produces the handshake signals, and then starts the data transfer
by calling the Digital Buffer Control VI.

taskiD in ]
number of scansfupdates to __. _I——' SIER
handshake zource | = "-"-’"' error out
clock frequency
error in (no error)

taskID oud

DIO Wait

Waits until the digital buffered input or output operation completes before returning.

For input, the VI detects completion when the acquisition state returned by the Digital Buffer
Read VI finishes with or without backlog. For output, the VI detects completion when the
generation complete indicator of the DIO Write VI is TRUE.

tazkID out

i [0
tazkID in y o

-
f Binn error oLt

EIror in [no error)

Refer to Appendix B, DAQ Hardware Capabilities, for the handshake modes available with
your DAQ device.

DIO Write

Calls the Digital Buffer Write VI to write to the internal transfer buffer.

(Macintosh) You must fill the buffer with data before you use the DIO Start VI to begin the
digital output operation. You can call the DIO Write VI after the transfer begins to retrieve
status information.

tazkID in BIT tazkID out

digital data I hm—

Iﬂ "“'L errar aut
error in [no emor)
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This chapter describes the Advanced Digital I/O VIs, which include the
digital port and digital group VIs. You use the digital port VIs for
immediate reads and writes to digital lines and ports. You use the digital
group VIs for immediate, handshaked, or clocked I/O for multiple ports.
These VIs are the interface to the NI-DAQ software and the foundation of
the Easy and Intermediate Digital I/O VlIs.

You can access the Advanced Digital I/O palette by choosing
Functions»Data Acquisition»Digital I/O»Advanced Digital 1/0.
The icon that you must select to access the Advanced Digital I/O VIs
is on the bottom row of the Digital I/O palette, as shown below.

5! Digital 170

DI DI DI DI
LIME FORT LIME POET

B | B B | (B

10 iin |[oin ] I
COHFIG| | READ || “'RITE || 2TART WHIE)
| |t B | | e | (B

15[ ag Do o Vis
| ’
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Digital Port VI Descriptions

The digital port VIs perform immediate digital reads and writes only.

DIO Port Config

Establishes a digital channel configuration. You can use the taskID that this VI returns only

in digital port VIs.

device Port
Config

digital channel ey

error in [ho error)
i direction map

tazk |0 oot

error ot

Refer to Appendix B, DAQ Hardware Capabilities, for the ports and directions available with

your DAQ device.

DIO Port Read

Reads the digital channel identified by taskID and returns the pattern read in pattern.

task ID Fort task ID out
Tine mask — Fead — pattern
ILIL T[]
error in (no error) =] error out

DIO Port Write

Writes the value in pattern to the digital port identified by taskID.

task ID

pattern —

Tine rmask —___|

error in (no error) R

Paort
Write

(L] T[T
[ =]

task ID out

oo arror out
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escriptions

Chapter 25 Advanced Digital I/0 Vs

The digital group VIs perform immediate, handshaked, or clocked digital 1/O.

Digital Buffer Config

Allocates memory for a digital input or output buffer.

time Tirnit

port data

task ID Euffer task ID out
¥ of scansfupdates —[Config
allocation rode —I ere B error out
error in (no error)
Digital Buffer Control
Starts an input or output operation.
tazk ID Buffer task ID out
" cuntrl:lﬂ code _.—_'_Eﬁ..".:.l.
of scans fupdates =
error in (no error) =i error out
data overwrite /regen.
Digital Buffer Read
Returns digital input data from the internal data buffer.
task ID Euffer task Il out
nurnber to read ) B mark locations
read location ==l ' | L — number read

error in (no error)

error out
=zan backlog

Digital Buffer Write

Writes digital output data to the buffer created by the Digital Buffer Config VI. The write
always begins at the write mark. After a write, the write mark points to the update following
the last update written.

task 1D EBuffer task 1D out
digital data =r——=1"%'rite
wirite location o elgh update progress
= error out

error in (no error)
time Timit

=]

(Macintosh) Fill the buffer with data before you use the Digital Buffer Control VI to begin the
digital output operation. You can call the Digital Buffer Write VI after the transfer begins to
retrieve status information.
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The total number of updates written to a buffer before you start it can be less than the number
of updates you allocated the buffer to hold when you called the Digital Buffer Config VI.
The VI generates only the updates written to the buffer.

Digital Clock Config
Configures a DIO-32 device to produce handshake signals based on the output of a clock for
timed digital I/O.

task D Cloch tazk D out
_—|Config

1o 10[S]) o e

. E be= error aut
error in [no emor|

Refer to Appendix B, DAQ Hardware Capabilities, for the clocks available with your
DAQ device.

The following example illustrates how to use the three timebase parameters to specify a clock
rate. Assume these parameters have the following settings:

timebase source: 1
timebase signal: 1,000,000.0 Hz
timebase divisor: 25

In this case, the ticks per second rate is 1,000,000.0 divided by 25, so LabVIEW updates the
digital group 40,000 times per second.

Digital Group Config

Defines a digital input or output group. You can use the taskID this VI returns only in the
digital group Vls.

device Group tazk 1D out
T Config i

digital channel list fiﬂ“"
error in [no error)

group direction

T

errar out

Refer to Appendix B, DAQ Hardware Capabilities, for the ports and directions available with
your DAQ device.

15 Note The same digital channel cannot belong to two different groups. If you configure
a group to use a specified digital channel, that digital channel must be one that is
not already defined in another group or you will get an error.
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MIO devices (except for the AT-MIO-16D and the AT-MIO-16DE-10), as well as the
NB-TIO-10, LPM devices, DAQCard-500, 516 devices, DAQCard-700, PC-TIO-10,
AO-2DC devices, PC-OPDIO-16, and AT-AO-6/10, do not allow handshaking. The digital
port VIs are more appropriate for these devices. Handshaking is not allowed if digital
channel list is composed of channel names. The AT-MIO-16D and AT-MIO-16DE-10 do not
allow handshaking if digital channel list includes ports 0,
do not allow handshaking if digital channel list includes ports 2, 5, 8, and/or 11. The DIO-24
and Lab and 1200 Series devices do not allow handshaking if digital channel list includes
port 2. The DIO-32F allows handshaking for the following configurations only:

* A group containing any one port
* A group containing ports 0 and 1, or ports 2 and 3, in

e A group containing ports 0, 1, 2, and 3, in that order

Digital Mode Config

Chapter 25 Advanced Digital I/0 Vls

1, and/or 4. The DIO-96 devices

that order

Configures the handshaking characteristics for DIO-32 devices.

11
tazk |0 Made
Contfig

tazk 10 aut

(L B o
f = eror out
erar in (o erar)

Refer to Appendix B, DAQ Hardware Capabilities, for the handshake modes available with

your DAQ device.

DIO Parameter

Configures and retrieves miscellaneous parameters associated with digital input and output

that are not configured by other DIO VIs.

task |10 in I-'.aram

operation J_|m!°l§m
parameter name

error in (o errar)

tashk 1D out

error out
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Table 25-1 lists device specific parameters and legal ranges for devices.

Table 25-1. Device Specific Parameters and Legal Ranges for Devices

Parameter Setting Input/Output Legal Default
Device Name Support Possible You Should Use Values Value

VXI-DIO-128 0: Input Port per input yes channels, floatin, | N/A N/A

Logic port float out

Threshold
DAQ-DIO-653 1: ACK/Req per group yes taskID in, value Off, On N/A
(DIO- 32HS) Exchange in, value out

2: Clock per group yes taskID in, value Off, On N/A

Reverse in, value out

Digital Single Read
Reads the digital channels that belong to the group identified by taskID and returns the
patterns read.

index array ————
tazk 1D Grou task |0 out

T Fca

L
10013 (L]
f =) 1 pattern list
2rrar in [ho ermar] errar oLk

Digital Single Write
Writes the data in pattern array to the digital channels that belong to the group identified by
taskID.

index array ———
tazk [D Group tazk 1D out
T Write

|
taralal ol
pattern Iistf = fil —

error in [no error)

errar out
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Digital Trigger Config
Configures the trigger condition for starting and/or stopping a digital pattern generation
operation. This VI is only valid when the Digital Clock Config VI has its handshake source
parameter set to 1 or 4 (internal or external pattern generation with external clock).

W
tazk ID Trigger task D out
trigger type [0 no changel < IEE_"' 3
mode (0 no change) f =

error in (o error)

arror ot
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This chapter describes the Easy Counter VIs that perform simple counting
operations. You can run these VIs from the front panel or use them as
subVlIs in basic applications.

You can access the Easy Counter VIs by choosing Functions»
Data Acquisition»Counter. The Easy Counter VIs are the VIs on the top
row of the Counter palette.

I+l Counter
o 1=]
FULSE| [PULSE | [FRE
|I C T"Rf'j_# BEERA | Easy Counter Vls
4w [[annt)] nd ([ ——
IHT B RO
S, Se,

This chapter describes the high-level VIs for programming counters on the
MIO, TIO, and other devices with the DAQ-STC or Am9513 counter/timer
chips. These VIs call the Intermediate Counter VIs to generate a single
delayed TTL pulse, a finite or continuous train of pulses, and to measure
the frequency, pulse width, or period of a TTL signal.

Note These VIs do not work with Lab and 1200 Series devices, DAQCards, and other
devices that have the 8253/54 chip. Use the intermediate-level ICTR Control for
those devices. Refer to Chapter 27, Intermediate Counter VlIs, for more
information on the ICTR Control VI.

Some of these VIs use other counters in addition to the one specified.

In this case, a logically adjacent counter is chosen, which is referred to as
counter+1 when it is the adjacent, logically higher counter and counter-1
when it is the adjacent, logically lower counter.

For a device with the Am9513 chip, if the counter is 1, then counter+1 is
counter 2 and counter—1 is counter 5.
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See the Adjacent Counters VI described in Chapter 27, Intermediate
Counter VlIs, for more information.

For examples of how to use the Easy Counter VIs, open the example
libraries located in examples\dag\counter.

Easy Counter VI Descriptions

The following Easy Counter VIs are available.

Count Events or Time

Configures one or two counters to count external events or elapsed time. An external event is
a high or low signal transition on the specified SOURCE pin of the counter.

source edge [rising 10)
event source timebase (coun__.
devrice

count

counter -4
counter size (16Ff24-bits:0)

startfrestart (F: no) -
stop (F: no) -

L zeconds since start
seconds since last call

To count events, set event source/timebase to 0.0 and connect the signal you want to count
to the SOURCE pin of the counter. To count time, set this control to the timebase frequency

you want to use.

Generate Delayed Pulse

Configures and starts a counter to generate a single pulse with the specified delay and pulse
width on the counter’s OUT pin. A single pulse consists of a delay phase (phase 1), followed
by a pulse phase (phase 2), and then a return to the phase 1 level. If an internal timebase is

chosen, the VI selects the highest resolution timebase for the counter to achieve the desired
characteristics. If an external timebase signal is chosen, the user indicates the delay and width
as cycles of that signal. Execute the Counter Start VI with this VI’s taskID to generate another
pulse. You can optionally gate or trigger the pulse with a signal on the counter’s GATE pin.

timebaze source Cinternal:0)
gate mode (ungated 01 ————
device FLLSE [taskiD]
counter «F Wl L [actual delay (s or cycles)]
pulse palarity Chigh:0) E] [actual width (s or cycles)]
pulse delay (5 or cycles)
pulse width (5 or cycles)
LabVIEW Function and VI Reference Manual 26-2
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Generate Pulse Train
Configures the specified counter to generate a continuous pulse train on the counter’s OUT
pin, or to generate a finite-length pulse train using the specified counter and an adjacent
counter. The signal has the prescribed frequency, duty cycle, and polarity. Each cycle of the
pulse train consists of a delay phase (phase 1) followed by a pulse phase (phase 2).

gate mode (ungated 0]
pulse polarity Chigh 00 ———— |

device %Hlﬁle [taskID of counter ]
t wnf . -
coun _er u "_ﬁl [taskID of counter-1]
number of pulses (cont:0) — - actual parameters
frequency (Hz) —

duty cycle (0.5)

This VI uses only the specified counter to generates a continuous pulse. For a finite-length
pulse, the VI also uses counter—1 to generate a minimum-delayed pulse to gate counter.
To generate another pulse train, execute the intermediate Counter Start VI with the taskIDs
supplied by this VI. To stop a continuous pulse train, execute the intermediate Counter Stop
VI or execute this counter again to generate one, short pulse. You must externally wire
counter—1’s OUT pin to counter’s GATE pin for a finite-length pulse train. You can
optionally gate or trigger the start of the train with a signal on counter—1’s GATE pin.

15 ote pulse train consists of a series of delayed pulses, where phase 1 or the first phase
Not A pul, ] ] ] delayed pul h hase 1 or th h
of each pulse is the inactive state of the output (low for a high pulse) and the
phase 2 of the second phase is the pulse itself.

Measure Frequency

Measures the frequency of a TTL signal on the specified counter’s SOURCE pin by counting
positive edges of the signal during a specified period of time. In addition to this connection,
you must wire counter’s GATE pin to the OUT pin of counter—1. This VI is useful for
relatively high frequency signals, when many cycles of the signal occur during the timing
period. Use the Measure Pulse Width or Period VI for relatively low frequency signals. Keep
in mind that period(s) = 1/frequency (Hz).

counter-1 gate modefungated O] 1 B [actual parameters
device FRE% frequency (Hz)
counter - AR byalid?

gate width (5) S I T ===“Em!-:nthe-r' status

counter size (16/24-bit:0)
[rnascirnunn delay to gate (5.0,
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This VI configures the specified counter and counter+1 (optional for Am9513) as event
counters to count rising edges of the signal on counter’s SOURCE pin. The VI also configures
counter-1 to generate a minimum-delayed pulse to gate the event counter, starts the event
counter and then the gate counter, waits the expected gate period, and then reads the gate
counter until its output state is low. Next the VI reads the event counter and computes the
signal frequency (number of events/actual gate pulse width) and stops the counters. You
can optionally gate or trigger the operation with a signal on counter—1’s GATE pin.

Measure Pulse Width or Period

Measures the pulse width (length of time a signal is high or low) or period (length of time
between adjacent rising or falling edges) of a TTL signal connected to counter’s GATE pin.
The method used gates an internal timebase clock with the signal being measured. This VI is
useful in measuring the period or frequency (1/period) of relatively low frequency signals,
when many timebase cycles occur during the gate. Use the Measure Frequency VI to measure
the period or frequency of relatively high frequency signals.

tirme Tirit Coomputed:-1) 11 count
device pulse width/period (5]
FULSE _
counter -~ Erion [, - walid?
type of measurement e ounker owverflow ?

timebase (1M Hz) l { tirmeout - -

The VI iterates until a valid measurement, timeout, or counter overflow occurs. A valid
measurement exists when count = 4 without a counter overflow. If counter overflow occurs,
lower timebase. If you start a pulse width measurement during the phase you want to
measure, you get an incorrect low measurement. Therefore, make sure the pulse does not
occur until after counter is started. This restriction does not apply to period measurements.
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This chapter describes Intermediate Counter VIs you can use to program
counters on MIO, TIO, and other devices with the DAQ-STC or Am9513
counter chips. These VIs call the Advanced Counter VIs to configure the
counters for common operations and to start, read, and stop the counters.
You can configure these VIs to generate single pulses and continuous pulse
trains, to count events or elapsed time, to divide down a signal, and to
measure pulse width or period. The Easy Counter VIs call the Intermediate
Counter VIs for several pulse generation, counting, and measurement
operations.

This chapter also describes the ICTR Control VI that you use with Lab and
1200 Series and PC-LPM devices that contain the 8253/54 counter/timer
chip.

You can access the Intermediate Counter VIs by choosing Functions»
Data Acquisition»Counter»Intermediate Counter. The Intermediate
Counter VIs are the VIs on the second row of the Counter palette, as shown
below.

i Counter

[ s 2] H—
‘h FULSE ;HLSE 1FIEE3 T
aihn | ot
nf | l—==
ADU

B,

/

Intermediate Counter Vis
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Handling Errors

LabVIEW makes error handling easy with the Intermediate Counter VIs.
Each intermediate-level VI has an error in input cluster and an error out
output cluster. The clusters contain a Boolean that indicates whether an
error occurred, the error code for the error, and the name of the VI that
returned the error. If error in indicates an error, the VI returns the error
information in error out and does not continue to run.

When you use any of the Intermediate Counter VIs in a While Loop, you

should stop the loop if the status in the error out cluster reads TRUE. If you
wire the error cluster to the General Error Handler VI, the VI deciphers the
error information and describes the error to you.

The General Error Handler VI is in Functions»Utilities in LabVIEW.
For more information on this VI, refer to your LabVIEW User Manual.

Intermediate Counter VI Descriptions

The following Intermediate Counter VIs are available.

Adjacent Counters

Identifies the counters logically adjacent to a specified counter of an MIO or TIO device.
It also returns the counter size (number of bits) and the timebases.

tirmmebaszes
| f------cl:-unter

device F counter+1
counter (717) ~F 4 23 ivgounter+1
counter — | E'=1=2"%t:ununte-r—l
counter-1

caunter

counter size (bits)

Devices with the Am9513 chip have one or two sets of five, 16-bit counters (1-5, 6-10) that
can be connected in a circular fashion. For example, the next higher counter to counter 1
(called counter+1) is 2 and the next lower one (called counter-1) is 5.
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Continuous Pulse Generator Config

Configures a counter to generate a continuous TTL pulse train on its OUT pin.

gate riode (ungated 01 ————
device EHIFHS_IEG taskiD

counter H L [actual frequency (Hz)]

41 1

pulse polarity Chigh 0 fﬂﬂm{ % [actual duty cyele]

error in (no error) error out

frequency (Hz)

duty cycle (0.3)

The signal is created by repeatedly decrementing the counter twice, first for the delay to the
pulse (phase 1), then for the pulse itself (phase two). The VI selects the highest resolution
timebase to achieve the desired characteristics. You can optionally gate or trigger the
operation with a signal on the counter’s GATE pin. Call the Counter Start VI to start the pulse
train or to enable it to be gated.

Counter Read
Reads the counter or counters identified by taskID.

taskiD E-:-un;h taskiD
[counter list] sefooeoqRea count
=)
error in (no error) m overflow ?
error out

The VI is designed to read one counter or two concatenated counters of an Am9513 counter
chip or to read one counter of a DAQ-STC counter chip.

Counter Start
Starts the counters identified by taskID.

tazkID E:untter tasklD
[u_:u:uunter lizt] = “1”2 -
errar i [ho enror] s=Fe== error aut

Counter Stop
Stops a count operation immediately or conditionally on an input error.
task ID Spunter task ID
error in (no error) =R | error out

Stl:lp when I:n':'w .T:| ..................... i
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Delayed Pulse Generator Config
Configures a counter to generate a single, delayed TTL pulse on its OUT pin.

timebaze source (internal :0)
gate rmode (ungated 0] ———
device FLLSE task ID
counter - L L [actual delay (s or eycles)]
pulse polarity Chigh:0) f 4 % [actual width (= or eyclesl]
error in (no error) error out
pulse delay (s or cycles)
pulse width (s or cycles)

The signal is created by decrementing counter twice, first for the delay to the pulse (called
phase 1), then for the pulse itself (phase 2). If an internal timebase is chosen, the VI selects
the highest resolution timebase for counter to achieve the desired characteristics. If an
external timebase signal is chosen, the user designates the delay and width as cycles of that
signal. You can optionally gate or trigger the operation with a signal on counter’s GATE pin.
Call the Counter Start VI to start the pulse or enable it to be gated.

Down Counter or Divider Config

Configures the specified counter to count down or divide a signal on the counter’s SOURCE
pin or on an internal timebase signal using a count value called timebase divisor. The result

is that the signal on the counter’s OUT pin is equal to the frequency of the input signal divided
by timebase divisor.

gate mode (ungated:0)
source edge ———

device OH GTR taskiD
counter W%ﬁ
output Chigh pulse :0) f b error out
error in {(no error)

timebase divisor
timebase {counter's SOURCE. ...

You can use this VI to generate finite pulse trains by enabling a continuous pulse generator
until the desired number of pulses has occurred. You can also use it in place of the Continuous
Pulse Generator Config VI to generate a train of strobe or trigger signals.
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Event or Time Counter Config

Configures one or two counters to count edges in the signal on the specified counter’s
SOURCE pin or the number of cycles of a specified internal timebase signal.

count lirnit Ceontinuous:1)
gate rode (ungated 07

dewvice " taskID
counter .

[
counter size (16 /24-bitz:0) 1T
error in [no error) . |

event source Stimebaze [cou...

source edge (Fising :0)

errar out

When the internal timebase is used, this VI works like the Tick Count (ms) function but uses
a hardware counter on the DAQ device with programmable resolution. You can optionally
gate or trigger the operation with a signal on the counter’s GATE pin. Call the Counter Start
VI to start the operation or enable it to be gated.

ICTR Control

Controls counters on devices that use the 8253/54 chip, including:
e Lab and 1200 Series devices, DAQCard-500, and DAQCard-700
¢ (Windows) LPM devices, 516 devices

count
output state ————
device |:I rl.:t RI i val
counter - JGertes read value
5
error out

control code f
error in {no error)
binary ar bod

In setup mode 0, as shown in Figure 27-1, the output becomes low after the mode set
operation, and counter begins to count down while the gate input is high. The output becomes
high when counter reaches the TC (that is, when the counter decreases to 0) and stays high
until you set the selected counter to a different mode.

Cleck I LML MM oo
W L
et | |
® E 5 4 321 0
Output |:n=E»:||
#
& B+EB=n B

Figure 27-1. Setup Mode in ICTR Control
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In setup mode 1, as shown in Figure 27-2, the output becomes low on count following the
leading edge of the gate input and becomes high on TC.

Clack | | | |
L p—
Cratput (h = 4] ] |

Figure 27-2. Setup Mode 1 in ICTR Control

In setup mode 2, as shown in Figure 27-3, the output becomes low for one period of the clock
input. The count indicates the period between output pulses.

Cloge T LML LML LML LML L

Gae g4 3 oz 1 0% 2 1 OM)
Quput = 4] L] L

Figure 27-3. Setup Mode 2 in ICTR Control

In setup mode 3, the output stays high for one-half of the count clock pulses and stays low
for the other half. Refer to Figure 27-4.

Note: Counting is possible

Gae 4 o g oz

4 2 4 & 4 & 4 % 4 onlywhen Gate stays high
Output (h=d) | | [ | ] |
5 4 2 5 25 4 2 5 2 5 4 2
Cuput (= 5) | | I L |

Figure 27-4. Setup Mode 3 in ICTR Control

In setup mode 4, as in Figure 27-5, the output is initially high, and counter begins to count
down while the gate input is high. On TC, the output becomes low for one clock pulse, then
becomes high again.

1373 I I 6 6 6

iR Lh=d]
Gale 43 2 1 0
Crtput

Figure 27-5. Setup Mode 4 in ICTR Control
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Setup mode 5 is similar to mode 4, except that the gate input triggers the count to start.
See Figure 27-6 for an illustration of mode 5.

1= PR I 6 I O
Gare 4 3 21 0
Lea¥], o 1¥] L1

Figure 27-6. Setup Mode 5 in ICTR Control

See the 8253 Programmable Interval Timer data sheet in your lab device user manual for
details on these modes and their associated timing diagrams.

Pulse Width or Period Meas Config

Configures the specified counter to measure the pulse width or period of a TTL signal
connected to its GATE pin.

timebase (Hz) —

device taskiD
_prnnnd FOLSE
counter FeroFs

error out

type of measurement Chigh p... f

error in {no error)

The measurement is done by counting the number of cycles of the specified timebase between
the appropriate starting and ending events. To accurately measure pulse width, the pulse must
occur after counter is started. Call the Counter Start VI to start the operation. You can also
use this VI to measure the frequency of low frequency signals. For more accurate
measurements, use a faster timebase.

Wait+ (ms)

Calls the Wait (ms) function only if no input error exists.

milliseconds to wait rnillisecond timer walue
seconds to wait (unused 0) L zecond timer value
ertar in Cno error) s ertar out

This VI is useful when you want to wait between calls to I/O subVIs that use the error I/O
mechanism; without it you need to use a Sequence Structure to control the execution order.

© MNational Instruments Corporation 27-7 LabVIEW Function and VI Reference Manual



Advanced Counter Vis

This chapter describes the VIs that configure and control hardware
counters. You can use these VIs to generate variable duty cycle square
waves, to count events or time, and to measure periods and frequencies.

You can access the Advanced Counter palette by choosing Functions»
Data Acquisition»Counter»Advanced Counter. The icon that you must
select to access the Advanced Counter VIs is on the bottom row of the
Counter palette, as shown below.

i+l Counter

= =]
s s i

3w _Fh'h"'lf'n_."t._.—.

INT p AOU
B, Br, | o Advanced Counter Vls
Note Use only the inputs that you need on each VI when working with data acquisition.

Leave the rest of the inputs unwired, and LabVIEW sets them to their default
values. In the Help window, the most important terminals are labeled in bold, and

the least commonly used are in brackets. Values given in parentheses are default
values.

The following lists the type of counter chips that your device must have to
work with your version of LabVIEW:

*  DAQ-STC Counter Chip
*  Am9513 Counter Chip
*  8253/54 Counter Chip
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The ICTRControl VIis the only VI that works with devices that contain the
8253/54 counter chip.

Refer to Table 28-1 for the counter chips used with the various devices.

Table 28-1. Counter Chips and Their Available DAQ Devices

Counter
Chip DAQ Device

Am9513 AT-MIO-16, AT-MIO-16D, AT-MIO-16F-5,
AT-MIO-16X, AT-MIO-64F-5, PC-TIO-10, All AO-2DC
Devices, EISA-A2000, NB-MIO-16, NB-MIO-16X,
NB-DMA-8-G, NB-DMA2800, NB-TIO-10, NB-A2000

DAQ-STC | All E Series Devices, 5102 Devices

8253/54 All Lab and 1200 Series Devices, DAQCard-500,
DAQCard-700, LPM Devices, 516 Devices

Advanced Counter VI Descriptions

The following Advanced Counter VIs are available.

CTR Buffer Config

Allocates memory where LabVIEW stores counter data. The CTR Buffer Config VI also
configures the specified group to perform buffered counter operations instead of the normal
single point operations.

task ID gufﬂgr task ID out
counts per buffer (-1 :no c... - """
error out

CTR Buffer Read
Returns data from the buffer allocated by CTR Buffer Config.

mark locations
acquisition state

task ID Eutfer| task ID out
number to read (-1 : no change) — Fe ad nurnber read
= ;
error in (no error) m binary data

error out

i Tirnit (-1 : h
irne Tirmit £-1: no change) backlog
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% Note Incremental reading from the count buffer is supported. However, circular use of
the buffer is not implemented. Therefore, you must set up a finite buffer. You can
read from the finite buffer as it fills.

CTR Group Config

Collects one or more counters into a group. You can use counter groups containing more than
one counter to start, stop, or read multiple counters simultaneously. DAQ-STC devices do not
currently support multiple counters in the same group.

device Graup task D
_[—Config
colnter list errar out

eIror in [no eror) =-==j=

Table 28-2 contains valid counter numbers for devices supported by this VI.

Table 28-2. Valid Counter Numbers for CTR Group Config Devices

Device Type Valid Numbers
DAQ-STC Devices Oand 1
Am9513 MIO Devices 1,2,and 5
NB-DMA-8-G, NB-DMA2800 1 through 5
PC-TIO-10, NB-TIO-10 1 through 10
EISA-A2000, NB-A2000 2

CTR Mode Config

Configures one or more counters for a designated counter operation and selects the source
signal, gating mode, and output behavior on terminal count (TC).

tazk (D Tads tazk 1D out
ontT1g
=
config mode 4L==L error ouk

timebagze zounce
emar in [ho errar)
imebaze zignal

L
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This VI does not start the counters. Use CTR Control VI with control code 1 (Start) to start
the counters. If you are using a counter for pulse generation, you do not have to call this VI
unless you want to change gate mode or output behavior.

Modes 3, 4, and 6 can be used with or without buffered counting. Mode 7 must be used with
buffered counting. With buffered counting, call the CTR Buffer Config VI before or after the
CTR Mode Config VI and before the CTR Control VI to start the operation, then call the CTR
Buffer Read VI to read the buffered count values. With buffered or unbuffered operations, call
the CTR Control VI to read the most recently acquired, unbuffered count value.

Unless otherwise stated, the following figures show timing and counter values for operations
in which gate mode is set to high-level or rising-edge and source edge is set to rising-edge.

Use mode 1 to reset all the CTR Mode Config VI parameters to their default settings.
This mode overrides any conflicting parameter settings.

Use mode 2 to count transitions of the selected signal and to stop at the first TC. The overflow
status bit is set at TC. Use the CTR Control VI to read the overflow status. This mode is
available only with Am9513 devices. Mode 2 counting is unbuffered. Figure 28-1 shows the
count values you would read with this mode using two gate mode settings (high-level gating
and rising-edge gating).

dtart
Gate +_|—| [
I

sowce LT LT L M _riri_rn r

Counker :QQQLE"E' =2 3 4
Yalue lLow Ll =2 —=3ed —= 5+ G —+ 5+ Gu
“aae

Figure 28-1. Unbuffered Mode 2 and 3 Counting

Use mode 3 to count transitions of the selected signal continuously, rolling over at TC and
then continuing on. Figure 28-1 shows unbuffered mode 3 counting. Figure 28-2 illustrates a
buffered mode 3 operation with rising-edge gating. This buffered operation is available only
with DAQ-STC devices. With buffered mode 3 operation, LabVIEW stores the current count
value into the buffer on each selected edge of the source signal.
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! Cowted ! !
a— Counted Evertts —ate—— E . —alm—— CoynbedEvetds —ad
| werks 1 1

Gate ' [ L |

:

Source

[ I
z 3 4

Buffer

Figure 28-2. Buffered Mode 3 Counting

Use mode 4 with level gating to measure pulse width and with edge gating to measure the
period of the selected gate signal.

Note For the following descriptions of pulse width measurements (modes 4, 6, and 7),
a high pulse is defined simply as the high-level phase of a signal when gate mode
is set to high-level gating. This definition differs from that of a high pulse using
pulse generation (mode 5), which consists of a low-level delay phase followed by a
high-level pulse phase. (Low pulses are similarly defined by switching the words
high and low.)
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To measure pulse width, set gate mode to high or low level. Figure 28-3 shows unbuffered
mode 4 pulse width measurements. You can start an Am9513 counter at any time, and it
measures pulses until you stop it. If you start it in the middle of the pulse you want to measure
(for example, during a high pulse for high-level gating), LabVIEW returns a short count for
that measurement. You must start a DAQ-STC counter only when the signal is in the opposite
polarity from the selected gate level (for example, a low-level phase for high-level gating).
Otherwise, the VI returns error number —10890. With unbuffered counting, the DAQ-STC
stops counting after one measurement. Mode 5 configures the counter for pulse generation.
Use the CTR Pulse Config VI to specify the pulse you want to generate.

Stirt 1 Start 2
I
Gate _I | }_L_| I_l : I_
1 1 1 1 1 1 1 1 1
. 1 1 | | 1 1 1 | 1
Timebase
1 i1 2 | | 1 2 3 a4 1 1 |
1 1 1 1 | 1 | 1
aAmasiz |0 T = = |
1 1 1 1 1 1 1 1
D&-STC ! | amar | | 1 wlg 1 | -
1 1 1 1 1 1 1 1

Figure 28-3. Unbuffered Mode 4 High Pulse Width Measurement

Figure 28-4 shows the buffered mode 4 pulse width measurement, which is available only
with DAQ-STC devices. The measured value is stored into the buffer at the end of each pulse.
See mode 6 for another way to measure pulse width with a DAQ-STC device.

Figure 28-4. Buffered Mode 4 Rising-Edge Pulse Width Measurement

To measure period, set gate mode to rising or falling edge. Figure 28-5 shows unbuffered
mode 4 pulse width measurement.

You may start either an Am9513 or a DAQ-STC counter at any time. The counter begins
counting at the start of the next period. The Am9513 counter measures periods continuously.
With unbuffered counting, the DAQ-STC stops counting after one measurement.
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Start

¢
aate T

N

||mED&SE_II_II_II_II_IL|_IL_II_II_II_|I_II_IL_II_I—I|_

24719513 0 1 w4 ol

DAQ-5TC 0 4 -

Figure 28-5. Unbuffered Mode 4 Rising-Edge Period Measurement

Figure 28-6 shows buffered mode 4 period measurement, which is available only with
DAQ-STC devices. The measured value is stored into the buffer at the end of each period.

Start

Measured Measured . Measired ,
=—— Pefiod ——— =— Period —+ = Pefiod—=
| 1

Source

Buffer

Figure 28-6. Buffered Mode 4 Rising-Edge Pulse Width Measurement

Use mode 5 to configure for pulse generation when you also need to configure gate mode,
output type, or output polarity to non-default values. Otherwise, avoid calling the

CTR Mode Config VI and use only the CTR Pulse Config VI for pulse generation. See the
CTR Pulse Config VI for additional information about this operation.

Use mode 6 with level gating to measure the pulse width of the selected signal. This mode is
available only with DAQ-STC devices. Mode 6 differs from mode 4 in that the measurement
of a high (low) pulse does not begin until the first falling (rising) edge of the signal after you
start the counter. If you use unbuffered counting, the counter continues to measure pulses until
you call the CTR Control VI to read the most recently measured value, at which time the
counter stops. Unbuffered mode 6 counting is illustrated in Figure 28-7.

Start Counter Read
Gae — 1 L] 1 I
i | L
Timebsse M ph MMM UM MUCLEL LR
1 | 1 1
D AG-ETC 0 2 - -

Figure 28-7. Unbuffered Mode 6 High Pulse Width Measurement
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With buffered mode 6 counting, the measured value is stored into the buffer at the end of each
pulse, as illustrated with Figure 28-8. Call the CTR Buffer Read VI to read the values.

Counter B ead
E.‘iart e
: s ad : : [N | :
™ e ! ™ niereal
Gate — | L1 | L1 L |

Figure 28-8. Buffered Mode 6 High Pulse Width Measurement (Count on Rising Edge of Source)

Use mode 7 to measure every phase of the selected signal using buffered counting. This mode
is available only with DAQ-STC devices. The count value is stored in the buffer on each
low-to-high and high-to-low transition. Use the CTR Buffer Read VI to read the values.

To measure period with this mode, sum successive pairs of signals. To measure phase, use
every other value. LabVIEW ignores the value of gate mode with mode 7, which means that
you cannot tell whether the first measurement starts at a rising or falling edge.

Pairs of amows indicate measured semi-periods

Measured | Measured, teasuted __:Measur’ed' heasured | Measured |

'
! Inbaral ! hteral | hteral ! Ibzrval | Inberval | hteral !

Buffer i El i i i i i i
q 88 B i
i i 0 O g 0
Figure 28-9. Buffered Mode 7 Semi-Period Measurement

Table 28-3 shows the legal values and default settings for timebase signal. A value of -1 tells
LabVIEW to use the default settings. When the table says counter, it refers to the counter
being configured. If there are multiple counters, LabVIEW configures each counter
successively.
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Refer to Table 28-3 to determine what is the next higher or lower consecutive counter.

Table 28-3. Adjacent Counters

Device Next Lower Next Higher
Type Counter Counter Counter
Am9513 5 1 2
1 2 3
2 3 4
3 4 5
4 5 1
10 6 7
6 7 8
7 8 9
8 9 10
9 10 6
DAQ-STC : 0 !
0 1 0
CTR Pulse Config

Specifies the parameters for pulse generation. This VI configures the counters but does not
start them. Use the CTR Control VI with control code 1 (Start) to produce the pulse.

Tow Tewvel parameters
duty cycle q
tazk ID

counter list ;.?“““""Co
config rode f 13

error in (no errorl
clock frequency
pulze mode

Pulzc

tazk ID out
actual parameters used
error out

Use this VI to specify the characteristics of your pulses. You can also use the CTR Mode
Config VI to set your desired gate modes, output polarity, and output type. Use the CTR Pulse
Config VI to specify timebase source and timebase signal for pulse generation, because
LabVIEW ignores these values specified in the CTR Mode Config VI.
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CTR Co

Advanced Counter VIs

ntrol

Controls and reads groups of counters. Control operations include starting, stopping, and

setting the output state.

change parameter data seeeeeneoeeee

ermar in [ho errar]

output state ———

tazk |D

counter list of
control code —

et

Contral} tazk 10 out
read value array
= [123
E% overflow state arrayp
error oLt

fout data

output state array

ICTRControl

Controls counters on devices that use the 8253 chip (Lab and 1200 Series devices,

516_devices PC-LPM-16, DAQCard-500, and DAQCard 700).

error in (no error)

count
output state ————
device I CTR |
counter — Cortol read value

S —

i

control code

binary ar bed

error out
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Calibration and
Configuration Vis

This chapter describes the VIs that calibrate specific devices and set and
return configuration information.

This chapter also includes a VI for controlling the RTSI bus, which is a
triggering and timing bus you can use to synchronize, time, and trigger
multiple DAQ devices.

(Windows) There is also a VI you can use to set up data acquisition event
occurrences.

You can calibrate certain DAQ devices with the device-specific VIs, but this
is not always necessary because National Instruments calibrates all devices
at the factory.

You can access the Calibration and Configuration VIs by choosing
Functions»Data Acquisition»Calibration and Configuration as shown

below.
-:.—D:U
SET||IMFO||RESET | Device Setting and
Channel Confiquration Vls
1200 M0 i LPF1&6] [E-Zericq [Calibr . .
Calibr ||Calibr aht:; Calibr |Calibr|| =R [4— Calibration Vls
=M
Raoute Crtrl || MO
Fgmal| [ =" [|Canfig -+ . .
=2|gde Dthﬂr;ﬁ;lhratmn
Index‘ &0 (2] P Configuration Vis
=lll=N=
Ra= dag {0
B AT - SCxl
ET || BET | Cal
e | npa || const
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The following VIs only exist in the DAQ VI Library:

Calibration and Configuration VI Descriptions

A2000 Calibrate
A2000 Configure
A2100 Calibrate
A2100 Config
A2150 Calibrate
A2150 Config

DSP 2200 Calibrate

DSP 2200 Configure

The following Calibration and Configuration VIs are available.

1200 Calibrate

This VI calibrates the gain and offset values for the ADCs and DACs on 1200 Series devices

(i.e., DAQPad-1200, DAQCard-1200, etc.).

LaC1 channel

CrACO channel

device

calibration

save new calibration
EEFROM location

A0 Calibration Cluster

—

1200
I Calibr

r

dewice aut

status

You can perform a new calibration (and optionally save the new calibration constants in one
of four user areas in the onboard EEPROM) or load an existing set of calibration constants by
copying them from their storage location in the onboard EEPROM. LabVIEW automatically
loads the calibration constants stored in the onboard EEPROM load area when LabVIEW

launches or when you reset the device. By default the EEPROM load area contains a copy of

the calibration constants in the factory area
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A2000 Calibrate
Calibrates the NB-A2000 or EISA-A2000 A/D gain and offset values or restores them to the
original factory-set values.

device L2000 device out
sample clock drive I:-:-nﬁg
dither — G status

You can calibrate your NB-A2000 or EISA-A2000 to adjust the accuracy of the readings from
the four analog input channels. LabVIEW automatically loads the stored calibration values
when it launches or when you reset your NB-A2000 or EISA-A2000.

A Warning  This VI is supported only up to NI-DAQ version 4.9.0 and has been removed from
the Calibration and Configuration palette. This VI is still included in the DAQ VI
Library for compatibility only, therefore if you are using NI-DAQ version 5.0 or
later, this VI will return the following message: deviceSupportError. If you
wish to use this VI, please reinstall NI-DAQ version 4.9.0 or an earlier version.

Refer to Appendix B, DAQ Hardware Capabilities, for more information on the NB-A2000
or EISA-A2000 DAQ devices.

ii Warning  Read the calibration chapter in the NB-A2000 or EISA-A2000 User Manual before
using the A2000 Calibrate VI.

If you set save new values to 1, then this VI stores the gain and offset calibration values in
an EEPROM on the NB-A2000 or EISA-A2000 device, which does not lose its data even if
the device loses power. LabVIEW reads these EEPROM values and loads them into the
NB-A2000 or EISA-A2000, you can choose to replace the permanent copies of the gain
and offset EEPROM values and use the new values until the next calibration, even if you
reinitialize the device. You can also choose not to replace the EEPROM values, but to use
the new values until the next calibration or initialization.

For example, if you consistently get inaccurate readings from one or more input channels after
you reset the device, you can calibrate and save the new gain and offset values as permanent
copies in the EEPROM. However, if acquisition results are accurate after initialization but
start to drift after a few hours of device operation when the device temperature increases, you
can calibrate the device at this operating temperature and retain the current EEPROM values
to use after the next initialization.

© MNational Instruments Corporation 29-3 LabVIEW Function and VI Reference Manual



Chapter 29 Calibration and Configuration VIs

A2000 Configure
Configures dithering and whether to drive the SAMPCLK* line for the NB-A2000 or
EISA-A2000.
device L2000 device out
Config

sample clock drive
P dither — status

A Warning  This VI is supported only up to NI-DAQ version 4.9.0 and has been removed from
the Calibration and Configuration palette. This VI is still included in the DAQ VI
Library for compatibility only, therefore if you are using NI-DAQ version 5.0 or
later, this VI will return the following message: deviceSupportError. If you
wish to use this VI, please reinstall NI-DAQ version 4.9.0 or an earlier version.

Refer to Appendix B, DAQ Hardware Capabilities, for more information on the NB-A2000
or EISA-A2000 DAQ devices.

After system startup, LabVIEW configures the NB-A2000 or EISA-A2000 as follows.

¢ sample clock drive = 0: Sample clock signal does not drive SAMPCLK* line.

e dither = 0: Dither disabled.

A2100 Calibrate

Selects the desired calibration reference and performs an offset calibration cycle on the ADCs
on the NB-A2100 or the NB-A2150.

device [ device out
AD group —

reference — | CRAL

status

A Warning  This VI is supported only up to NI-DAQ version 4.9.0 and has been removed from
the Calibration and Configuration palette. This VI is still included in the DAQ VI
Library for compatibility only, therefore if you are using NI-DAQ version 5.0 or
later, this VI will return the following message: deviceSupportError. If you
wish to use this VI, please reinstall NI-DAQ version 4.9.0 or an earlier version.

NI-DAQ driver software calibrates the two A/D channels using the analog input ground as the
reference for each channel when you turn on the computer.
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A2100 Config

Selects the signal source used to provide data to the DACs and lets you configure the external
digital trigger to be shared by data acquisition and waveform generation operations on the
NB-A2100.

device [ — device out
DA source — |
shared trigger —  |CoNFIG

status

A Warning  This VI is supported only up to NI-DAQ version 4.9.0 and has been removed from
the Calibration and Configuration palette. This VI is still included in the DAQ VI
Library for compatibility only, therefore if you are using NI-DAQ version 5.0 or
later, this VI will return the following message: deviceSupportError. If you
wish to use this VI, please reinstall NI-DAQ version 4.9.0 or an earlier version.

If LabVIEW acquires multiple data acquisition frames and generates multiple waveform
cycles with a trigger required at the beginning of each cycle, then the external trigger
recognition synchronizes so that each trigger simultaneously initiates the acquisition of the
next data frame while generating the output of the next waveform cycle.

A2150 Config
Selects whether or not LabVIEW should drive an internally generated trigger to the
NB-A2150 I/O connector. This VI also determines whether LabVIEW should drive the
NB-A2150 sampling clock signal over the RTSI bus to other devices for multiple-device
synchronized data acquisition.

device TR device out

io trigger drive — Bz
master cleck — __|CoNFIG
number of slaves
slave list

status

A Warning  This VI is supported only up to NI-DAQ version 4.9.0 and has been removed from
the Calibration and Configuration palette. This VI is still included in the DAQ VI
Library for compatibility only, therefore if you are using NI-DAQ version 5.0 or
later, this VI will return the following message: deviceSupportError. If you
wish to use this VI, please reinstall NI-DAQ version 4.9.0 or an earlier version.

Enable io trigger drive only if you have executed the RTSI Control VI to receive the
RTSITRIG* signal over the RTSI bus, or if you have enabled the analog level trigger using
the Al Trigger Config VI. In these cases, you can monitor the signal being sent to the A/D
trigger circuitry at the EXTTRIG* line of the I/O connector after starting the acquisition.

A high-to-low edge of the signal triggers the data acquisition.
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The NB-A2150 uses signals over the RTSI bus for sampling clock synchronization between
two or more NB-A2150 devices. The sampling clock synchronization circuitry makes
simultaneous sampling possible on more than four channels using additional NB-A2150
devices. If master clock is 1, slave list should contain the list of devices that accept the
sampling clock from device. After you run A2150 Config with master clock equal to 1 and
number of slaves greater than 0, you cannot use the Al Clock Config to set the scan rate for
devices in slave list until you run A2150 Config again on device with master clock equal to
1 and number of slaves equal to 0.

Note Executing A2150 Config with master clock equal to 1 and number of slaves equal
to 0 deconfigures the devices previously in the slave list and sets them up to use
their own sampling clock signal.

A2150 Calibrate (Macintosh)
Performs offset calibrations on the ADCs of the specified AT-A2150.

device A2150 device out
ADCO reference — |Calibr
ADCT reference —T |

status

A Warning  This VI is supported only up to NI-DAQ version 4.9.0 and has been removed from
the Calibration and Configuration palette. This VI is still included in the DAQ VI
Library for compatibility only, therefore if you are using NI-DAQ version 5.0 or
later, this VI will return the following message: deviceSupportError. If you
wish to use this VI, please reinstall NI-DAQ version 4.9.0 or an earlier version.

Refer to Appendix B, DAQ Hardware Capabilities, for more information on the AT-A2150
DAQ device.

When you launch LabVIEW, or when you reset the AT-A2150, LabVIEW performs an offset
calibration using the analog ground as the reference. Use this VI only for device calibration
to an external reference or for device recalibration for ground reference after using an external
reference.

A0-6/10 Calibrate (Windows)

Loads a set of calibration constants into the calibration DACs or copies a set of calibration
constants from one of four EEPROM areas to EEPROM area 1.

n;af'::fjﬁ Calibr device out
- CIR
EEPROM location =N ctatus
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You can load an existing set of calibration constants into the calibration DACs from a storage
area in the onboard EEPROM. You can copy EEPROM storage areas 2 through 5 to storage
area 1. EEPROM area 5 contains the factory calibration constants. LabVIEW automatically
loads the calibration constants stored in EEPROM area 1 upon start-up or when you reset the
AT-AO-6/10.

Note You can also use the calibration utility provided with the AT-AO-6/10 to perform
a calibration procedure. Refer to the calibration chapter in the AT-AO-6/10 User
Manual for more information.

Refer to Appendix B, DAQ Hardware Capabilities, for more information on the
AT-AO-6/10 DAQ devices.

When LabVIEW initializes the AT-AO-6/10, the DAC calibration constants stored in
EEPROM location 1 (user calibration area 1) provide the gain and offset values that ensure
proper device operation. So, this initialization is the same as running the AO-6/10 Calibrate
VI with operation set to 1 and EEPROM location set to 1. When the AT-AO-6/10 leaves the
factory, EEPROM location 1 contains a copy of the calibration constants stored in
EEPROM location 5 (factory calibration).

A calibration procedure performed in bipolar mode is not valid for unipolar mode and vice
versa. See the calibration chapter of the AT-AO-6/10 User Manual for more information.

Channel To Index

Uses the current group configuration for the specified task to produce a list of indices into the
group’s scan or update list for each channel specified in the channel list.

task ID Ind |' task ID out
channel Tist sof e = channel indices

5
buffer number — [

status

You can use this list of channel indices to locate data for a particular channel within a multiple
channel buffer. You can also use the indices to read or write to a group subset with the buffer
read and write VIs.

Refer to your specific device information in Appendix B, DAQ Hardware Capabilities, for
the channel limitations that apply to your device.
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Table 29-1 shows possible values for the channel scan list, channel list, and channel indices
parameters. Table 29-2 shows the possible values for the Sun. The channel scan list

parameter is an input for the group configuration VlIs.

Table 29-1. Channel to Index VI Parameter Examples

channel 1 three times
during a scan.)

Channel Scan List Channel List Channel Indices

1,3,4,5,7 channel list[0] = 5 channel indices[0] = 3.
Data for channel 5 is at position 3
within a scan. Indices are
zero-based.

1,3,4,5,7 channel list is of 0 length. | channel indices is of O length.
(In this case, status is non-zero.)

1,2,1,3,1,4 channel list[0] =1, 1, 1 channel indices[0] = 0,

(The device samples channel indices[1] = 2, and

channel indices[2] = 4.

The first occurrence of channel 1
within a scan is at index 0, the
second at index 2, and the third at
index 4.

0,1,3,4
(For this example,
channel scan list is a

channel list[0] = 3

channel indices[0] = 2.
The eight bits of data from port 3
are at index 2 in the scan list.

digital input group.)

0:3 channel list[0] = amM1!9 channel indices[0] = 9.

(One AMUX-64T Data obtained from channel 9 on
in use.) AMUX-64T device number 1 is at

index 9 in the data buffer.

SC1!'MD1!CHO:7,
SC1!'MD2!CHO0:4

channel list[0] =
SC1!MD2!CH3

channel indices[0] = 11.

Data obtained from channel 3 of
the SCXI module in slot 2 is at
index 11 in the data buffer.
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Table 29-2. Channel to Index VI Parameter Examples for Sun

Channel Scan List Channel List Channel Indices

1,3,4,5,7 channel list[0] = 5 channel indices[0] = 3.
Data for channel 5 is at position 3
within a scan. Indices are

zero-based.
1,3,4,5,7 channel list is of 0 length. | channel indices is of 0 length.
(In this case, status is non-zero.)
1,2,1,3,1,4 channel list[0] =1, 1,1 channel indices[0] = 0,
(The device samples channel indices[1] = 2, and
channel 1 three times channel indices[2] = 4.
during a scan.) The first occurrence of channel 1

within a scan is at index 0, the
second at index 2, and the third at
index 4.

DAQ Occurrence Config (Windows)

Creates occurrences that are set by data acquisition events.

general value B
general value A E—

task ID in task ID out
create/olear — — OCCUr Fence
DAL E".re-n‘t {D error out

error in (no error) s E
channel

lewvel conditions =

A DAQ event can be the completion of an acquisition, the acquisition of a certain number of
scans, an analog signal meeting certain trigger conditions, a periodic event, an aperiodic
(externally driven) event, or a digital pattern match or mismatch. Your VI can sleep while
waiting for an occurrence to be set, freeing your computer to execute other VIs.

When you set the create/clear control to 1 (create) and call the VI, this VI creates an
occurrence. Use the DAQ event control to select the event that sets the occurrence. Wire the
occurrence this VI produces to the Wait on Occurrence function. Anything you wire to the
output of the Wait on Occurrence function does not execute until the occurrence is set. The
occurrence is set each time the event occurs. The occurrence does not clear until you set the
create/clear control to 0 (clear) and call this VI, or call the Device Reset VI for the device.

LabVIEW returns a Not a Refnum file I/O constant along with a non-zero status code if it
cannot create the occurrence.
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For each computer platform, LabVIEW limits the number of occurrences per second that you
can set. Although this limit depends on the speed of your computer, avoid exceeding
500 occurrences per second.

For some of the events, you must perform your operation using interrupts instead of DMA.
Refer to the description of the DAQ event control in this section for more information.

Device Reset
Resets either an entire device or the particular function identified by taskID.

tazk I RESET tazk 10 out
device

device string status

Resetting a taskID function has the same result as calling the control VI for that function with
control code set to clear. When you reset the entire device, LabVIEW clears all tasks and
changes all device settings to their default values.

DSA Calibrate

Use this VI to calibrate your DSA device.

tazkID Calibr tazkID oot
operation ! 0sA

Error out
Error in [Mao Ermar] ====jm

Your device contains calibration D/A converters (calDACs) that fine-tune the analog circuitry.
The calDACs must be programmed (loaded) with certain numbers called calibration
constants. These constants are stored in non-volatile memory (EEPROM) on your device.
To achieve specification accuracy, perform an internal calibration of your device just before
a measurement session but after your computer and the device have been running for at least
15 minutes. Frequent calibration produces the most stable and repeatable measurement
performance.

Before the device is shipped from the factory, an external calibration is performed, and the
EEPROM contains calibration constants that LabVIEW automatically loads into the calDACs
as needed. The value of the onboard reference voltage is also stored in the EEPROM, and this
value is used when you subsequently perform a self-calibration. The calibration constants are
re-calculated and stored in the EEPROM when a self-calibration is performed. When you
perform an external calibration, LabVIEW recalculates the value of the onboard reference
voltage, and then performs a self-calibration. This new onboard reference value is used for all
subsequent self-calibration operations. If a mistake is made when performing an external
calibration, you can restore the board’s factory calibration so that the board is not unusable.
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DSP2200 Calibrate (Windows)

Performs offset calibrations on the analog input and/or analog output of the AT-DSP2200.

device 025 F device out
rode = | zavib

40T reference —

status

A Warning  This VI is supported only up to NI-DAQ version 4.9.0 and has been removed from
the Calibration and Configuration palette. This VI is still included in the DAQ VI
Library for compatibility only, therefore if you are using NI-DAQ version 5.0 or
later, this VI will return the following message: deviceSupportError. If you
wish to use this VI, please reinstall NI-DAQ version 4.9.0 or an earlier version.

Refer to Appendix B, DAQ Hardware Capabilities, for more information on the
AT-DSP2200 DAQ device.

When you launch LabVIEW or reset the AT-DSP2200, LabVIEW performs an offset
calibration on both the analog input and output using analog ground as the reference.

You can use this VI to calibrate the analog input using an external reference or to recalibrate
the AT-DSP2200 to compensate for configuration or environmental changes.

DSP2200 Configure (Windows)

Specifies data translation and demultiplexing operations that the AT-DSP2200 performs on
analog input and output data.

device 0= F device out
aitranslate /| onsig
aotranslate — |
demux

status

A Warning  This VI is supported only up to NI-DAQ version 4.9.0 and has been removed from
the Calibration and Configuration palette. This VI is still included in the DAQ VI
Library for compatibility only, therefore if you are using NI-DAQ version 5.0 or
later, this VI will return the following message: deviceSupportError. If you
wish to use this VI, please reinstall NI-DAQ version 4.9.0 or an earlier version.

Refer to Appendix B, DAQ Hardware Capabilities, for more information on the
AT-DSP2200 DAQ device.

Because software running locally on the AT&T WE DSP32C DSP chip reads data from the
ADCs and writes data to the DACs, you can manipulate the data during these transfers.
When you write analog input data to DSP memory, you can write the data as unscaled 16-bit
integers, unscaled 32C floating-point numbers, or scaled 32C floating-point voltages. You can
use the demux option only when you write analog input data to DSP memory. When you
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enable demux, the device writes data from channel 0 consecutively into DSP memory,
beginning at the start of each buffer, and writes channel 1 data consecutively beginning at the
half-way point of each buffer. When the device writes analog input data to PC memory, it can
write the data as unscaled 16-bit integers, unscaled IEEE single-precision floating-point
numbers, or scaled IEEE single-precision voltages.

If aotranslate is 0, the source data must be in a format suitable for the DACs (16-bit integer
DAC values). If aotranslate is 1 or 3, the source data are DAC values in 32C format in
DSP memory or in IEEE single-precision format in PC memory. If aotranslate is 2 or 4, the
source data are voltages in 32C format in DSP memory or in IEEE single-precision format in
PC memory.

E-Series Calibrate

Use this VI to calibrate your E-Series device and to select a set of calibration constants to be
used by LabVIEW.

task ID E-%erics task I out
aper ation Calibr
calibration constants f error out
error in (no error)
reference valtage

ii Waming  Read the calibration chapter in your device user manual before using the E-Series

Calibrate VI.

Your device contains calibration D/A converters (calDACs) that are used for fine-tuning the
analog circuitry. The calDACs must be programmed (loaded) with certain numbers, called
calibration constants. Those constants are stored in non-volatile memory (EEPROM) on your
device or are maintained by LabVIEW. To achieve specification accuracy, you should perform
an internal calibration of your device just before a measurement session, but after your
computer and the device have been powered on and allowed to warm up for at least

15 minutes. Frequent calibration produces the most stable and repeatable measurement
performance. The device is not harmed in any way if you recalibrate it as often as you like.

Two sets of calibration constants can reside in two areas inside the EEPROM, called load
areas. One set of constants is programmed at the factory, the other is left for the user. One
load area in the EEPROM corresponds to one set of constants. The load area LabVIEW uses
for loading calDACs with calibration constants is called the default load areas. When you get
the device from the factory, the default load area is the area that contains the calibration
constants obtained by calibrating the device in the factory. LabVIEW automatically loads
the relevant calibration constants stored in the load area the first time you call a VI that
requires them.
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Calibration of your E-Series device takes some time. Do not be alarmed if the VI
takes several seconds to execute.

ii Warning When you run this VI with the operation set to self calibrate or external calibrate,

LabVIEW will abort any ongoing operations the device is performing and set all
configurations to their defaults. Therefore, you should run this VI before any
other DAQ VIs or when no other operations are running.

12-Bit E-Series Devices

Connect the positive output of your reference voltage source to the analog input
channel 8.

Connect the negative output of your reference voltage source to the AISENSE line.
Connect DACO line (analog output channel 0) with analog input channel 0.

If your reference voltage source and your computer are floating with respect to each
other, connect the AISENSE line with the AIGND line as well as with the negative output
of your reference voltage source.

16-Bit E-Series Devices

Connect the positive output of your reference voltage source to the analog input
channel 0.

Connect the negative output of your reference voltage source to the analog output
channel 8 (by performing those two connections you supply reference voltage to the
analog input channel 0, which is configured for differential operation.)

If your reference voltage source and your computer are floating with respect to each
other, connect the negative output of your reference voltage source to the AIGND line,
as well as to the analog input channel 8.

Get DAQ Device Information
Returns information about a DAQ device.

I 1

tazk |0 or device INFO bask 1D oot

infarmation type infarmation tring
&Irar in [hio erar] &rror out

Refer to Appendix B, DAQ Hardware Capabilities, for the transfer methods available with
your DAQ device.
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Get SCXI Information

Returns the SCXI chassis configuration information that you set using the configuration
utility or the Set SCXI Information VI.

chassis type
chasziz address

slot information

[ ' — communication mode
status
cornmiahitation path

device string

LPM-16 Calibrate
Calibrates the PC-LPM-16 or PC-LPM-16PnP converter. The calibration calculates the
correct offset voltage for the voltage comparator, adjusts positive linearity and full-scale
errors to less than £0.5 LSB each, and adjusts zero error to less than =1 LSB.

device = device out
Calibr
status

Refer to Appendix B, DAQ Hardware Capabilities, for more information on the PC-LPM-16,
DAQCard-500, or DAQCard-700 device.

Master Slave Config

Configures one device as a master device and any remaining devices as slave devices for
multiple-buffered analog input operations.

MM /E F— Macter TackiD Out
Master TaskID ——(Config
5lave TasklD List ——

— Statux

A Warning  This VI is supported only up to NI-DAQ version 4.9.0 and has been removed from
the Calibration and Configuration palette. This VI is still included in the DAQ VI
Library for compatibility only, therefore if you are using NI-DAQ version 5.0 or
later, this VI will return the following message: deviceSupportError. If you
wish to use this VI, please reinstall NI-DAQ version 4.9.0 or an earlier version.

Makes sure LabVIEW always re-enables the slave devices before the master device in a
multiple-buffer analog input operation. Only the following devices, which support multiple
buffered acquisitions, can use this VI.

e (Macintosh) NB-A2000, NB-A2100, and NB-A2150.
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The master device sends a trigger or clock signal to the slave device(s) to control the slave
device sampling. In a multiple-buffer acquisition, you must enable the slave device before the
master device to make sure the slave device always responds to a master signal. If you enable
the master device first, it can send a signal to the slave devices before they can respond. You
are responsible for the initial startup order. You should always start the master device last. The
Master Slave Configuration VI makes sure LabVIEW arms the master device last for each
subsequent buffer acquired during a multiple-buffer acquisition.

MIO Calibrate (Windows)
Calibrates the AT-MIO-16F-5, AT-MIO-64F-5, and AT-MIO-16X gain and offset values for
the ADCs and the DACs. You can either perform a new calibration or use an existing set of
calibration constants by copying the constants from their storage location in the onboard
EEPROM. You can store several sets of calibration constants. LabVIEW automatically loads
the calibration constants stored in the EEPROM load area during startup or when you reset
the device.

reference location
Dact channel

D ACO channel ]

device 10 device out
calibration —|Calibr| |
save new calibration — ] status

EEPROM location — | |

reference channel
reference voltage

The load area for the AT-MIO-16F-5 is user area 5. The load area for the AT-MIO-64F-5 and
AT-MIO-16X is user area 8.

ii Warning  Read the calibration chapter in your device user manual before using the
MIO Calibrate VI.

Refer to Appendix B, DAQ Hardware Capabilities, for more information on the
AT-MIO-16F-5, AT-MIO-64F-5, and AT-MIO-16X DAQ devices.

5 Note You should always calibrate the ADC and the DACs after you calibrate the internal
reference voltage.

Note If the device takes analog input measurements with the wrong set of calibration
constants loaded, you may get erroneous data.
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MIO Configure (Windows)

Turns dithering on and off. This VI supports the following devices: AT-MIO-16F-5,
AT-MIO-64F-5, all 12-bit E-Series devices, and all 1200 Series devices.

device 10 device oul
dither — |Config
status

Refer to Appendix B, DAQ Hardware Capabilities, for more information on the devices
supported by this VI.

Route Signal

Use this VI to route an internal signal to the specified I/O connector or RTSI bus line, or to
enable clock sharing through the RTSI bus clock line.

Note This VI is supported by E-Series and 54XX Series devices only.
task 1D Fioute task ID out
zignal narne — %
signal source f oo prror out
error in {no error)

RTSI Control

Connects or disconnects trigger and timing signals between DAQ devices along the
Real-Time System Integration (RTSI) bus.

device Crtrl device out
control code — == 1{rigger line usermnap

-
board signal — [‘ﬁ[‘ﬁ status
trigger line

direction

This VI is not supported for E-Series devices. For E-Series devices, multiple RTSI
connections can be set directly in the analog input, analog output, and counter VIs and
used along with the Route Signal VI. Other RTSI connections must be made using the
Route Signal VI.

LabVIEW Function and VI Reference Manual 29-16 © MNational Instruments Corporation



Chapter 29 Calibration and Configuration VIs

Scaling Constant Tuner

Adjusts the scaling constants, which LabVIEW uses to account for offset and non-ideal gain,
to convert analog input binary data to voltage data.

task ID

channel Tist :opecacaq !

binary offsets —F |}
precision voltages
binary readings

task ID out
binary offsets aul
actual gains out
status

For more information on the Scaling Constant Tuner VI, see the Scaling Constant Tuner VI
description in Chapter 30, Signal Conditioning VIs.

SCXI Cal Constants

Calculates calibration constants for the given channel and range or gain using measured
voltage/binary pairs. You can use this VI with any SCXI module.

TE Gain [1.0)

Cal Constant In 1
Volt/ Amp 2
Volt/dmp 1

SCEI Chassis Cluster
Task ID - Task 10 Out

A
Op Code Cal Cal Constant Out 1

Cal Area Lonzt L Cal Canstant Out 2
Range Code ertar out
SCH1 Gain
ertor in [no ertor) soooo
LAl Board Cluster s
Binary 1
Binary 2
Cal Constant In 2

Set DAQ Device Information
Sets the data transfer mode for different types of operations.

task ID SET task ID out
inforrmation type
infarrmation setting error out
error in {no error)

Refer to Appendix B, DAQ Hardware Capabilities, for the transfer methods available with
your DAQ device.
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Set SCXI Information

Sets the SCXI chassis configuration information.

slot inforration =

device string
chas=is type —
chassis address — | |?“|EFI:|

communication mode — |

cornrnunication path

status

Use this VI to override the configuration already set with the configuration utility. You can
use this VI instead of using the configuration utility to enter the chassis configuration
information. If you do not use this VI, the first VI that accesses an SCXI chassis automatically
tries to load information from the configuration file.

Channel Configuration Vls

The following illustration shows the Channel Configurations VIs palette.

=1

GET
MHAMES IMFO

A A
Scale
IMFO

WS

Get DAQ Channel Names
Returns an array of all the channel names in the default configuration file. A corresponding
array of the channels' configured physical units is also returned. Using channel type, you can
chose to retrieve all channels, or only analog input and analog output, or digital I/O channels.

channel lype \ZET channel names
) Wl Rea channel units
eror in [no ermor) 2 e o out

15 Note This VI is specific to computers running NI-DAQ 5.0 or later. LabVIEW returns
an UnsupportedError message if you attempt to run this VI on computers not
running NI-DAQ 5.0 or later.
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Returns configuration information about a channel configured in the DAQ Channel Wizard.

channel name

IMFO

channel name out

infarmation tpe

2Irar in [ho errgr] ===

A

= infarmation string

“"E infarmation wal.ie
error ot

Note This VI is specific to computers running NI-DAQ 5.0 or later. LabVIEW returns
an UnsupportedError message if you attempt to run this VI on computers not
running NI-DAQ 5.0 or later.

Get Scale Information

Returns configuration information about a scale configured in the DAQ Channel Wizard.

zcale name

Scale
INF

[ i ioh
MR | dezcription

zcale name out

ermar in (o errar)

“"Ln zcale bype
efrar ouk
coeffizients 1
coefficients 2

05 Note This VI is specific to computers running NI-DAQ 5.0 or later. LabVIEW returns
an UnsupportedError message if you attempt to run this VI on computers not
running NI-DAQ 5.0 or later.
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This chapter describes the data acquisition Signal Conditioning VIs, which
you use to convert analog input voltages read from resistance temperature
detectors (RTDs), strain gauges, or thermocouples into units of strain or
temperature.

You can edit the conversion formulas used in these VIs or replace them with
your own to meet the specific accuracy requirements of your application. If
you edit or replace the formulas, you should save the new VI in one of your
own directories or folders outside of vi.lib.

You can access the Signal Conditioning VIs by choosing Functions»
Data Acquisition»Signal Conditioning, as shown below.

EI:I Data Acquisition

Signal Conditioning
EK\ g E'\’ g EE:. ' EE:. '
LI
E'.- k(). k
MISG vl ﬁ—u:ﬂﬁignal Conditioning

THER
LIMEAR. ELIFF |_
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Signal Conditioning VI Descriptions

The following Signal Conditioning VIs are available.

Convert RTD Reading

Converts a voltage you read from an RTD into temperature in Celsius.

RTDwvalks Sl RTDtemp
= lc-:-m,l

This VI first finds the RTD resistance by dividing RTDVolts by Iex. The VI then converts the
resistance to temperature using the following solution to the Callendar Van-Dusen equation
for RTDs:

Rt = Ro[1 + At + B2 + C(t — 100)83]

For temperatures above 0° C, the C coefficient is 0, and the preceding equation reduces to a
quadratic equation for which the algorithm implemented in the VI gives the appropriate root.
So, this conversion VI is accurate only for temperatures above 0° C.

Your RTD documentation should give you Ro and the A and B coefficients for the Callendar
Van-Dusen equation. The most common RTDs are 100-Q platinum RTDs that either follow
the European temperature curve (DIN 43760) or the American curve. The following table
gives the values for A and B for the European and American curves.

European Curve (DIN 43760) American Curve
A = 3.90802¢-03 A = 3.9784e-03
B =-5.80195e-07 B =-5.8408¢-07
(a = 0.00385; 0 =1.492) (a = 0.00392; 0 =1.492)

Some RTD documentation gives values for o and 0, from which you can calculate A and B
using the following equations:

A =a(l +8/100)

B = -00/1002
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Convert Strain Gauge Reading

Converts a voltage you read from a strain gauge to units of strain.

Ra(120]

Vea (0.0] W Strain

Bridge Configuration [3:Hal... = ]3ratu
Yes [3.33] S

Yinit [0.0]

The conversion formula the VI uses is based solely on the bridge configuration. Figures 30-1
through 30-3 show the seven bridge configurations you can use and the corresponding
formulas. For all bridge configurations, the VI uses the following formula to obtain Vr:

Vr = (Vsg — Vinit) / Vex

In the circuit diagrams, VOUT is the voltage you measure and pass to the conversion VI as the
Vsg parameter. In the quarter-bridge and half-bridge configurations, R1 and R2 are dummy

resistors that are not directly incorporated into the conversion formula. The SCXI-1121 and
SCXI-1122 modules provide R1 and R2 for a bridge-completion network, if needed.

Refer to your Getting Started with SCXI manual for more information on bridge-completion
networks and voltage excitation.

© MNational Instruments Corporation 30-3 LabVIEW Function and VI Reference Manual



Chapter 30

Signal Conditioning Vs

Figures 30-1 through 30-3 illustrate the bridge-completion networks available.
RL
VvV
Ri Rg (¢)
gl RL
Vex = —@+ WW
R2 rg AL
bridgeConfig = 1 (Qtr Bridge 1)
4V (1 RL )
strain (€) = GF(1+2V) x (1 + _Rg
RL
VVVV
R Rg (¢)
il RL
Vex = —@+ WW
R2 Rg (dummy)
RL
— A
bridgeConfig = 1 (Qtr Bridge II)
N\ . (1 RL )
strain (g) GF (1+2V) + Re
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Figure 30-1. Strain Gauge Bridge Completion Networks (Quarter-Bridge Configuration)
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1

571

Vex

2

?*E

B
e

bridgeConfig = 2 (Half Br|dge )

»’*?

in (g) = — 4V R
Stain (&) = GF [T +v) — 2% (v =1)] (1 * "Ry )
RL
M-
Vex +E _®+ E'

2

bridgeConfig = 3 (Half Bndgell)

. -2V, ( R. )
= £ 1
strain (€) GF X + .
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Figure 30-2. Strain Gauge Bridge Completion Networks (Half-Bridge Configuration)
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bridgeConfig = 4 (Full Bridge I)

strain (g) = _G_\{:r

bridgeConfig = 5 (Full Bridge )
. A
strain (g) = —GF(V 1)

bridgeConfig = 6 (Full Bridge I1l)
. —av,
t =
strain (&) = GE v T =V, v =]

Figure 30-3. Strain Gauge Bridge Completion Networks (Full-Bridge Configuration)

Convert Thermistor Reading
Converts a thermistor voltage into temperature. This VI has two different modes of operation

for voltage-excited and current-excited thermistors.

Type of Excitation 1
THERMT Temperature

Yoltage
[

Voltage Reference — L=
R —— &2

T =n

Excitation Current
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This VI has two modes of operation for use with different types of thermistor circuits.
Figure 30-4 shows how the thermistor can be connected to a voltage reference. This is the
setup used in the SCXI-1303, SCXI-1322, SCXI-1327, and SCXI-1328 terminal blocks,
which use an onboard thermistor for cold-junction compensation.

VREF

Figure 30-4. Circuit Diagram of a Thermistor in a Voltage Divider

Figure 30-5 shows a circuit where the thermistor is excited by a constant current source.
An example of this setup would be the use of the DAQPad-MIO-16XE-50, which provides a
constant current output. The DAQPad-TB-52 has a thermistor for cold-junction sensing.

Figure 30-5. Circuit Diagram of a Thermistor with Current Excitation
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If the thermistor is excited by voltage, the following shows equation relating the thermistor
resistance, R, to the input values:

\%
- u 0 0
Ry =R;

|:VREF - V()[|

If the thermistor is current excited, the equation is

v
R, = -2
IEX

The following equation is the standard formula the VI uses for converting a thermistor
resistance to temperature:

1

Ty = 3
a+b(InRy)+c(inR;)

The values used by this VI for a, b, and ¢ are given below. These values are correct for the
thermistors provided on the SCXI and DAQPad-TB-52 terminal blocks. If you are using a
thermistor with different values for a, b, and c (refer to your thermistor data sheet), you can
edit the VI diagram to use your own a, b, and ¢ values.

a=1295361E-3
b =2.343159E-4
c=1.018703E-7

The VI produces a temperature in degrees Celsius. Therefore, T- = T — 273.15.

Convert Thermocouple Buffer

Converts a voltage buffer read from a thermocouple into a temperature buffer value in degrees
Celsius.

Yoltage Buffer TC LIN Temperature Buffer
CJC Yoltage BLUFF

ThermocoupleType ilﬁ_
CJC Sensor(D)

Convert Thermocouple Reading
Converts a voltage read from a thermocouple into a temperature value in degrees Celsius.

Thermucnl.l.!!‘:lle Yoltage [HEEED Linearized Temperature
C Voltage I '
ThermocoupleType

CJC Sensor[0]
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Scaling Constant Tuner

Adjusts the scaling constants, which LabVIEW uses to account for offset and non-ideal gain,
to convert analog input binary data to voltage data.

task ID s-:a1gr task ID out
channel Tist sgposssaq LONS binary offsets aul
binary offsets — |40 actual gains out
precision voltages status
binary readings

To use this VI correctly, you must first take two analog input readings—a zero offset reading
and a known-voltage reading.

The default binary offset for each channel in the group is 0. To determine the actual binary
offset for a channel path, ground the channel inputs and take a binary reading, or take multiple
binary readings and average them to get fractional LSBs of the offset.

If you use SCXI, ground the inputs of the SCXI channels to measure the offset of the entire
signal path, including both the SCXI module and the DAQ device. The SCXI-1100,
SCXI-1122, and SCXI-1141 modules have an internal switch you can use to ground the
amplifier inputs without actually wiring the terminals to ground. To use this feature, type the
special SCXI string CALGND in your SCXI channel string as described in the Amplifier Offset
section of Chapter 21, Common SCXI Applications, in the LabVIEW Data Acquisition
Basics Manual. Use intermediate or advanced analog input VIs to get binary data instead of
voltage data.

Note If your device supports dithering, you should enable dither on your DAQ device
when you take multiple readings and average them.

LabVIEW assumes the DAQ devices gain settings and SCXI modules are ideal when it scales
binary readings to voltage, unless you use this VI to determine actual gain values for the
channels. Apply a known precision voltage to each channel and take a binary reading, or take
multiple readings from each channel and compute an average binary reading for each channel.
Your precision voltage should be about ten times as accurate as the resolution of your

DAQ device to produce meaningful results. When you wire binary readings, precision
voltages, and binary offsets to this VI, LabVIEW determines the actual gain using the
following formula:

voltage resolution * (binary reading — binary offset)

actual gain = —
precision voltage

In this formula, the voltage resolution value expressed in volts per LSB and is a value that
varies depending on the DAQ device type, the polarity setting, and the input range setting. For
example, the voltage resolution for a PCI-MIO-16E-1 device in bipolar mode with an input
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range of +5 to -5 V is 2.44 mV. The VI returns an array of the actual gain values that the VI
stores for each channel.

Note When you take readings to determine the offset and actual gain, you should use
the same input limits settings and clock rates that you use to measure your input
signals.

LabVIEW uses the following equation to scale binary readings to voltage:

voltage resolution * (binary reading — binary offset)

It =
voltage aain

When you run the AI Group Config VI, it sets the attributes of all the channels in the group
to their defaults, including the binary offset and gain values.

You can wire channel list if you want to adjust the scaling constants for a subset of the
channels in the group. If you leave channel list unwired, the VI adjusts the scaling constants
for all channels in the group. The VI uses the same method as the Al Hardware Config VI to
apply values in the binary offsets, precision voltages, and binary readings input arrays.
That is, if you wired channel list to this VI, the first element (at index 0) of the input arrays
(binary offsets, precision voltages, and binary readings) apply to the channels listed at
index O of channel list. If you leave channel list unwired, the first values of the input arrays
apply to the first channel in the group. The VI applies the values of each input array to
channel list channels or the group in this manner until the VI exhausts the arrays. If channels
in channel list or in the group remain unconfigured, the VI applies the final values in the
arrays to all the remaining unconfigured channels.

If you want to adjust only the channel offsets, and you want to assume the gain settings on the
DAQ device and SCXI modules are ideal, wire only binary offsets and leave precision
voltages and binary readings unwired.

You can also use this VI to retrieve the binary offset and actual gain values for all the channels
in the group by wiring taskID only.

After you use this VI to adjust the scaling constants for a channel path, any analog input VIs
that return voltage data use the adjusted constants for scaling. You can use the Al Group
Config VI to reset the scaling constants for each channel in the group to their default values
(zero offset and ideal gain).
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This VI returns a single scan of temperature data from a list of SCXI channels. The
SCXI Temperature Scan VI uses averaging to reduce 60 Hz and 50 Hz noise, performs
thermocouple linearization, and performs offset compensation for the SCXI-1100 module.

CJC sensor type (IC)
ternperature units (C)
dewicel 1)

channels CobOlzc Irnd1 10030
channel senzor types [Jtc)
channel signal limits (£50C)
errar in Cno error)
iteration

—

S'SEHI
='W

=T =]

readings

error out
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Part i

Instrument I/0 Functions and Vs

Part I11, Instrument I/0 Functions and VIs, describes LabVIEW instrument
drivers and GPIB, serial port, instrument driver template, and VISA VIs
and functions. This part contains the following chapters:

Chapter 31, Introduction to LabVIEW Instrument I/O Vls, introduces
LabVIEW instrument drivers and GPIB, serial port, instrument driver
template, and VISA VIs and functions.

Chapter 32, Instrument Driver Template VIs, describes the Instrument
Driver Template VIs.

Chapter 33, VISA Library Reference, describes the VISA Library
Reference operations and attributes.

Chapter 34, Traditional GPIB Functions, describes the traditional
GPIB functions.

Chapter 35, GPIB 488.2 Functions, describes the IEEE 488.2 (GPIB)
functions.

Chapter 36, Serial Port VIs, describes the VIs for serial port
operations.



Introduction to LabVIEW
Instrument 1/0 Vs

This chapter describes LabVIEW instrument drivers and GPIB, serial port,
instrument driver template, and VISA VIs and functions.

You can find the Instrument Driver VIs in the Functions palette from your
block diagram in LabVIEW. The Instrument Driver Vs are located near the
bottom of the Functions palette.

To access the Instrument I/O palette, choose Functions»Instrument I/0,
as shown in the following illustration.

[ ]
Instrument 1/0
3 4
mel |[22] [[mF
3 O RE (
=
L M 3
M )
k= 3 (d
el [ [I[l
A = )
......
" ﬂ [=] [=] [=] [=]
—— = [0izA) -|$=ah = [EE -
sk Lil
i [=18| §=1E|§ =18

=

Bl
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The Instrument I/0 palette consists of the following subpalettes:

e VISA

e Traditional GPIB
¢ GPIB 488.2

e Serial

You can find helpful information about individual VIs online by using the
LabVIEW Help window (Help»Show Help). When you place the cursor
on a VI icon, the wiring diagram and parameter names for that VI appear
in the Help window. You also can find information for front panel controls
or indicators by placing the cursor over the control or indicator with

the Help window open. For more information on the LabVIEW Help
window, refer to the Getting Help section in Chapter 1, Introduction to

G Programming, of the G Programming Reference Manual.

In addition to the Help window, LabVIEW has more extensive online
information available. To access this information, select Help»Online
Reference. For most block diagram objects, you can select Online
Reference from the object’s pop-up menu to access the online description.
For information about creating your own online reference files, see the
Creating Your Own Help Files section in Chapter 5, Printing and
Documenting VIs, of the G Programming Reference Manual.

Instrument Drivers Overview

A LabVIEW instrument driver is a set of VIs that control a programmable
instrument. Each VI corresponds to a programmatic operation such as
configuring, reading from, writing to, or triggering the instrument.
LabVIEW instrument drivers simplify instrument control and reduce test
program development time by eliminating the need to learn the low-level
programming protocol for each instrument.

The LabVIEW instrument driver library from National Instruments
contains instrument drivers for a variety of programmable instrumentation,
including GPIB, VXI, and serial. If a driver for your instrument is in the
library, you can use it as is to control your instrument. Instrument drivers
are distributed with a block diagram source code, so you can customize
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them for your specific application, if needed. If a driver for your particular
instrument does not exist, try one of the following suggestions:

e Use a driver for a similar instrument. Often similar instruments from
the same manufacturer have similar, if not identical, instrument
drivers.

e Modify the Instrument Driver Template VIs to create a new driver for
your instrument.

¢ Use either the GPIB, VXI, Serial, or VISA I/O libraries provided with
LabVIEW to send and receive commands directly to and from your
instrument.

e Refer to Chapter 7, Getting Started with a LabVIEW Instrument
Driver, in the LabVIEW User Manual for information on how to start
using LabVIEW instrument drivers from National Instruments.

Instrument Driver Distribution

LabVIEW instrument drivers are distributed in a variety of media including
electronically via bulletin board and internet, and on CD-ROM.

You can download the latest versions of the LabVIEW instrument drivers
from one of the National Instruments bulletin boards and, if you have
internet access, you can download the latest instrument driver files from the
National Instrument File Transfer Protocol site. See the Bulletin Board
Support and FTP Support sections of Appendix D, Customer
Communication.

CD-ROM Instrument Driver Distribution

The entire library of LabVIEW instrument drivers is available on
CD-ROM. The instrument driver CD-ROM is available from National
Instruments at no charge.

You can retrieve the latest instrument driver list on a touch-tone phone by
calling the National Instruments automated fax system, Fax-on-Demand, at
(512) 418-1111 or by calling National Instruments.
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Instrument Driver Template Vis

The LabVIEW instrument driver templates are the foundation for all
LabVIEW instrument driver development. The templates have a simple,
flexible structure and a common set of instrument driver VIs that you can
use for driver development. The VIs establish a standard format for all
LabVIEW drivers and each has instructions for modifying it for a particular
instrument.

The LabVIEW instrument driver templates are predefined instrument
driver VIs that perform common operations such as initialization, self-test,
reset, error query, and so on. Instead of developing your own VIs to
accomplish these tasks, you should use the LabVIEW instrument driver
template VIs, which already conform to the LabVIEW standards for
instrument drivers.

Chapter 32, Instrument Driver Template VlIs, provides more information
on the Instrument Driver Template VIs.

Introduction to VISA Library

VISA (Virtual Instrument Software Architecture) is a single interface
library for controlling VXI, GPIB, RS-232, and other types of instruments.
The VISA Library provides a standard set of I/O routines used by all
LabVIEW instrument drivers. Using the VISA functions, you can construct
a single instrument driver VI which controls a particular instrument model
across different I/O interfaces.

An instrument descriptor string is passed to the VISA Open function in
order to select which kind of I/O will be used to communicate with the
instrument. Once the session with the instrument is open, functions such as
VISA Read and VISA Write perform the instrument I/O activities in a
generic manner such that the program is not tied to any specific GPIB or
VXI functions. Such an instrument driver is considered to be interface
independent and can be used as is in different systems.

Instrument drivers that use the VISA functions perform activities specific
to the instrument, not to the communication interface. This creates more
opportunities for using the instrument driver in many diverse situations.

For more information on VISA functions, see Chapter 33, VISA Library
Reference.
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Introduction to GPIB

The General Purpose Interface Bus (GPIB) is a link, or interface system,
through which interconnected electronic devices communicate.

LabVIEW Traditional GPIB Functions

These traditional GPIB functions are compatible with both IEEE 488 and
IEEE 488.2 devices and are sufficient for most applications. For more
complex applications, such as using several devices and more than one
GPIB interface, you can use the GPIB IEE 488.2 functions.

For more information on the LabVIEW Traditional GPIB functions, see
Chapter 34, Traditional GPIB Functions.

GPIB 488.2 Functions

Using GPIB 488.2 functions together with IEEE 488.2-compatible devices
improves the predictability of instrument and software behavior and
lessens programming differences between instruments of different
manufacturers.

The latest revisions of many National Instruments GPIB boards

are fully compatible with the IEEE 488.2 specification for controllers.
The LabVIEW package also contains functions that use IEEE 488.2.

By using these functions, your programming interface will strictly adhere
to the IEEE 488.2 standard for command and data sequences.

The GPIB 488.2 functions contain the same basic functionality as the
traditional GPIB functions, and include the following enhancements and
additions:

*  You specify the GPIB device address with an integer instead of a
string. Further, you specify the bus number with an additional numeric
control, which makes dealing with multiple GPIB interfaces easier.

*  You can determine the GPIB status, error, and/or byte count
immediately from the connector pane of each GPIB 488.2 function.
You no longer need to use the GPIB Status Function to obtain error and
other information.

e The FindLstn function implements the IEEE 488.2 Find All Listeners
protocol. You can use this function at the beginning of an application
to determine which devices are present on the bus without knowing
their addresses.
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e The GPIB Misc function is still available, but it is no longer
necessary in most cases. IEEE 488.2 specifies routines for most
GPIB application needs, which are implemented as functions.
However, you can mix the GPIB Misc function, as well as other
GPIB functions, with the GPIB 488.2 functions if you need to.

e There are GPIB 488.2 functions with low-level as well as high-level
functionality, to suit any GPIB application. You can use the low-level
functions in non-controller situations or when you need additional
flexibility.

e Although you must use an IEEE 488.2-compatible controller with
these functions, they can control both IEEE 488.1 and IEEE 488.2
devices. The GPIB 488.2 functions are divided into five functional
categories: single-device, multiple-device, bus management,
low-level, and general.

Single-Device Functions

The single-device functions perform GPIB I/O and control operations with
a single GPIB device. In general, each function accepts a single-device
address as one of its inputs.

For more information on single-device functions, see Chapter 35,
GPIB 488.2 Functions.

Multiple-Device Functions

The multiple-device functions perform GPIB I/O and control operations
with several GPIB devices at once. In general, each function accepts an
array of addresses as one of its inputs.

For more information on multiple-device functions, see Chapter 35,
GPIB 488.2 Functions.

Bus Management Functions

The bus management functions perform system-wide functions or report
system-wide status.

For more information on bus management functions, see Chapter 35,
GPIB 488.2 Functions.
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Low-Level Functions

The low-level functions let you create a more specific, detailed program
than higher-level functions. You use low-level functions for unusual
situations or for situations requiring additional flexibility.

For more information on low-level functions, see Chapter 35,
GPIB 488.2 Functions.

General Functions

The general functions are useful for special situations.

For more information on general functions, see Chapter 35,
GPIB 488.2 Functions.

Serial Port VI Overview

The serial port VIs configure the serial port of your computer and conduct
I/O using that port.

For more information on serial port functions, see Chapter 36,
Serial Port VIs.
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This chapter describes the Instrument Driver Template VIs. These Vs are
located in examples\instr\insttmpl.1llb.

Instrument Driver Template Vis

Introduction to Instrument Driver Template Vis

The LabVIEW instrument driver templates are the foundation for all
LabVIEW instrument driver development. The templates have a simple,
flexible structure and a common set of instrument driver VIs that you can
use for driver development. The templates establish a standard format for
all LabVIEW drivers and each has instructions for modifying it for a
particular instrument. The LabVIEW instrument driver templates contain
the following 11 predefined template component VIs:

e PREFIX Initialize

¢ PREFIX Initialize (VXI, Reg-based)
*  PREFIX Close

* PREFIX Reset

*  PREFIX Self Test

e PREFIX Error Query

*  PREFIX Error Query (Multiple)

e PREFIX Error Message

*  PREFIX Revision Query

*  PREFIX Message-Based Template
* PREFIX Register-Based Template

The templates contain the following support VIs:
*  PREFIX Utility Clean Up Initialize
*  PREFIX Utility Default Instrument Setup

They also contain PREFIX VI Tree, a VI Example Tree.
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Rather than developing your own VIs to accomplish these tasks, you can
use the LabVIEW instrument driver template VIs, which already conform
to the LabVIEW standards for instrument drivers. The template VIs are
IEEE 488.2-compatible and work with IEEE 488.2 instruments with
minimal modifications. For non-IEEE 488.2 instruments, use the template
VIs as a shell or pattern, which you can modify by substituting your
corresponding instrument-specific commands where applicable. After
modifying the VIs, you have the base-level driver that implements all of the
template instrument driver VIs for your particular instrument.

Additionally, LabVIEW instrument drivers developed from the template
VIs are similar to other instrument drivers in the library. Therefore, you
have a higher level of familiarity and understanding when you work with
multiple instrument drivers.

Instrument Driver Template VI Descriptions

Note

PREFIX Close
All LabVIEW instrument drivers should include a Close VI. The Close V1is the last VI called
when controlling an instrument. It terminates the software connection to the instrument and
deallocates system resources. Additionally, you can choose to place the instrument in an idle
state. For example, if you are developing a switch driver, you can disconnect all switches
when closing the instrument driver.

The following Instrument Driver Template VIs are available.

To develop your own Instrument Driver VI, follow the instructions on the front
panel of the Template VI.

W54 zession FREFIR
LA
Cloze

error in [no ermor)

errar out

PREFIX Error Message

The PREFIX Error Message VI is a template for creating an Error Message VI for your
particular instrument. It translates the error status information returned from a LabVIEW
instrument driver VI to a user-readable string.

., ......................... S tatus
WS4 session [FREFER | dup V154 sezsion
Type aof Dialag [1: OF Mzq) EHWLL Errar Code (0]
erar in (o erar] Erx “"Lm Error Meszage [emphy]
errar out
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PREFIX Error Query, Error Query (Multiple) and Error Message
If an instrument has error query capability, the LabVIEW instrument driver has Error Query
and Error Message VIs. The Error Query VI queries the instrument and returns the
instrument-specific error information. The Error Message VI translates the error status
information returned from a LabVIEW instrument driver VI into a user-readable string.

WS4 sezsion dup W54 seszion

_ FEea E..........im'- Errar
error in [no emor) Ll "““-’“‘Lﬂ Errar Meszzage

efrar out

PREFIX Initialize and PREFIX Initialize (VXI, Reg-based)

The Initialize VI is the first VI called when you are accessing an instrument driver. It
configures the communications interface, manages handles, and sends a default command to
the instrument. Typically, the default setup configures the instrument operation for the rest of
the driver (including turning headers on or off, or using long or short form for queries). After
successful operation, the Initialize VI returns a VISA session that addresses the instrument in
all subsequent instrument driver VIs. The Initialize VI is a template for message-based
instruments while Initialize (VXI, Reg-based) is for register-based instruments.

[nztrument Descriptar [WVE:] W54 zegsion
ID Query [T: Check] -
Reset [T: Rezet] - errar out

Erar in (o erraor)

The VI has an Instrument Descriptor string as an input. Based on the syntax of this input,
the VI configures the I/O interface and generates an instrument handle for all other instrument
driver VIs. The following table shows the grammar for the Instrument Descriptor. Optional
parameters are shown in square brackets ([1).

Interface Syntax

GPIB GPIB[board]::primary address|[::secondary
address] [: : INSTR]

VXI VXI::VXI logical address|[::INSTR]

GPIB-VXI GPIB-VXI[board] [::GPIB-VXI primary address]::VXI
logical address|[::INSTR]

Serial ASRL[board] [::INSTR]
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The GPIB keyword is used with GPIB instruments. The VXI keyword is used for either
embedded or MXIbus controllers. The GPIB-VXI keyword is used for a National Instruments
GPIB-VXI controller.

The following table shows the default values for optional parameters.

Optional Parameter Default Value
board 0
secondary address none
GPIB-VXI primary address 1

Additionally, the Initialize VI can perform selectable ID query and reset operations. In other
words, you can disable the ID query when you are attempting to use the driver with a similar
but different instrument without modifying the driver source code. Also, you can enable or
disable the reset operation. This feature is useful for debugging when resetting would take the
instrument out of the state you were trying to test.

PREFIX Message-Based Template and Register-Based Template

The PREFIX Message-Based and Register-Based Template VIs are the starting point for
developing your own instrument driver VIs. The template VIs have all required instrument
driver controls, and instructions for modification for a particular instrument.

WIS zegzion REFIH | dup 154 seszion
1 Remy
2rrar in [ho ermar] F"— gl errar oLt

PREFIX Register-Based Template

The PREFIX Register-Based Template VI is a template for creating a register-based VI for
your particular instrument.

WISA zegzion HEFIH | dup %154 seszion

| R
2Irar in [ho ermar] sz Tigl] error oLt

PREFIX Reset

All LabVIEW instrument drivers have a Reset VI that places the instrument in a default state.
The default state that the Reset VI places the instrument in should be documented in the help
information for the Reset VI. In an IEEE 488.2 instrument, this VI sends the command string
*RST to the instrument. When you reset the instrument from the Initialize VI, this V1is called.
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Also, you can call the Reset VI separately. If the instrument cannot perform reset, the
Reset VI should return the literal string Reset Not Supported.

WS4 sezsion [FRert dup V154 zeszion
_ Béng
error in [no emor| {Rasat | error out

PREFIX Revision Query

LabVIEW instrument drivers have a Revision Query VI. This VI outputs the following:
e The revision of the instrument driver.

*  The firmware revision of the instrument being used. (If the instrument firmware revision
cannot be queried, the Revision Query VI should return the literal string Firmware
Revision Not Supported.)

WISA sezzion FREFLE dup W54 sezsion
L st Drriver Revision

errar in (o erar] ““‘“’“MF‘“LE [nztr Firmweare Fevizion
errar out

PREFIX Self-Test

If an instrument has self-test capability, the LabVIEW instrument driver should contain a
Self-Test VI to instruct the instrument to perform a self-test and return the result of that
self-test. If the instrument cannot perform a self-test, the Self-Test VI returns the literal string
Self-Test Not Supported.

WISA zezzion FREFIE dup 154 zeszion
_ .........Em‘— Self-Test Ermar
EI1Or it [ho epror) s S Tart “‘Lﬂ Self-Test Responsze

error ot

PREFIX Utility Clean UP Initialize

Closes an open VISA session if there is an error during initialization. This VI should be called
only from the Initialize VI.

WS4 seszion [FREFTE dup 154 zeszion

I

ermar in [ho errar) {CLEAHUF | &rrar oLt
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PREFIX Utility Default Instrument Setup

Sends a default command string to the instrument whenever a new VISA session is opened,
or the instrument is reset. Use this VI as a subVI for the Initialize and Reset VIs.

W54 zession FREFIT dup VIS4, zeszion

&rmar in [ho errar] {DEFAULT | &rrar aut

PREFIX VI Tree

The VI Tree VI is a non-executable VI that shows the functional structure of the instrument
driver. It contains the Getting Started VI, application VIs, and all of the component VIs.
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VISA Library Reference

This chapter describes the VISA Library Reference operations and
attributes.

The following figure shows the VISA palette, which you access by
selecting Functions»Instrument I/O» VISA.
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The

Operations

VISA palette includes the following subpalettes:
Event Handling Functions

High-Level Event Access

Low-Level Registry Access

Serial Functions

This section describes the VISA Library Reference operations.

VISA Library Reference Parameters
Most of the VISA Library operations use the following parameters:

VISA session is a unique logical identifier used to communicate with
aresource. It is created and linked to a resource by the VISA Open
function. It then is used by other VISA functions to access the resource
and its attributes. The dup VISA session is a copy of the VISA session
that is passed out of the VISA functions. By passing the VISA session
in and out of functions, you can simplify dataflow programming by
chaining functions together. This is similar to the dup file refnums used
by the File I/O functions.

VISA session is set to the Instr class by default. You can change the
class type by popping up on the VISA session control in edit mode and
selecting a different class. The following classes currently are
supported:

—  Instr

—  GPIB Instr

—  VXI/GPIB-VXI/VME RBD Instr
—  VXI/GPIB-VXI MBD Instr

—  Serial Instr

— Generic Event

—  Service Request Event

—  Trigger Event

—  VXI Signal Event

—  VXI/VME Interrupt Event

— Resource Manager
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—  PXI Instr
—  VXI/GPIB-VXI/VME MemAcc

Note The Generic Event, Service Request Event, Trigger Event, VXI Signal Event,
VXI/VME Interrupt Event, and Resource Manager classes can only be passed in
as a VISA session with the VISA Close function and the VISA Property Node.

© MNational Instruments Corporation

VISA functions vary in the class of VISA session that can be wired to
them. The valid classes for each function are indicated in the
documentation. For example, the functions on the High Level
Register Access and Low Level Register Access palettes do not
accept VISA sessions of class GPIB Instr or Serial Instr. If you wire
VISA session to a function that does not accept the class of the session,
or if you wire two VISA sessions of differing classes together, your
diagram will be broken and the error will be reported as a Class
Conflict.

error in and error out terminals comprise the error clusters in each
VISA function. An error cluster contains three fields. The status field
is a Boolean that is TRUE when an error occurs and FALSE when no
error occurs. code field is a VISA error code value if an error occurs
during a VISA function. Appendix A, Error Codes, lists the VISA
Reference Library error codes. source field is a string that describes
where the error has occurred. By wiring the error out of each function
to the error in of the next function, the first error condition is recorded
and propagated to the end of the diagram where it is reported in only
one place.
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VISA Operation Descriptions

These functions appear on the main VISA palette. The valid classes for these functions are
Instr (default), GPIB Instr, Serial Instr, VXI/GPIB-VXI/VME RBD Instr, and
VXI/GPIB-VXI MBD Instr.

Note The following Easy VISA VlIs provide a simple interface to the functions they use.
If optimizing performance is important for your application, use the VISA
primitives, also located in this palette.

Easy VISA Find Resources

Finds all the VXI, Serial, and GPIB resources that are available for communication.

gearch (Al Devices) ea firnd list
. I return count
Ermar in (o error] ==—==—={F Eh‘a JR—

Easy VISA Read

Reads data from the resource specified by the resource name. The maximum number of bytes
to be read is determined by the byte count.

resource name

butes ta read [1024) read buffer
tirmeout [10zec] g returr count
== gfrar oLt

&rrar in [hio erar]

Easy VISA Serial Write and Read

Writes a command string to the specified serial device then reads the response data. The read
is terminated when the specified termination character is received or after receiving the
number of bytes specified in the bytes to read parameter, whichever is first. If a termination
character is required for writing to the instrument, it needs to be included in the write buffer
string.

parity [0:nione]
termination char [Oxd =" ..
baud rate [3600] —

_ [esource name r -
wirite: buffer [0 M) Pag S
bytes ta read (1024) R
timeout [10zec]

ermar in (o errar]

data hitz [3]

stap bitz [F: 1 stop Bit] -
flovs contral [0:MNaone]

read return count
read buffer
errar out

L
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Easy VISA Write and Read

Writes a command string to the specified device then reads the response data.

Chapter 33

bytes to read [1024)
resource name
write buffer [10M ]
timeout [10zec)

ermar in [ho erar)

L]

ERSY1 I

read buffer

e | - 1
W winite return count
m_lf read return count
errar out

Easy VISA Write
Writes a command string to the specified device.
resoUICE name [E .
wite buffer ["IDN 7]~ —labeS WIIE Teturm count
Ld=TH errar aut

tirmeaout [10zec)

VISA Library Reference

I
2Iror in [no error)

VISA Assert Trigger
Asserts a software or hardware trigger, depending on the interface type.
VISA seszsion U_:_SRAG dup VIS4 zezzion
protocol [default; 0] -
errar in [ho error) = errar out

VISA Clear
Performs an IEEE 488.1-style clear of the device. For VXI, this is the Word Serial Clear
command; for GPIB systems, this is the Selected Device Clear command. For Serial, this
sends the string *CLS In.

YISA session VES'I-iJR dup V154 sezsion
error in [no error] J‘“ Error out

VISA Close

Closes a specified device session or event object. VISA Close accepts all available classes.
For a listing of available classes, see the VISA Library Reference Parameters section earlier
in this chapter.

YISA session

L5

2Iror in [no error) error out
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VISA Find Resource

Queries the system to locate the devices associated with a specified interface.

expression [*"]

EIT0r in [ error ] s

[ find lizt

E‘g‘a L returmn count
F PR grror Uk

The following tables show the expression parameter descriptions for the VISA Find

Resource VI.

Instrument Resources

Expression

GPIB GPIB[0-9]*::?2*INSTR
VXI VXI?*INSTR
GPIB-VXI GPIB-VXI?*INSTR

GPIB and GPIB-VXI

GPIB?*INSTR

All VXI ?*VXI[0-9]*::?2*INSTR
Serial ASRL[0-9]*::?*INSTR
All ?*INSTR
Memory Resources Expression
VXI VXI?*MEMACC
GPIB-VXI GPIB-VXI?*MEMACC
All VXI ?*VXI[0-9]*::2*MEMACC
All ? *MEMACC
VISA Lock

Establishes locked access to the specified resource.

¥ISA zession

.Es.u dup W54 zeszion
tirmeout (0] - :
fﬂ' eror ouk
ermar in [ho erar)

A
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For more information about VISA locking and shared locking, refer to Chapter 8§,
LabVIEW VISA Tutorial, in the LabVIEW User Manual.

VISA Open

Opens a session to the specified device and returns a session identifier that can be used to call
any other operations of that device.

. .
YISA zession [for class] ] WISA zezzion
resource name [*"] ~f %

i
error in [no eror)

' Joemen grrar Ut

The following table shows the grammar for the address string. Optional string segments are
shown in square brackets ([ 1).

Interface Syntax
VXI VXI[board]::VXI logical address][::INSTR]
GPIB-VXI GPIB-VXI[board]::VXI logical address[::INSTR]
GPIB GPIB|[board]::primary address|::secondary

address] [: : INSTR]

ASRL ASRL[board] [::INSTR]
VXI VXI [board] : :MEMACC
GPIB-VXI GPIB-VXI [board] : :MEMACC

The VXI keyword is used for VXI instruments via either embedded or MXIbus controllers.
The GPIB-VXI keyword is used for a GPIB-VXI controller. The GPIB keyword can be used
to establish communication with a GPIB device. The ASRL keyword is used to establish
communication with an asynchronous serial (such as RS-232) device.

The following table shows the default value for optional string segments.

Optional String Segments Default Value
board 0
secondary address none
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The following table shows examples of address strings.

Address String Description

VXIO::1::INSTR A VXI device at logical address 1 in VXI interface VXIO.

GPIB-VXI::9::INSTR A VXI device at logical address 9 in a GPIB-VXI controlled
system.

GPIB::1::0::INSTR A GPIB device at primary address 1, secondary address 0 in
GPIB interface 0.

ASRL1::INSTR A serial device attached to interface ASRLI1.

VXI::MEMACC Board-level register access to the VXI interface.

GPIB-VXI1::MEMACC Board-level register access to GPIB-VXI interface
number 1.

For the access mode parameter, the value VI_EXCLUSIVE_LOCK (1) is used to acquire an
exclusive lock immediately upon opening a session; if a lock cannot be acquired, the session
is closed and an error is returned.

The value VI_LOAD_CONFIG (4) isused to configure attributes to values specified by some
external configuration utility, such as T&M Explorer (on Windows 95/NT) or VISAconf
(on Windows 3.x, Solaris 2, and HP-UX).

VISA Read

Reads data from a device. Whether the data is transferred synchronously or asynchronously
is platform-dependent.

YISA zession 'u"-'t-lf-'-ﬂ dup 154 zession
byte count (0] - b =, read buffer
2ITar in [ho errgr] === B return cont
error ot
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Reads the service request status from a message-based device. For example, on the

IEEE 488.2 interface, the message is read by polling devices. For other types of interfaces,
a message is sent in response to a service request to retrieve status information. If the status
information is only one byte long, the most significant byte is returned with the zero value.

VISA Status Description

YIS5A session EEI dup %154 session
. S | : shatus
Er1ar in (o erraor] e 2 (O] ermar aut
Retrieves a user-readable string that describes the status code presented in error in.
¥I5A zession LG dup %154 zezsion
) EhL L status description
&rmar in [ho eror) ML e wpror ot

VISA Unlock

Relinquishes the lock previously obtained using the VISA Lock function.

oa |

YISA session ng-f-'-ﬂ dup V154 session
error in [no ermor| J‘“ error out

VISA Write

Writes data to the device. Whether the data is transferred synchronously or asynchronously is

platform-dependent.

¥I5A zeszion [EEE] dup 154, seszion
wirite: buffer [~ ‘at' : return count
errar in [ho errar] B ermar ot
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Event Handling Functions

This section describes the VISA Event Handling functions. Valid classes for these
functions are Instr (default), GPIB Instr, Serial Instr, VXI/GPIB-VXI/VME RBD Instr,
and VXI/GPIB-VXI MBD Instr.

You can find the VISA Event Handling functions in the VISA palette, which you access by
selecting Functions»Instrument I/0» VISA.

[ X

Event Handling

(=] LA L5 A& A4
ERSYIS| | Easvio| | EASY IO :asvlo ERSY |

el |- | e ||

E

mEA |[EA_ | WA 2P 4 3
| ol |c T R [vent
F 0 C Ve D_[l:u
[EE] L5 l-".'.S‘.ﬂ [ (K]
b, ||abon, STE || TRG || 2 [

CLR

R B0 |wEE| | E]| | G| e EE|High W88 |wWea |[wea | (wea
WA |[Wea g [wea ws.a _'i a4 | 4ax || 4o *y
8 = ]

1]
- ?!;:c Low |53 g|[wea g
ROS |4, v

;
g

VISA Disable Event

Disables servicing of an event. This operation prevents new event occurrences from being
queued. However, event occurrences already queued are not lost; use the VISA Discard
Events VI if you want to discard queued events.

¥I5A zession (5] dup V154, seszzion
event tppe - 40
- error oLt

2rar in [ho errar]

VISA Discard Events

Discards all pending occurrences of the specified event types and mechanisms from the
specified session.

YISA zession ([GEE] dup W54 sezsion

event type - RanTS
—l__'ﬁ ermor cluster

errar in [ho errar]
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VISA Enable Event
Enables notification of a specified event.
¥ISA zeszion WHEA dup 154, seszion
event type - o4
f errar aut

ermar in (o errar)

5 Note You must call the VISA Enable Event VI for a given session before using
VISA Wait on Event VL.

VISA Wait On Event
Suspends execution of a thread of application and waits for an event of event type for a time
period not to exceed that specified by timeout. Refer to individual event descriptions for
context definitions. If the specified event type is All Events, the operation waits for any event
that is enabled for the given session.

timeaut (0] ———
YISA session A5 dup VIS4 seszzion
event type 4.7 L event type
event seszion [for class] f 1event FEETION
2Irar in [hio erar] error out
5 Note You must first call the VISA Enable Event VI for the specified session before using

VISA Wait on Event VI.
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High Level Reg

VISA Library Reference

ister Access Functions

This section describes the VISA High Level Register Access functions. Valid classes for these
functions are Instr (default), VXI/GPIB-VXI/VME RBD Instr, VXI/GPIB-VXI MBD Instr,
and VXI/GPIB-VXI/VME MemAcc. To access the VISA High Level Register Access
functions, pop up on the High Level icon on the VISA palette.

B x|
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P | o e
VISA In8 /In16 / In32

Reads 8 bits, 16 bits, or 32 bits of data, respectively, from the specified memory space
(assigned memory base plus offset). These functions do not require VISA Map Address to be
called prior to their invocation.

address space [ATE: 1] ———

¥I5A zession

L5

offset [0] -
ermar in [ho ermar]

[REK]

16

Visa in 16

8
PR

o plrs
Wiga in 32 i

dup Y154 seszzion
L walue
errar ouk

LA5A

LabVIEW Function and VI Reference Manual

33-12

© National Instruments Corporation



Chapter 33 VISA Library Reference

The following table lists the valid entries for specifying address space.

Address Space Value Description
@) Address the A16 address space of the VXI/MXI bus.
2) Address the A24 address space of the VXI/MXI bus.
3) Address the A32 address space of the VXI/MXI bus.
VISA Memory Allocation

Returns an offset into a device’s region that has been allocated for use by the session.

The memory can be allocated on either the device itself or on the computer’s system memory.
If the device to which the given VISA Session refers is located on the local interface card,
the memory can be allocated either on the device itself or on the computer's system memory.
The memory region referenced by offset that is returned from this function can be

accessed with the high-level functions VISA Move In8 / Move In16 / Move In32 and

VISA Move Out8 / Move Outl6 / Move Out32, or it can be mapped using the

VISA MapAddress function.

YIS5A sezsion ] dup VIS4, seszzion
1 . o | .
zize (0] a [ offzet

EIror in [no error) === error out

VISA Memory Free

Frees the memory previously allocated by the VISA Memory Allocation function. If the
specified offset has been mapped using the VISA Map Address function, it must be
unmapped before the memory can be freed.

YISA session (L] dup VIS4 zeszzion
offset (0] - 1l
erar in (o emor] ==t

errar out
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VISA Move In8 / Move In16 / Move In32

Moves a block of data from device memory to local memory in accesses of 8 bits, 16 bits, or
32 bits, respectively. The VISA Move InXX functions use the specified address space to read
8 bits, 16 bits, or 32 bits of data, respectively, from the specified offset. These functions do
not require the VISA Map Address to be called prior to their invocation.

address space [ATE 1] ———

¥I5A zession 'ufg-ﬂn dup 154, sezzion
offset [0] - = data
count [0] f “' errar oLt

Ermar in [ho erar]

LA ) (=]
16 2 0isa Move In 1§ YWisa Move In 32 |32
e i

The following table lists the valid entries for specifying address space.

Value Description
€))] Address the A16 address space of the VXI/MXI bus.
2) Address the A24 address space of the VXI/MXI bus.
3) Address the A32 address space of the VXI/MXI bus.

VISA Move Out8 / Move Out16 / Move Qut32

Moves a block of data from local memory to the specified address and offset and uses the
specified address space to write 8 bits, 16 bits, or 32 bits of data, respectively, to the specified

offset. These functions do not require the VISA Map Address function to be called prior to
their invocation.

address space [ATE 1] ———
YISA sezsion ug.un dup 154, seszion
—
?:IfLSt:t[ED]% - H“‘D* errar out
Ermor in [ho ermar]
i ]
6t visa Move Out 18 Visa Move Qut 32 [z2R
Eil l]lh
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The following table lists the valid entries for specifying address space.

Value Description
@)) Address the A16 address space of the VXI/MXI bus.
2) Address the A24 address space of the VXI/MXI bus.
3) Address the A32 address space of the VXI/MXI bus.
VISA Out8 / Out16 / Out32

Writes 8 bits, 16 bits, or 32 bits of data, respectively, to the specified memory space (assigned
memory base plus offset). These functions do not require the VISA Map Address function to
be called prior to their invocation.

address space [A16: 1] ———
YISA zession [EEE] dup VIS4 zezsion

offzet (0] - 8
wealue [0] f[’"
&rrar in [ho errar]

] _ 5
Visa Out 16 Visa Out 32 |52
0+ L1 o[

The following table lists the valid entries for specifying address space.

errar out

Value Description
(D) Address the A16 address space of the VXI/MXI bus.
2) Address the A24 address space of the VXI/MXI bus.
3) Address the A32 address space of the VXI/MXI bus.
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Low Level Register Access Functions

This section describes the VISA Low Level Register Access functions. Valid classes for these
functions are Instr (default), VXI/GPIB-VXIVXE RBD Instr, VXI/GPIB-VXI MBD Instr,
and VXI/GPIB-VXI/VME MemAcc. To access the VISA Low Level Register Access
functions, pop up on the Low Level icon on the VISA palette.

B

X

Low Level Begister Access

=] [E=] [E] =] (=]
ERSYID .#ERE\'I':' w:::s:I:) ERE\'I':' Eﬁ!\'lﬁ
ﬂ R = |R (@
=]
g5 \"x
05

@

e b

Event

ws.q e | [Aea
STB TRG
™ =1H| | E= =TH|

EE

2

High

[

LJ'.'.S'.-'J
abc
:u?.f

Low_ g

VISA Map Address

[

a ]

[FEf] (G5 (S
£ LB 0| | £

54
8

6 L]
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16

L4454 [EE] L5 L#54

8 16 32
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Maps a specified memory space. The memory space that is mapped is dependent on the type
of interface specified by VISA session and the address space parameter. Once the window
is mapped, VISA tracks the window that is mapped. This behavior dictates that VISA can

only map one window for each VISA session.

addreszs space [A16: 1]
YISA session

map baze (0] T —]

map zize (0]

&frar in [fio error]
access [Fale]

1

L4054

|

dup VIS4 zezzion

error cluster
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The following table lists the valid entries for specifying address space.

Value Description
@)) Address the A16 address space of the VXI/MXI bus.
2) Address the A24 address space of the VXI/MXI bus.
3) Address the A32 address space of the VXI/MXI bus.
VISA Memory Allocation

For information about the VISA Memory Allocation function, see the High Level Register
Access Functions section of this chapter.

VISA Memory Free

For information about the VISA Memory Free function, see the High Level Register Access
Functions section of this chapter.

VISA Peek8 / Peek16 / Peek32

Reads an 8-bit, 16-bit, or 32-bit value, respectively, from the address location specified in
offset. The address must be a valid memory address in the current process mapped by a
previous VISA Map Address function call.

YISA session [EEE] dup Y54 sezsion

aoffzet (0] - {:3 L walue

2IT0r IR o error] === eror out
[T A
& Visa Peek 16 Wisa Peek 32 |22

VISA Poke8 / Poke16 / Poke32

Writes an 8-bit, 16-bit, or 32-bit value, respectively, to the specified address and stores the
content of the value to the address pointed to by offset. The address must be a valid memory
address in the current process mapped by a previous VISA Map Address function call.

¥I5A session [EEE] dup 54 seszsion
offset (0] - 8

walue [0] —l_r‘ error out

2Irar in [hio erar]

% Yisa Poke 16 Visa Poke 32 32
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VISA Unmap Address
Unmaps memory space previously mapped by VISA Map Address.
¥I5A zession HEA dup 154, seszzion
ermar in [ho ermar] errar oLt

VISA Serial Functions

This section describes the VISA functions that are specific to serial ports.
Valid classes for these functions are Instr (default) and Serial Instr.

To access the VISA Serial functions, pop up on the Low Level icon on the
VISA palette.

B x|
YIS5A Sernial

[E] LA =] [E=] L]
ERSYIN v}ﬁﬂl'} :sﬁzs:II: atfﬁﬂ'll:- atf*““'
F EEEI R =) |R [0 w R
HEa | [lWEA | J| Ok
|| o_[l:ﬂ
(] LA =] (K]
abow, |[abo—, || CLR || STE
R WS A =H|

Lea =1H| | = =TH
[EG] [EEA] [EAEi]
g (=T
8 |8 e | B |
s [E1E]| |4 [E0E] | |42 (1]

Flush Serial Buffer

Flushes the serial buffer.

VISA zession W‘ dup W54 seszion
mask. [16] - %g
ermor in [ho errar) error aut

Flushing the receive buffer (16) discards the contents, while flushing the output buffer (32)
waits for any remaining contents in the transmit buffer to be sent to the device. To discard any
remaining data in the transmit buffer, you need to use the discard output buffer mask (128).
To flush more than one buffer simultaneously, combine the buffer masks by using an O-Ring.
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Set Serial Buffer Size

Sets the size of the serial buffer.

¥IS5A session 175A 7 dup 154 session

rnask [16] - 'E |
zize [0] errar out

Erar in (o erraor)

Valid values for mask are Serial receive buffer (16) and Serial transmit buffer (32). To set the
size of both buffers simultaneously, combine the buffer masks by using an O-Ring.

VISA Property Node

This section describes the VISA Library attributes. The VISA Property
Node gets and/or sets the indicated attributes. The node is expandable;
evaluation starts from the top and proceeds downward until an error or until
the final evaluation occurs.

To access the property node, select Functions»Instrument I/O» VISA.
Then select the Property Node icon located on the bottom row of the
VISA palette.

[ X
VISA

||||
SIES

— Property Hode

FiEd | [FEA | [FEd | [FEa | [WEd
ERSYIN w!ﬁ!'flﬁ ES“:::II: atfﬁ!'flﬁ atf‘“\'m
F EEEI R & |R [=0] w n|
WEa | REa Mg ¥
c?g % Event
WEd | (WA |[MEA | e | [wea
abiw, ||abe-, || CLR [[STR || TRG || R[]
B ot ]| | [ [ [T |42 [51]|| Hig
VA | (WA g WA [E
& la ¥llg” =™, ) #m)
e [E1E] | |4+ [ | | e [E1E] 2173 ||Lowr
The VISA Property Node only displays attributes for the class of the
session that is wired to it. You can change the class of a VISA Property

Node as long as you have not wired it to a VISA session. Once a
VISA session is wired to a VISA Property Node, it adapts to the class of
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the session and any displayed attributes that are not valid for that class
become invalid (indicated by turning the attribute item black).

Because the Property Node can be used in other contexts in LabVIEW, the
Property Node might default to a class other than a VISA class if you place
it on a diagram by itself. When you wire it to a VISA session, it becomes a
VISA class.

VISA Property Node Descriptions

The following VISA Property Node categories are available.

Fast Data Channel

Specifies the following information:

General Settings

Channel number
Data transfers through channel pairs
Enabling signal

Normal-mode or streaming-mode transfers

Determine the following properties:

GPIB Settings

Maximum event queue length

Unique VISA resource name
Resource lock state

Timeout value for accessing the device
Communication trigger mechanism

Information used to document the functionality in your
VISA application

Specify the following information:

What the primary and secondary addresses of a GPIB device are
If the GPIB device needs to be readdressed before every transfer

If the GPIB device is unaddressed after each read and write operation
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Interface Information

Provides information about the VISA interface type, the board number of
the interface and the board number of the parent device.

Message-Based Settings
Determine the following aspects of VISA message-based communication:
¢ The I/O Protocol (GPIB, Serial, VXI)
*  Whether to send an END indicator in write operations
e Whether to ignore an END indicator in read operations

*  Whether to terminate read operations with a special character

Modem Line Settings

Determine the current state of the following signals used in modem
communication: CTS, DCD, DSR, DTR, RI, and RTS.

PXI Resources

Specify the address type, the address base and address size of devices at
slots BARO through BARS.

PXI Settings

Specify the following information: device number, function number,
subsytem manufacturer information, and subsystem model code.

Register-Based Settings
Determine the following aspects of VISA register-based communication:
* Identification of the device manufacturer
*  Model of the device
*  Physical slot location of the device

*  Number of elements in block-move operations at both the source and
memory addresses

*  (Windows) Base address, size, and access to space
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Serial Settings

Specify the following: number of bytes at the serial port, baud rate, data
bits, parity, stop bits, flow control, and termination method for read and
write operations.

Version Information

Provides information about the version and the manufacturer’s name of the
VISA implementation, as well as the version of the VISA specification.

VME/VXE Settings

Determine the necessary addresses, access privileges, memory space, and
byte orders necessary for VXI communication.
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Traditional GPIB Functions

This chapter describes the Traditional GPIB functions.

The following figure shows the Traditional GPIB Functions palette
which you access by selecting Functions»Instrument I/0O»GPIB.
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For examples of how to use the Traditional GPIB functions,
see examples\instr\smplgpib.1l1lb.
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Traditional GPIB Function Parameters

Most of the Traditional GPIB functions use the following parameters:

address string contains the address of the GPIB device with which the
function communicates. You can input both the primary and secondary
addresses in address string by using the form primary+secondary.
Both primary and secondary are decimal values, so if primary is 2
and secondary is 3, address string is 2+3.

If you do not specify an address, the functions do not perform
addressing before they attempt to read and write the string. They
assume you have either sent these commands another way or that
another Controller is in charge and therefore responsible for the
addressing. If the Controller is supposed to address the device but does
not do so before the time limit expires, the functions terminate with
GPIB error 6 (timeout) and set bit 14 in status. If the GPIB is not the
Controller-In-Charge, do not specify address string.

When there are multiple GPIB Controllers that LabVIEW can use,

a prefix to address string in the form ID:address (or ID: if no
address is necessary) determines the Controller that a specific function
uses. If a Controller ID is not present, the functions assume
Controller (or bus) 0.

status is a 16-bit Boolean array in which each bit describes a state of
the GPIB Controller. If an error occurs, bit 15 is set. The error code
field of the error out cluster is a GPIB error code only if bit 15 of
status is set.

error in and error out terminals comprise the error clusters in each
Traditional GPIB function. The error cluster contains three fields. The
status field is a Boolean which is TRUE when an error occurs, FALSE
when no error occurs. code field will be a GPIB error code value if an
error occurs during a GPIB function. source field is a string which
describes where the error has occurred. If the status field of the error
in parameter to a function is set, the function is not executed and the
same error cluster is passed out. By wiring the error out of each
function to the error in of the next function, the first error condition is
recorded and propagated to the end of the diagram where it is reported
in only one place.
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Traditional GPIB Function Behavior

The GPIB Read and GPIB Write functions leave the device in the
addressed state when they finish executing. If your device cannot tolerate
functioning in the addressed state, use the GPIB Misc function to send the
appropriate unaddress message or configure the NI-488.2 software to
unaddress automatically for all devices on the GPIB.

The Traditional GPIB Read and Write functions can execute
asynchronously. This means other LabVIEW activity can continue while
these GPIB functions operate. When set to execute asynchronously, a small
wristwatch icon appears as part of the function icons. A pop-up item on the
Traditional GPIB Read and GPIB Write functions allows you to switch
their behavior to and from asynchronous operation.

g Show L
= Description...

=

5et Breakpoint

Show Terminals

Replace ]

Cluster Tools
Create Constant
Create Control
Create Indicator
Do 1/0 synchronously

Traditional GPIB Function Descriptions

The following traditional GPIB functions are available.

GPIB Clear

Sends either Selected Device Clear (SDC) or Device Clear (DCL).

address string “ shatuz
<o

2Iror in error oLt
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GPIB Initialization
Configures the GPIB interface at address string.

require re-addreszing (T] -
azzert REM with IFC [T] -
gyztemn controller [T] .
address strifg ] YT

=== ol ot

d|Sa"|:|W DM'{-,' [F] ..................... .-

GPIB Misc

Performs the GPIB operation indicated by command string. Use this low-level function
when the previously described high-level functions are not suitable.

cormmand string autput string
R <:> [t ghatug
=rern errar out

Table 34-1. Command String Device Functions

Device Functions Description
loc address Go to local.
off address Take device offline.
pct address Pass control.
ppc byte address Parallel poll configure (enable or disable).

Table 34-2. Command String Controller Functions

Controller Functions Description
cac 0/1 Become active Controller.
cmd string Send IEEE 488 commands.
dma 0/1 Set DMA mode or programmed I/O mode.
gts 0/1 Go from active Controller to standby.
ist 0/1 Set individual status bit.
llo Local lockout.
loc Place Controller in local state.
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Table 34-2. Command String Controller Functions (Continued)

Controller Functions Description
off Take controller offline.
ppc byte Parallel poll configure (enable or disable).
pPpu Parallel poll unconfigure all devices.
rpp Conduct parallel poll.
rsc 0/1 Request or release system control.
rsv byte Request service and/or set the serial poll status byte.
sic Send interface clear and set remote enable.
sre 0/1 Set or clear remote enable.

To specify the GPIB Controller used by this function, use a command
string in the form ID: xxx, where ID is the GPIB Controller (bus number)
and xxx is the three-character command and its corresponding arguments,
if any. If you do not specify a Controller ID, LabVIEW assumes 0.
